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1 Safety

1.1 Designated use
Fieldgate SWG70 serves as a gateway for WirelessHART networks. It enables WirelessHART 
devices to communicate with each other and manages security and connectivity. The 
Fieldgate converts wireless device data to a format that is compatible with host systems. 

NOTICE!
• The WirelessHART protocol may not be used to replace the wiring in the case of safety 

applications with a control function.

1.2 Installation, commissioning and operation
The WirelessHART Fieldgate can be operated safely in compliance with the current 
guidelines for technical safety and the latest EU directives. Wireless field devices and 
adapters connected to the WirelessHART Fieldgate must also be operated in accordance 
with the current guidelines for technical safety and the latest EU directives.

If the WirelessHART Fieldgate is installed incorrectly or used in applications for which it is 
not intended, it is possible that dangers may arise.

Installation, connection to the electricity supply, commissioning, operation and 
maintenance of the WirelessHART Fieldgate may only be carried out by trained, qualified 
technical specialists authorized to perform such work by the facility's owner-operator. The 
specialist staff must have read and understood these Operating Instructions and must follow 
the instructions they contain. It is not permitted to modify or repair the devices in any way.
NOTICE!
• Changes or modifications to the Fieldgate not expressly approved by Endress+Hauser will 

void the user’s authority to operate the equipment.

1.3 Operational safety

Location Fieldgate SWG70 fulfills the requirements of EU Guidelines for a number of applications. 
The associated environmental conditions must be upheld. See the Technical Information 
document for "WirelessHART Fieldgate SWG70" (TI00027S).

The device must not be installed at locations where corrosive vapors may be present.

Hazardous areas Fieldgate SWG70 is available in a version that can be mounted in an explosion hazardous 
area. In order to ensure the necessary degree of protection: 

• All seals must be undamaged and have been correctly fitted.
• All screws of the housing/housing cover must have been tightened with the appropriate 

torque.
• Only cable of the appropriate size must be used in the cable glands.
• All cable glands must have been tightened with the appropriate torque, see (Chapter 5.5).
• All empty cable glands must have been sealed with sealing plugs.
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When installing components in explosion hazardous areas:

• Ensure that all installation and maintenance personnel are suitably qualified.
• Check that all equipment has the appropriate safety certificates.
• Observe the specifications in the device certificates as well as national and local 

regulations.

Coexistence of wireless 
technologies

WirelessHART networks use the frequency spectrum between 2400 ... 2483.5 MHz accord-
ing to IEEE 802.15.4. Various other wireless technologies also use this frequency spectrum, 
for example WLAN and Bluetooth. Depending upon the situation, it is possible that these 
different wireless technologies will affect each other.

When wireless technologies are used in an industrial environment, they must coexist with-
out interfering with each other. If you find that systems are interfering with each other, take 
appropriate measures to ensure the operation of all wireless systems, e.g. by reconfiguring, 
enforcing a wireless compatibility policy, etc.

Operation CAUTION!

Maintain a minimum distance of 20 cm between the device antenna and the body of the user 
and all persons in the vicinity at all times and for all applications and uses.

1.4 IT security
The Fieldgate SWG70 is equipped with security mechanisms to protect it against any 
inadvertent changes to the device settings. Additional IT security measures in line with 
operators' security standards and designed to provide additional protection for the device 
and device data transfer must be implemented by the operators themselves.

The Fieldgate offers the following functions that increase IT security:

• WirelessHART security management (See Chapter 3.2.2 "WirelessHART security 
management" on page 12 and see Chapter 8.2.1 "Basic Setup" on page 43.)

• Password for Web server (See Chapter 11.4 "Change Password (Web Server)" on 
page 108.)

• Security certificate for Web server (See Chapter 11.7 "Upload Certificate (Web server)" on 
page 110.)

See the Technical Information document "WirelessHART Fieldgate SWG70" (TI00027S) for 
system-specific firewall configurations such as TCP/IP ports and services.

1.5 Declaration of Conformity
All Declarations of Conformity can be found on www.endress.com.

CE Mark The WirelessHART Fieldgate SWG70 meets the legal requirements of the relevant EC direc-
tives. Endress+Hauser confirms successful testing of the WirelessHART Fieldgate SWG70 by 
affixing to it the CE mark. An EC Declaration of Conformity has been issued for the Ex-ver-
sions and non-Ex versions of the device.

1.6 Technical improvement
Endress+Hauser reserves the right to make technical improvements to its software and 
equipment at any time and without prior notification. Where such improvements have no 
effect on the operation of the equipment, they are not documented. If the improvements 
effect operation, a new version of the operating instructions is normally issued.
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1.7 Conventions and icons
In order to highlight safety relevant or alternative operating procedures in the manual, the 
following conventions have been used, each indicated by a corresponding icon in the margin. 

Safety conventions

Type of protection .

Electrical symbols .

Icon Meaning
DANGER!
This symbol alerts you to a dangerous situation. Failure to avoid this situation will result 
in serious or fatal injury.

WARNING!
This symbol alerts you to a dangerous situation. Failure to avoid this situation can result 
in serious or fatal injury.

CAUTION!
This symbol alerts you to a dangerous situation. Failure to avoid this situation can result 
in minor or medium injury.

NOTICE!
This symbol contains information on procedures and other facts which do not result in 
personal injury.

Icon Meaning
Device certified for use in explosion hazardous area
If the device has this symbol embossed on its name plate it can be installed in an explosion 
hazardous area in accordance with the specifications in the certificate or in a safe area.

Explosion hazardous area
Symbol used in drawings to indicate explosion hazardous areas. Devices located in and wiring 
entering areas with the designation “explosion hazardous areas” must conform with the stated type 
of protection.
Safe area (non-explosion hazardous area)
Symbol used in drawings to indicate, if necessary, non-explosion hazardous areas. Devices located 
in safe areas still require a certificate if their outputs run into explosion hazardous areas.

Icon Meaning
Direct voltage
A terminal to which or from which a direct current or voltage may be applied or supplied.

Alternating voltage
A terminal to which or from which an alternating (sine-wave) current or voltage may be applied or 
supplied.

Grounded terminal
A grounded terminal, which as far as the operator is concerned, is already grounded by means of an 
earth grounding system.

Protective grounding (earth) terminal
A terminal which must be connected to earth ground prior to making any other connection to the 
equipment.

Equipotential connection (earth bonding)
A connection made to the plant grounding system which may be of type e.g. neutral star or 
equipotential line according to national or company practice. 
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2 Identification

2.1 Unpacking

2.1.1 Visual inspection
During unpacking:

• Check the packing materials for signs of transportation damage.
• Remove the packaging material with care, so as not to damage the Fieldgate.
• Store the original packing material, in case the Fieldgate must be shipped again.
• Keep the documentation supplied with the Fieldgate in a safe place.
• Keep the accompanying documents.

2.1.2 Scope of delivery
Please check that the delivery is complete and free of defects before starting installation. 

The scope of delivery comprises the following parts:

• WirelessHART Fieldgate SWG70
• Antenna
• Short instructions
• Depending upon order, FieldCare Device Setup DVD

2.1.3 Storage and transport
Always store and transport the device in the original packaging.

Always store the device in a clean, dry environment. 

Keep within the permitted storage temperature range. See the Technical Information 
document for "WirelessHART Fieldgate SWG70" (TI00027S).

2.2 Nameplate
The device designation together with other information can be found on the nameplate 
affixed to the front of the Fieldgate.

Fig. 2-1:  Nameplate (example)

1 Order number and serial number
2 Type of protection, if any

3 Telecommunication compliance
4 Version information

1

24 3

x

Made in Germany CH-4153 Reinach, Switzerland

Order code: SWG70-1056/0
Ser. no.: 60011009001
Ext. ord. cd.: SWG70-BG3

WirelessHART Fieldgate SWG70
U: 
P: 
Ta: 

Dev.Rev.: 
CMIIT-ID:

FCC-ID: 
Contains: 

IC-ID: 
 

5853A-M2140
SJC-M2140
2.4 GHz

Dat./Insp.: 2015-07-06
XA00C01S

II 3 G Ex nA nC IIC T4 Gc

НАНИО   “ЦСВЭ”
No.: TC  RU C-CH.ГБ05.В.00043 
2ExnAIIT4 X

DC 20...30 V
< 5 W
-20 °C...+60 °C

R 202-SMD11
0976

IP 66 / IP 67 / NEMA 4

MAC: DD-DD-BE-DD-DD-BB

FW: 

1
2011DJ5310

Anatel ID: HHHHFF-AAAA
FW: 

HW: 

01.00.01

01.00.00

Order code:
Ser. no.:
Ext. ord. cd.:
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2.3 Ordering information
Detailed information about the product structure is available:

• On the Endress+Hauser website: www.endress.com/SWG70
• From your Endress+Hauser Sales Center: www.addresses.endress.com
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3 Function and system design

3.1 WirelessHART protocol
The HART protocol has until now used the wired 4–20 mA loop with a superimposed digital 
signal as physical layer.

WirelessHART enables the wireless transmission of HART data. To be employable world-
wide, WirelessHART utilizes the 2.4 GHz Band (IEEE 802.15.4 wireless network) as physical 
layer. The WirelessHART devices form a mesh network in which every device is not just a 
measurement point, but also a repeater. This results in a wider range for the whole network 
as well as increased reliability through redundant communication paths.

The network may comprise three types of device:

• WirelessHART gateway (Fieldgate SWG70)
• WirelessHART field devices
• WirelessHART Adapters (SWA70): either connected to 4–20 mA/HART devices or acting 

as repeaters.

The WirelessHART network is built up, organized and maintained by the Fieldgate, which 
also takes care for connection to different HOST systems through different bus interfaces.

Fig. 3-1: WirelessHART network

1 Host applications
2 Ethernet

3 WirelessHART Fieldgate
4 Field devices with wireless

Ethernet

1

2

34

4

4

4
4

4
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3.2 WirelessHART network
Fieldgate SWG70 is the master device in the WirelessHART network. Acting as network 
manager, it recognizes other devices wanting to join the network. It makes contact with each 
in turn and initiates the procedures required for them to join. The network organizes itself 
without any intervention on the part of the user. Fieldgate SWG70 also acts as security man-
ager and collects the data sent by the network participants, converting it into a form which 
can be used by other systems connected to it. 

3.2.1 Network management
In its role as network manager, Fieldgate SWG70 organizes the wireless communication 
between the WirelessHART field devices.

Fig. 3-2: Network management 

After the Fieldgate has started up the network, devices can join. To this end, it first sends out 
a call for devices to join the network. Then, the device sends a join request to announce its 
wish to join the network. If the WirelessHART field device can identify itself with the same 
network ID and join key as stored in the WirelessHART Fieldgate, the field device is autho-
rized to join the network. Otherwise, the field device will be rejected.

In the next step, the WirelessHART Fieldgate sends session and network keys as well as 
scheduling and routing information to the field device. The field device is told how to partic-
ipate in the network and receives various information from the WirelessHART Fieldgate:

• Number and identity of neighboring WirelessHART field devices,
• When to send messages and which channels to use,
• When to repeat messages for other WirelessHART field devices,
• The optimal communication path for messages as well as alternative communication 

paths in case of failure.

During this process, the WirelessHART device or adapter may also apply to send messages 
in certain intervals and ask the network manager for the appropriate resources. The network 
manager then takes care that these resources are available. For example, the network man-
ager informs other WirelessHART field devices when to repeat messages.

3.2.2 WirelessHART security management
Fieldgate SWG70 also acts as security manager. To make communication safe, all messages 
are encrypted with industry-standard AES-128 block ciphers with symmetric keys. There-
fore, messages are unreadable for external listeners. The encryption keys are distributed by 
the security manager.

The Join Key is used to join the network. Subsequently, the Join Key is automatically 
exchanged against the Session Key and the Network Key, i.e. two new additional keys.

1 Step 1: Advertising
2 Step 2: Join Request
3 Step 3: Authorization, Session & Network Keys, 

Scheduling and Routing

4 WirelessHART gateway (Fieldgate SWG70)
5 WirelessHART device or adapter

1

2

4 5

3
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3.3 Connecting to HART-compatible host systems
Fieldgate SWG70 also makes wireless communication accessible to HART-capable host sys-
tems via its Ethernet interface or serial interfaces (RS-485) and the following functions.

Depending on the version ordered, Fieldgate SWG70 can also be integrated into Modbus, 
OPC or Ethernet/IP host systems.

3.3.1 Instrument list
The WirelessHART devices in the network are made available to the host systems via an 
instrument list. This list contains one or more I/O cards. Every I/O card has one or more 
channels. Up to 6 field devices can be connected in multidrop mode to each channel. See 
Figure 3-3 on page 13. The list itself can be up and downloaded. See Chapter 10.1 "Instru-
ment List" on page 62.

Fieldgate SWG70 assigns a virtual I/O card to each WirelessHART device. The I/O cards are 
assigned to the WirelessHART devices in the order in which they join the network. New 
WirelessHART devices in the network are assigned to the next available I/O card, which is 
added to the end of the instrument list (First-in-First-Out principle). 

Within an I/O card, the WirelessHART device itself as well as status information is assigned 
to Channel 0. If the WirelessHART device is an adapter, all field devices connected to it are 
assigned to channel 1 (multi-drop mode). The list of the connected field devices is also called 
sub-device list.

Fig. 3-3: Instrument list

If a WirelessHART device loses communication to the Fieldgate, it stays assigned to the I/O 
card initially allocated to it. When communication is established again, the device thus has 
the same position in the instrument list that it had before.

The same principle applies to the field devices connected to the WirelessHART Adapter 
(SWA70). When communication to the Fieldgate is lost, the long tags of the filed devices are 
stored. After communication has been established again, the field devices regain their pre-
vious position in the instrument list.

1

2

3

4

5

WirelessHART-Gateway

I/O card 1

I/O card 2

Channel 0

WirelessHART Field device

WirelessHART Adapter

Channel 0

Channel 1

WirelessHART  Field device1

WirelessHART  Field device2

WirelessHART  Field device3

Network structure

1

2

3

4

5

5

5

Instrument list I/O structure
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3.3.2 Cache
The WirelessHART Fieldgate stores information received over the WirelessHART network 
and makes it available to the host for further processing. This ensures that information is 
available immediately for the host system without having to send a request to the device and 
wait for the response. The following commands and answers to requests are cached in the 
Fieldgate.

Information cached in the 
WirelessHART Fieldgate

Each listed command has its own cache memory. Static commands are stored in the cache 
upon the first request. Dynamic variables are stored each time a field device sends a burst 
message so that up-to-date values are available at all times.

With the exception of write commands 17, 18, 22 and 51, when the WirelessHART 
Fieldgate receives a request from a host system which is embedded in Command 77, the 
response is sent immediately (provided that the response is available in the cache). 

Long Tag Emulation WirelessHART uses the long tag for addressing devices. Not every HART device supports 
long tags, for example, older HART devices with HART Protocol Version 5 or less, do not sup-
port long tag addressing. 

If a HART 5.0 device is connected to a WirelessHART Adapter (SWA70), the WirelessHART 
Fieldgate emulates the long tag using the "Message" field. When a host system addresses a 
HART 5 device, the emulation translates Command 20(22) directly into Command 12 (17) 
which the HART 5 understands. The response is stored in the Fieldgate cache for CMD 
12(17) and for CMD 20(22).

Cache HART Command Description
Static: cached upon 
read

0, 11, 21 Read unique identifier (associated with tag or long tag)

Static: cached upon 
read & write 
confirmation

12, (17) Read (Write) Message
13, (18) Read (Write) Short Tag, Descriptor, Date
20, (22) Read (Write) Long Tag
50 (51) Read (Write) Dynamic Variable Assignments

Dynamic: cached on 
publication only 

1 Read Primary Variable
2 Read Current and Percentage
3 Read All Variables
9 Read Device Variables and Status
33 Read Device Variables
38 Read Additional Device Status
48 Reset Configuration Change Counter
93 Read Trend
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4 Installation

NOTICE!
• It is recommended that Fieldgate SWG70, adapters and devices be setup on the test bench 

and the network be tested before the components are installed in the field.

4.1 Mounting considerations

4.1.1 Positioning the Fieldgate
Install the Fieldgate before installing other WirelessHART devices. This way you can check 
for proper operation of new devices as they are installed. Nevertheless, consider the location 
of future WirelessHART devices that will be routed through the Fieldgate to ensure good 
connectivity.

Guidelines for Planning a 
WirelessHART Network

• Mark the positions of the various measuring points on a scale overview of the plant. It is 
important that the overview shows likely obstacles to the propagation of the radio waves. 

• Make sure that a minimum of 2 other WirelessHART devices are well within the antenna 
range of the device. If necessary, consider using an adapter as an additional stand-alone 
repeater. Please refer to the following section for more information about the antenna 
properties.

• Where a lot of metal, grids or walls prevent a device from being in line-of-sight of its 
nearest neighbor, the maximum distance between two devices is 30 m. Install wireless 
devices at least 1m above the ground or the floor.

• Where there are fewer structural elements and one or more neighbors are in direct line-
of- sight, the maximum distance between two devices for planning purposes is 200 m. In 
this case, install wireless devices at least 3m above the ground or the floor.

• Consider moving objects that could affect the device's antenna range.
• Make sure that the device's antenna is aligned vertically.
• If possible, position the Fieldgate at or near the center of the network - it should be in 

contact with at least 20% of the devices in the network.
• Do not position WirelessHART devices directly below or above each other as they will be 

outside each other's antenna range. See Chapter 4.1.3 "Examples of good and poor 
positioning" on page 17.

• If possible, do not position the device next to metal surfaces, pipes or walls containing 
metal (minimum distance: 6 centimeters). There should be as little metal around the 
device as possible.

• Do not position other 2.4 GHz devices like cordless phone bases or WLAN routers near 
WirelessHART devices. Wireless technologies used in an industrial environment must be 
able to coexist without disrupting each other. If multiple networks operate in one facility, 
wireless frequency management may be required.
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4.1.2 Antenna range
The antenna supplied is an omni-directional dipole antenna.

A schematic representation of the wave propagation is provided in the following graphic. 
If the antenna is pointed upwards, the signal is emitted horizontally. The transmission and 
reception quality decreases by up to 50% as of an angle of approx. 39°. Almost no signal will 
be radiated directly above and below the antenna.

We therefore recommend that you mount the wireless devices on one plane where possible.

If you must mount the wireless devices on very different planes, we recommend you use a 
remote antenna. See Chapter 4.2 "Mounting the antenna" on page 17. Different coverage is 
achieved with a remote antenna. For the associated requirements, please see the Technical 
Information document for "WirelessHART Fieldgate SWG70" (TI00027S).

Fig. 4-1: Wave propagation, schematic representation (alpha = approx. 39°)

1 No signal above and below 2 Stronger signal sideways

1

2 2

1

α

α

α

α100% 100%

50%50%

50%50%

0%
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4.1.3 Examples of good and poor positioning
The positioning is good when the network participants are within the antenna range:

Fig. 4-2: Example of good positioning

The positioning is poor when neighbors are not in the antenna range or within the weaker 
signal zone of the antenna:

Fig. 4-3: Example of poor positioning

4.2 Mounting the antenna

WARNING!
• If Fieldgate SWG70 is installed in a hazardous area Zone 2, you may only connect or 

disconnect the antenna and cables in the absence of any potentially explosive atmosphere 
or if the Fieldgate is not connected to the power supply. 

PWR
COM
FLT

Height

Distance

Height

Distance



Installation WirelessHART Fieldgate SWG70

18 Endress+Hauser

NOTICE!
• Use only the antenna supplied or a remote antenna that meets the requirements. For 

the associated requirements, please see the Technical Information document for 
"WirelessHART Fieldgate SWG70" (TI00027S).

4.2.1 Mounting the antenna supplied

1. Switch off the power supply to the Fieldgate.

2. Firmly screw the antenna to the device's antenna terminal. 
See Figure 5-1 on page 20, Item 6.

4.2.2 Connecting a remote antenna

WARNING!
• Outdoor installations can be subject to lightning strikes. Install a surge arrester to protect 

the installation against transients or damage caused by lightning strikes.

NOTICE!
• Only use antennas, cables and surge arresters that are listed in the Technical Information 

document "WirelessHART-Fieldgate SWG70" (TI00027S).
• Ensure adequate strain relief for the cables.
• Pay attention to the bending radii of the cables. Do not drop below the permitted bending 

radii.

Fig. 4-4: Installation of an remote antenna

1. Switch off the supply voltage to the Fieldgate.

2. Install the antenna where it is within the antenna range of other WirelessHART 
devices. See Chapter 4.1.3 "Examples of good and poor positioning" on page 17.

1 Omnidirectional antenna
2 Directional antenna
3 Coaxial cable with connector
4 Surge arrester

5 Coaxial cable with connector
6 Coaxial adapter
7 Fieldgate SWG70

2

1

6

7

53 4
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3. Mount the surge arrester indoors. The coaxial cable between the surge arrester and 
Fieldgate may only be routed indoors.

4. Connect the antenna to the surge arrester using a coaxial cable.

5. Connect the antenna, the surge arrester and the Fieldgate to the protective grounding 
as illustrated in Figure Fig. 4-4.

4.3 Mounting the Fieldgate
In addition to fulfilling the conditions for good wireless communication, the mounting loca-
tion should be well accessible for mounting and electrical installation. Make sure that there 
is enough space to open the housing cover and to access the terminals, switches, and cable 
glands. Choose a mounting location that meets the climatic limits specified and radio 
requirements in the technical data.

Required tools:

• 2 screws (M6)
• Drill
• Screwdriver

Fig. 4-5: Mounting holes and housing screws

Mounting the Fieldgate 1. Drill 2 holes in the mounting surface so that they match the holes of the housing 
(centers 240 mm to 250 mm apart). See the Technical Information document for 
"WirelessHART Fieldgate SWG70" (TI00027S).

2. Screw the device to the mounting surface.

1 Mounting holes 2 Housing screws

2

1 1

2
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5 Electrical Installation

5.1 Connections and interfaces
The connections and interfaces are only accessible with an open enclosure. In the case of the 
DIP switches, the user has the choice of using the switch settings, or overriding the settings 
by software. See Chapter 8 "Fieldgate configuration" on page 42.

WARNING!
• If Fieldgate SWG70 is installed in a hazardous area Zone 2, you may only connect or 

disconnect the antenna and cables in the absence of any potentially explosive atmosphere 
or if the Fieldgate is not connected to the power supply.

Fig. 5-1: Connections and interfaces

1 Grounding terminal
2 RS-485 interfaces, duplicated terminal block for 

daisy-chain capability
3 Ethernet interface
4 Power supply connections (redundant)

5 Antenna
6 Antenna terminal
7 Cable glands

5

1

6

1

2 3 4

7
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5.2 Connecting to power supply and grounding
There are two 24 VDC power supply terminal blocks located inside Fieldgate SWG70, allow-
ing for redundant power supply. Open the housing cover to access the terminal blocks.

NOTICE! 
• Ensure adequate strain relief for the cables.
• Pay attention to the bending radii of the cables. Do not drop below the permitted bending 

radii.

Fig. 5-2: Power supply

Connecting to 24 VDC 
power supply and 
grounding

Fieldgate SWG70 must be connected to a 24 VDC power supply. For details, see the 
Technical Information document for "WirelessHART Fieldgate SWG70" (TI00027S).

DANGER!

Risk of electric shock if the wrong power unit is used.

• Always use a SELV/PELV power unit to guarantee electrical safety.

1. Switch off the power supply.

2. Connect the protective ground to one of the two ground terminals.

3. Unscrew the 4 screws of the housing cover and remove the housing cover. See 
Figure 4-5 on page 19.

4. Route the 24 VDC power cable through the second cable gland from right. 
The permissible cable diameter lies between 6 mm and 10 mm.

5. Connect the 24 VDC power cable to the first power supply connection "Line 1" observing 
polarity. See Figure 5-1 on page 20.

6. If you want to connect a redundant power supply (optional), route the second 24 VDC 
power cable through the cable gland on the far right of the housing.

7. Connect the second power cable to the second power supply connection "Line 2" 
observing polarity.

8. Switch on the power supply. The green power LED should light up immediately.

9. Tighten the cable gland with appropriate torque. See Chapter 5.5 "Cable glands and 
housing cover" on page 25.

1 First power supply connection
2 Second (redundant) power supply connection

3 Grounding terminals

1 2

KL14 KL15 KL16 KL17

+24V +24V0V 0V
LINE1 LINE2

+24V +24V0V 0V
LINE1 LINE2

A B SHD
RS485

T1 T2 RX– RX+ TX– TX+

ON

OFF

SHDA B SHD
RS485 ETHERNET

3 3
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5.3 Connecting to Ethernet
WARNING!
• If Fieldgate SWG70 is installed in a hazardous area Zone 2, you may only connect or 

disconnect the antenna and cables in the absence of any potentially explosive atmosphere 
or if the Fieldgate is not connected to the power supply.

NOTICE!
• Keep in mind that an access point of the Ethernet network has to be available. The 

maximum length of the cable running from the Fieldgate to the access point is 100 m, 
depending on the cable type and communication speed.

• Please note that older computers, hubs, switches or routers might not feature automatic 
TX/RX detection. In this case, use a crossover cable.

• Ensure adequate strain relief for the cables.
• Pay attention to the bending radii of the cables. Do not drop below the permitted bending 

radii.

5.3.1 Connecting the "Modbus" or "Modbus + OPC" versions to 
Ethernet

The Ethernet cable is connected directly to the Ethernet terminal block in the Fieldgate.

Fig. 5-3: Fieldgate with 5 cable entries and Ethernet terminal block

1. Switch off the power supply.

2. Unscrew the screws of the housing cover and remove the housing cover. See Figure 4-5 
on page 19.

3. Route the Ethernet cable through the cable gland in the middle of the Fieldgate 
housing. The permissible cable diameter is between 6 mm and 10 mm.

KL7 KL8 KL9 KL10

+24V +24V0V 0V
LINE1 LINE2

A B SHD
RS485

T1 T2 RX– RX+ TX– TX+

ON

OFF

SHDA B SHD
RS485 ETHERNET

T1 T2 RX– RX+ TX– TX+SHD
ETHERNET

KL11 KL12 KL13
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4. Connect the Ethernet cable to the terminal block labeled "Ethernet" according to the 
following table. 

5. Screw the housing cover on the housing.

6. Tighten the cable gland with appropriate torque. See Chapter 5.5 "Cable glands and 
housing cover" on page 25.

7. Switch on the power supply.

5.3.2 Connecting the "EtherNet/IP" version to Ethernet
The Ethernet cable with a D-coded M12 connector is connected to the M12 socket of the 
Fieldgate housing.

Fig. 5-4: Fieldgate with M12 socket in the middle

1. Switch off the power supply.

2. Plug the D-coded M12 connector into the Ethernet socket of the Fieldgate. See 
Figure 5-4 on page 23.

3. Tighten the coupling nuts on the M12 connector. The Fieldgate is connected to the 
Ethernet network.

4. Switch on the power supply.

Computer Fieldgate
Pin Numbering Connector Crossover cable Normal cable

Pin 1 TX+ RX+
Pin 2 TX– RX–
Pin 3 RX+ TX+
Pin 4 T2 T2
Pin 5 T2 T2
Pin 6 RX– TX–
Pin 7 T1 T1
Pin 8 T1 T1

1 Ethernet terminal block wired internally to M12 
socket 

2 M12 socket, D-coded for connection to an 
Ethernet or Ethernet/IP network

1 2 3 4 5 6 7 8

KL7 KL8 KL9 KL10

A B SHD
RS485

T1 T2

ON

OFF

SHDA B SHD
RS485 ET

T1 T2 RX– RX+ TX– TX+SHD
ETHERNET

KL11 KL12 KL13
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Internal wiring The Ethernet socket is wired to the Ethernet terminal block. The internal wiring may not be 
modified.

5.4 Connecting to RS-485
Fieldgate SWG70 is equipped with a fully galvanic isolated RS-485 interface. A second 
RS-485 terminal block allows several Fieldgates to be connected through a daisy chain. 

A terminating resistor is required at each end of the RS-485 cable. If the RS-485 cable is not 
routed to other devices (no daisy-chain connection), activate the terminating resistor using 
the corresponding DIP switches in the fieldgate. See Chapter 6.1.3 "DIP switches" on page 29.

NOTICE! 
• The maximum length of the cable from the Fieldgate is 1200m (at reduced 

communication speed).
• Use shielded twisted pair (STP) cables only.
• If the cable shield is grounded, only connect the grounding to one cable end. This avoids 

potential equalization currents.
• Ensure adequate strain relief for the cables.
• Pay attention to the bending radii of the cables. Do not drop below the permitted bending 

radii.

Fig. 5-5: RS-485 interface

Pin Numbering Connector Signal Internal Wire Colors
Pin 1 TX+ Yellow

Pin 2 RX+ White

Pin 3 TX– Orange

Pin 4 RX– Blue

3

4

2

1

1 First RS-485 connection 2 Second RS-485 connection for daisy chaining

KL1 KL2 KL3 KL4

+24V +24V0V 0V
LINE1 LINE2

A B SHD
RS485

T1 T2 RX– RX+ TX– TX+

ON

OFF

SHDA B SHD
RS485 ETHERNET

KL5 KL6

A B SHD
RS485

A B SHD
RS485

1 2

.
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Connecting to RS-485 1. Switch off the power supply.

2. Unscrew the screws of the housing cover and remove the housing cover. See Figure 4-5 
on page 19.

3. Route the RS-485 cable through the first cable gland from left. 
The permissible cable diameter is between 6 mm and 10 mm.

4. Connect the RS-485 cable to the left terminal block labeled "RS-485" as follows (see the 
graphic above): 

5. For a daisy-chain connection, route the second RS-485 cable through the second cable 
gland from left and connect it to the right terminal block labeled "RS-485", see table 
above.

6. To activate the RS-485 termination, set DIP switch number 7 to "ON". See Chapter 6.1.3 
"DIP switches" on page 29.

7. Screw the housing cover on the housing.

8. Tighten the cable gland with appropriate torque. See Chapter 5.5 "Cable glands and 
housing cover" on page 25.

5.5 Cable glands and housing cover
The degree of protection cannot be achieved if the cables and cable glands are not fitted 
correctly.

To ensure the IP degree of protection

• all screws of the housing / housing cover must have been tightened with the appropriate 
torque,

• only cables of the appropriate size must be used in the cable glands,
• all cable glands must be tightened with the appropriate torque,
• all seals must be undamaged and fitted correctly,
• all empty cable glands must be sealed with appropriate plugs.

The tightening torques of cable glands depend on what type of cable is used and must there-
fore be determined by the user. The cap nuts must be securely tightened. Tightening the cap 
nuts too tight can have a negative effect on the protection class. The following figures can 
be taken as rough guides.

The Fieldgate housing cover must be tightened with a torque of 2.5 Nm.

Wire RS-485 cable Fieldgate terminal Remarks
RxD/TxD– (RS-485 A) A RS-485 differential 

signalRxD/TxD+ (RS-485 B) B
Shield SHD Cable shielding

Type of cable gland Approx. installation torque
Plastic 2.5 Nm
Nickel-plated brass 4.1 Nm
Stainless steel 4.1 Nm
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6 Operation

6.1 Operating and display elements
Inside the fieldgate housing there are LED indicators, DIP switches and reset buttons. The 
controls and indicators are accessible with open enclosure.

WARNING!
• If Fieldgate SWG70 is installed in a hazardous area Zone 2, you may only operate the DIP 

switches and the keys and only connect or disconnect the cables in the absence of any 
potentially explosive atmosphere or if the Fieldgate is not connected to the power supply.

Fig. 6-1: Operating and display elements 

1 LEDs
2 Button P1

3 Button P2
4 DIP switches

1

2 3

4
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6.1.1 LEDs
Five LEDs indicate the status of Fieldgate SWG70.

Fig. 6-2: LED indicators

Yellow LED: RS-485 
communication status

Green LED: Power supply 
and operation status

Yellow LED: WirelessHART 
communication status

Red LED: Device status

1 Yellow LED: RS-485 communication status
2 Green LED: Power supply
3 Yellow LED: WirelessHART communication status

4 Red LED: Device status
5 Yellow LED: Ethernet communication status

+24V +24V0V 0V
LINE1 LINE2

A B SHD
RS485

T1 T2 RX– RX+ TX– TX+

ON

OFF

SHDA B SHD
RS485 ETHERNET

1 2 3 4 5

Mode Status Meaning
Flashes – Flashes briefly whenever a valid message is received by the 

Fieldgate on the RS-485 communication line.
– The LED does not flash if the message is not addressed to the 

Fieldgate or if a communication error was detected within the 
message.

Off – Currently no communication on the RS-485 line.

Mode Status Meaning
On OK Fieldgate SWG70 is powered up and running
Flashes Not ready On power-up, indicates that the Fieldgate application is running 

but the Fieldgate is not yet ready to answer HART commands.
Off No power The power supply is not connected/Fieldgate is not ready.

Mode Status Meaning
Flashes – Flashes shortly whenever a valid WirelessHART message is 

received by the Fieldgate on the WirelessHART communication 
interface. 
– Messages include simple commands but not published bursts 

and event notifications.
Off – Currently no communication on the WirelessHART interface.

Mode Status Meaning
On Hardware fault Fieldgate has detected a hardware fault that makes normal 

operation impossible. 
Flashes Recovering from hardware 

fault.
The Fieldgate application is trying to recover from the fault (not 
possible for all faults).

Off No hardware fault –
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Yellow LED: Ethernet 
communication status

6.1.2 Buttons
Fieldgate has two pushbuttons.

WARNING!
• When Fieldgate SWG70 is installed in Ex-Zone 2 and the power is switched on, the 

operation of the pushbuttons is permitted only in the absence of any potentially explosive 
atmosphere.

Fig. 6-3: Pushbuttons

Mode Status Meaning
On – The connection to the Ethernet line is established.
Flashing 
irregularly

– Fieldgate is receiving a message via the Ethernet interface. The 
LED does not flash in the following instances:
• The message is not addressed to the Fieldgate.
• A communication error was detected in the message.

Flashing (every 
second)

– A conflict has been detected in the IP address. The Fieldgate IP 
address is already being used by another device in the Ethernet 
network
Assign another IP address to the Fieldgate. See Chapter 7.1 
"Ethernet connection" on page 31.

Off – There is no connection to the Ethernet network. This is often due 
to a bad cable connection. See Chapter 5.3 "Connecting to Ethernet" 
on page 22.

1 Button P1 2 Button P2

+24V +24V0V 0V
LINE1 LINE2

A B SHD
RS485

T1 T2 RX– RX+ TX– TX+

ON

OFF

SHDA B SHD
RS485 ETHERNET

1 2

1 2 3 4 5 6 7 8
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The function of the buttons is as follows:

Buttons

6.1.3 DIP switches

WARNING!
• When Fieldgate SWG70 is installed in Ex-Zone 2 and connected to the power supply, the 

operation of DIP switches is permitted only in the absence of any potentially explosive 
atmosphere.

NOTICE! 
• The same functions can be initiated from the Fieldgate SWG70 Web interface and DTM. 

See Chapter 8.3 "Interfaces (wired communication)" on page 48.

Fieldgate SWG70 has one 8-gang DIP switch. Fieldgate SWG70 is delivered with all DIP 
switches set to ON and with all DIP switch functions set by software controls.

Fig. 6-4: DIP switches 

Buttons Function Procedure
Button P1 Configuration reset Press the button for more than 3 seconds.

– All Fieldgate SWG70 configuration parameters are reset to 
factory settings with exception of the parameters set by button 
P2 and button P1 + P2.

– After approx. 3 seconds, all LEDs light up to confirm the reset.
Button P2 Communication reset Press the button for more than 3 seconds.

– All Fieldgate SWG70 configuration parameters related to the 
wired communication channels are reset to factory settings.

– After approx. 3 seconds, all LEDs light up to confirm the reset.
Button P1 + P2
DIP switch 8 OFF

Password reset Press buttons P1 and P2 simultaneously for more than 3 seconds.
– All Fieldgate SWG70 passwords are reset to the factory settings.
– Passwords are used for access to the Command Line Interface 

and the Web Server (HTTPS).
– For Web Server User name: admin; Password: admin
– After approx. 3 seconds, all LEDs light up to confirm the reset.

Button P1 + P2
DIP switch 8 ON

Network manager reset Press buttons P1 and P2 simultaneously for more than 3 seconds.
– The Fieldgate SWG70 join key, network ID, radio power and 

access mode are reset to factory settings.
– After approx. 3 seconds, all LEDs light up to confirm the reset.

1 DIP switches 1 to 4: HART device address
2 DIP switches 5 and 6: 

Baud rate of RS-485 interface

3 DIP switch 7: RS-485 terminating resistor
4 DIP switch 8: Security mode

+24V +24V0V 0V
LINE1 LINE2

A B SHD
RS485

T1 T2 RX– RX+ TX– TX+

ON

OFF

SHDA B SHD
RS485 ETHERNET

1 2 3 4

ON

OFF
1 2 3 4 5 6 7 8
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DIP switch positions

Security mode When DIP switch 8 is OFF, it is not possible to download the Network ID and the Join Key to 
the Fieldgate. See Chapter 8.3.2 "Serial (RS-485)" on page 49. Fieldgate SWG70 is delivered 
with the download enabled by default, i.e. DIP switch 8 is ON.

Switch Function 1 2 3 4 Value 1 2 3 4 Value
1 – 4 HART device address 1) OFF OFF OFF OFF 0 OFF OFF OFF ON 8

ON OFF OFF OFF 1 ON OFF OFF ON 9
OFF ON OFF OFF 2 OFF ON OFF ON 10
ON ON OFF OFF 3 ON ON OFF ON 11
OFF OFF ON OFF 4 OFF OFF ON ON 12
ON OFF ON OFF 5 ON OFF ON ON 13
OFF ON ON OFF 6 OFF ON ON ON 14
ON ON ON OFF 7 ON ON ON ON 15
5 6 Value 5 6 Value

5 and 6 Baud rate of RS-485 
interface

OFF OFF 9600 bit/s OFF ON 38400 bit/s
ON OFF 19200 bit/s ON ON 57600 bit/s

7 RS-485 termination • OFF = disconnected • ON = connected
8 Download 

Join Key/Network ID
• OFF = disabled • ON = enabled

1) You can set up HART device addresses from 0 to 63 by software.
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7 Commissioning

NOTICE!
• We recommend that you first set up the Fieldgate SWG70, the WirelessHART Adapters 

and the HART devices on a test bench and test the network.

The Fieldgate SWG70 can be set up in the following ways:

• Via the Ethernet connection using the Web server
• Via the Ethernet connection using FieldCare and Fieldgate-DTM
• Via the RS-485 connection using FieldCare and Fieldgate-DTM

The structure of the parameter blocks and the parameters in the Fieldgate DTM and the Web 
server in the Fieldgate are identical.

Web server The Fieldgate SWG70 has an integrated Web server.

You can set up the Fieldgate and the associated WirelessHART network via the Web server.

See Chapter 7.1 for details on setting up the Fieldgate SWG70 via the Web server.

FieldCare You can set up the Fieldgate and the associated WirelessHART network via FieldCare. In 
addition, you can also configure the WirelessHART Adapters SWA70 and the connected 
devices via FieldCare.

A prerequisite is that the WirelessHART Adapters and devices already use the same join key 
and network identifier as Fieldgate SWG70 and have joined the network. Configure 
connected WirelessHART Adapters and field devices via the relevant DTMs.

NOTICE!
• It is advisable to configure the adapters and connected HART devices via a direct 

connection. See Operating Instructions BA00061S/04/en. If FieldCare accesses the 
devices via the Fieldgate SWG70 DTM, the response times may be considerably longer 
than for a direct connection.

See Chapter 7.1 and Chapter 7.3. for details on setting up the Fieldgate SWG70 via 
FieldCare.

7.1 Ethernet connection
The Ethernet connection of Fieldgate SWG70 allows communication with a computer via the 
integral Web Server or via FieldCare. 

The following requirements must be met: 

• Internet Protocol TCP/IP is installed on your computer and is active.
• You have administration rights for your computer and network.
• You have an set of IP addresses that have been authorized by your IT department.
• Any proxy server for your Internet Browser is disabled.
• Firewalls allow communication on port 80, 433, 502, 3333 and 5094.

Fieldgate SWG70 is delivered with the default IP address:

• 192.168.1.1
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NOTICE!
• By default, the IP address of the WirelessHART Fieldgate EtherNet/IP version is 

automatically assigned via DHCP. Please contact your network administrator to identify 
the automatic set IP address, if necessary.

• Alternative 3rd party IP scanner software i.e. "BOOTP Utility Software" from Rockwell 
Automation enables you to scan the Ethernet network and being able to assign a dedicated 
IP address i.e. 192.168.1.1 to the WirelessHART Fieldgate. Please consider WirelessHART 
Fieldgate MAC address is required to be able to set a dedicated IP address with "BOOTP 
Utility Software" from Rockwell Automation. 

• Please find below path to Rockwell Automation "BOOTP Utility Software" download and 
instruction page:

1. Go to http://www.rockwellautomation.com

2. Click "Products"

3. Click "Reliance Electric Drives"

4. Click "Software”"

http://www.rockwellautomation.com
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7.1.1 Establishing the connection between the host computer and 
the Fieldgate SWG70 Web server

Prerequisite

The Fieldgate SWG70 is connected to the Ethernet network. See Chapter 5.3 "Connecting 
to Ethernet" on page 22. 

Procedure 1. Check that the computer can reach the Fieldgate via ports 80, 443, 502, 3333 and 
5094. Please contact your network administrator if necessary. 

2. Note the current settings for the IP address and network/subnet mask of the computer 
to restore them if necessary.

3. Change the IP address and the network/subnet mask of your computer: 

– IP address 192.168.1.200 
– Network/subnet mask 255.255.255.0.

4. The simplest way to check the connection is to call up the Fieldgate SWG70 Web 
server. For this, enter the default IP address of the Fieldgate SWG70 in your Internet 
browser: 192.168.1

5. Accept the site certificate in the dialog which now appears. 

6. The Login of the Web page appears. 

– To open the Fieldgate SWG70 Web page, enter the User name 
(default: admin) and the Password (default: admin) and click OK.

– You must change the password after logging in for the first time.

7. If the connection to the Fieldgate Web server fails, check the following points:

– Are all the proxy servers in the browser switched off or not used for this address 
range?

– Are ports 80, 443, 502, 3333 and 5094 open in all the firewalls?
– Are you using the correct Ethernet cable? See Chapter 5.3 "Connecting to Ethernet" on 

page 22.
– Is the Ethernet cable correctly connected? See Chapter 5.3 "Connecting to Ethernet" on 

page 22.
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7.2 RS-485 connection
Prerequisite

The Fieldgate SWG70 is connected to the RS-485 bus. See Chapter 5.4 "Connecting to 
RS-485" on page 24.

Procedure 1. Connect the RS-485 bus to your computer via an RS-485/RS-232 signal converter or 
an RS-485/USB signal converter.

2. If you are using an RS-485/USB signal converter, install the correct driver.

3. Open the Windows device manager to find out which COM port the converter is 
connected to. For this purpose, enter "Device manager" in the search window in the 
Windows Start menu.

4. The signal converter and the assigned COM port are displayed under "Ports (COM & 
LPT)".

5. Note the COM port (in this case USB Serial Port (COM5)) and the baudrate etc. as you 
will need them to set up communication.

7.3 Creating a FieldCare project
Creating a FieldCare project will allow you to configure Fieldgate SWG70 and any HART 
device (field device or adapter) in the wireless network via its DTM. The configuration of a 
field device can be taken from the manufacturer’s operating manual, the configuration of 
the adapter is described in Operating Instructions BA00061S/04/en, SWA70 Wireless 
Adapter.

7.3.1 Adding the HART IP CommDTM
The HART IP CommDTM is required for communication via Ethernet with FieldCare. 

NOTICE!
• If you wish to connect to FieldCare via the RS-485 interface, the HART Communication 

CommDTM must be added and configured instead of the HART IP CommDTM. 
• The procedure is similar to that described here, whereby the configuration involves other 

parameters such as selection of multiplexer option, COM port and baudrate.
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1. In the FieldCare project workspace, right-click on the Host Computer node and select 
Add Device:

2. The Add New Device dialog opens:

– Select HART IP Communication and press OK.
– The dialog closes and the HART IP Communication DTM is added below the Host 

node.

3. If desired, the HART IP Communication DTM can be now configured offline.

– Right-click on the node and select Configuration. 
– The node name and timeout (default 10000 ms) can be changed.
– The changes are accepted when the Apply button is pressed.
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7.3.2 Adding the Fieldgate SWG70

1. Right-click HART IP Communication and select Add Device:

2. The Add New Device dialog opens:

– Select WirelessHART Fieldgate SWG70  and press OK.

3. The dialog closes and the Fieldgate SWG70 DTM is added below the HART IP node.

4. If the factory IP address (192.168.1.1) or the Ethernet Port (5094) of the Fieldgate 
SWG70 has been changed, right-click on the HART IP Communication node and select 
Additional Functions => Set DTM Addresses...

– The Set DTM Addresses Dialog opens:

5. Enter the new IP address and/or Ethernet UDP Port number and press Update Changed 
Data.

6. Close the dialog – the Fieldgate SWG70 can now be put online.
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7.3.3 Parameterizing Fieldgate SWG70

1. Right-click HART IP Communication and select Connect:

– The HART IP CommDTM is put on-line and the two arrows turn green.

2. Right-click on the Fieldgate SWG70 node and select Connect.

– The Fieldgate SWG70 DTM is put on-line and the two arrows turn green.

3. Right-click on the Fieldgate SWG70 node and select Online Parameterize: 

– The DTM of Fieldgate SWG70 opens.

4. Expand all the submenus of the directory tree to reveal the parameter blocks. (The 
"Identification" page is open in the graphic below):

– You are now ready to configure the device. See Chapter 8 "Fieldgate configuration" on 
page 42.
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7.3.4 Scanning for wireless devices in the network
After Fieldgate SWG70 has been configured, see Chapter 8.2 onwards, you may want to 
scan for other devices in the network.

1. Right-click on the Fieldgate SWG70 node and select Create Network..:

– You can also click on the Create Network icon to do this.
– The Fieldgate SWG70 is put on-line and the two arrows turn green.

2. The Fieldgate CommDTM now scans the wireless network and automatically adds all 
WirelessHART devices found to the network (in our case the SWA70 adapters):

NOTICE!
• If no device is found although communication has been established, check that the 

adapters have been configured with the correct network identification and join key.
• It may take up to ten minutes for a wireless device to join the network after download of 

the Network ID and Join Key. 
• To increase the performance of a connection to an adapter it is possible to open a fast pipe. 

See Chapter 8.2.3 "Operating Modes" on page 47.
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7.3.5 Scanning for devices connected to adapters
It is also possible to scan for the devices connected to the adapters. Depending on the size of 
the network and the connected field devices, however, it is possible that time out problems 
occur. In this case, FieldCare issues a warning and the user can choose to cut the connection, 
wait for connection or retry the connection.

1. Open a fast pipe to the corresponding adapter. See Chapter 8.2.3 "Operating Modes" on 
page 47.

2. Right-click on the Adapter node and select Create Network...: 

– You can also click on the Create Network icon to do this.

3. The adapter DTM now scans the wired interface and automatically adds all the HART 
devices found to the network (in this case, the temperature transmitter TMT162):

– Depending upon FieldCare configuration and number of devices, this may occur 
automatically or after confirmation with OK in the Scanning Result dialog.

– Depending upon FieldCare configuration, if only one device is found, the 
corresponding Device DTM will open, see below.

4. Repeat the process for all adapters in the network.

5. To open the Device DTM of an unconnected transmitter right-click on the Transmitter 
node and select Connect, then right-click again and select Online Parameterization. 
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7.4 User interface
The Web Server and DTM of the Fieldgate SWG70 are structured in the same manner, so 
that the configuration is identical. Before starting, the Web Server must be open, (see 
Chapter 7.1.1) or the Online parameterization dialog of the DTM must be open, see 
(Chapter 7.3.3). The user interface is structured as follows:

Structure Chapter Modbus OPC EtherNet/IP
Fieldgate configuration Chapter 8

Identification Chapter 8.1 X X X
Wireless Communication Chapter 8.2 X X X

Basic Setup and 
Advanced Setup

Chapter 8.2.1 
and 
Chapter 8.2.2

X X X

Operating Modes Chapter 8.2.3 X X X
Interfaces (wired communication) Chapter 8.3 X X X

Ethernet Chapter 8.3.1 X X X
Serial (RS-485) Chapter 8.3.2 X X X

Protocols (wired communication) Chapter 8.4
Modbus via Ethernet or RS-485 Chapter 8.4.1 X
EtherNet/IP via Ethernet Chapter 8.4.2 X
HART via Ethernet or RS-485 Chapter 8.4.3 X X X
AMS via Ethernet Chapter 8.4.4 X X X

Diagnostics Chapter 9 X X X
Identification Chapter 9.1 X X X
Wireless Communication Chapter 9.2 X X X

Overview Chapter 9.2.1 X X X
Details Chapter 9.2.2 X X X
Burst Lists Chapter 9.2.3 X X X
Topology View (Diagnostics) Chapter 9.2.4 X X X

Wired Communication Chapter 9.3 X X X
Overview Chapter 9.3.1 X X X
HART Chapter 9.3.2 X X X

Engineering Chapter 10 X X X
Instrument List Chapter 10.1 X X X

General Chapter 10.1.1 X X X
Creating and editing an Instrument List Chapter 10.1.2 X X X

Topology View (Engineering) Chapter 10.2 X X X
Configuring Modbus Chapter 10.3 X X

Modbus Settings Chapter 10.3.1 X
Input Status Chapter 10.3.2 X
Input Register Chapter 10.3.3 X

 Configuring a WirelessHART OPC server Chapter 10.4 X
System architecture of an OPC WirelessHART network Chapter 10.4.1 X
Configuring the WirelessHART OPC server with "WirelessHART 
Fieldgate OPC Configurator"

Chapter 10.4.2 X

Description of the WirelessHART Fieldgate OPC Configurator Chapter 10.4.3 X
Configuring bursts using the WirelessHART OPC server Chapter 10.4.4 X

EtherNet/IP configuration Chapter 10.5 X
Setting up an EtherNet/IP connection Chapter 10.5.1 X
Assigning data exchange connections via HART descriptors Chapter 10.5.2 X
Burst commands for cyclic data exchange Chapter 10.5.3 X
Integrating SWG70 into a PLC via EtherNet/IP Chapter 10.5.4 X
Cyclic data exchange via the ControlLogix® controller system Chapter 10.5.5 X
Connection parameters for cyclic data exchange Chapter 10.5.6 X
Diagnostic bits in cyclic data exchange Chapter 10.5.7 X
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The Web interface differs from the DTM only in the presentation of the parameters. In the 
case of the Web interface, the parameters are presented in a single tree. In the case of the 
DTM, configuration, diagnostics and other functions are presented in separate DTM dialog 
boxes. To open the dialog boxes, you must right-click the Fieldgate SWG70 and select the 
desired option from the context menu. The DTM offers addition functions which are FDT-
frame specific, e.g. Set Device Addresses. In both cases parameters are registered by pressing 
Enter. In some cases, in which more than one parameter is registered, an additional button 
must be pressed for the changes to take effect.

Downstream Communication (for discreet field devices) Chapter 10.6 X X
Substitution value (substitution value to DCS) Chapter 10.7 X X

Burst message monitoring Chapter 10.7.1 X X
Factory Acceptance Test (FAT) Chapter 10.7.2 X X

Security – Whitelist, Temporary Join Key Chapter 10.8 X X
Additional Functions Chapter 11 X X X

Reset Chapter 11.1 X X X
Self Test Chapter 11.2 X X X
Firmware Upgrade (Web Server) Chapter 11.3 X X X
Change Password (Web Server) Chapter 11.4 X X X
Set DTM Addresses (DTM) Chapter 11.5 X X X
Set Device Addresses (DTM) Chapter 11.6 X X X
Upload Certificate (Web server) Chapter 11.7 X X X
Auto Refresh Chapter 11.7 X X

Measurement Chapter 12 X X X

Structure Chapter Modbus OPC EtherNet/IP
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8 Fieldgate configuration
Parameter contains all parameters related to the set-up of Fieldgate SWG70. In the case of 
FieldCare, right-click Fieldgate SWG70 and select Online Parameterize.

8.1 Identification
The parameters to be found in this leaf pertain to the identification of Fieldgate SWG70. The 
default parameters of Fieldgate SWG70 will appear in the appropriate input fields.

1. Click Parameters => Identification to display the associated parameters:

2. Enter at least a Device Long Tag and a Device Tag, pressing Enter to register the 
change.

Identification parameters Parameter Meaning Default
Device Long Tag Identifies Fieldgate within the plant network

– Max. 32 character ASCII "Latin 1" string
–

Device Tag Identifies Fieldgate within the plant network
– Max. 8 character HART Packed ASCII string*

–

Descriptor User text describing, e.g. function or location of Fieldgate SWG70
– Max. 16 character HART Packed ASCII string*

–

Date Date in dd.mm.yyyy format; you can enter any date here, e.g. the date of 
the last configuration

01.04.2009

Message User message, to be transmitted with information from the adapter
– Max. 32 character HART Packed ASCII string*

–

Serial number Indicates serial number of connected Fieldgate SWG70 –
Ext. Order Code Indicates order code of connected Fieldgate SWG70 –
Order Code Indicate order identification of the connected Fieldgate SWG70 –
Country Code Country in which the Fieldgate is to be used - select from list

– Governs the signal strength that can be set for the device
Germany

* Valid character set: @ A B C D E F G H I J K L M N O P Q R S T U V W X Y Z 
[ \ ] ^ _ blank ! " # $ % & ' ( ) * + , - . / 0 1 2 3 4 5 6 7 8 9 : ; < = > ?
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8.2 Wireless Communication

8.2.1 Basic Setup
This leaf contains the parameters required to set up the WirelessHART communication 
offered by the Fieldgate SWG70. 

1. Click Parameter > Wireless Communication > Setup, to display the associated 
parameters.

Basic Setup parameters Parameter Meaning Default
Network Tag 32-character network identification tag of Fieldgate SWG70 –
Network ID Unique identification number of the network: Valid range 0-65535 1447
Join Key Part 1 of 4 User network password, 8 hexadecimal characters, Part 1 of 4 456E6472
Join Key Part 2 of 4 User network password, 8 hexadecimal characters, Part 2 of 4 65737320
Join Key Part 3 of 4 User network password, 8 hexadecimal characters, Part 3 of 4 2B204861
Join Key Part 4 of 4 User network password, 8 hexadecimal characters, Part 4 of 4 75736572
Execute Join Click the button to download your changes and restart the network. The 

"Join Key" is sent to all network subscribers and changed.
–

RTC Date Real time clock (RTC) – date, date setting for the network 
Enter the date in the following format: DD/MM/YYYY. The parameter is 
only available in the online mode.

–

RTC Time Real time clock (RTC) – time, time setting for the network
Enter the time in 24-hour format: hh:mm:ss. The parameter is only 
available in the online mode.

–

Network start date Indicates the date on which the network was created
Network start time Indicates the time at which the network was created
Allow New Devices Determines whether new devices are allowed to join the network

• All: any device can join the network
• None: no device can join the network

All

Radio Power Determines power of the radio signal emitted by the device 
– Selection and default value depend on the Country Code
– Observe local restrictions for 2.4 GHz equipment

–

Bandwidth Profile Determines Fieldgate’s bandwidth profile Normal
Global Advertising
Timeout

Determines the period for global advertising on network start-up –

Activate Global
Advertising

Click this button to activate global advertising –
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NOTICE!
• The Join Key parameters can only be entered when DIP switch 8 (inside the Fieldgate 

housing) is set to ON (factory default). See Chapter 6.1.3 "DIP switches" on page 29.

Basic Setup Procedure 1. Click on Parameter => Wireless Communication => Setup

2. Enter the following parameters, pressing Enter after each change:

– Network Tag
– Network ID
– Join Key Part 1 to Part 4.

3. If your national regulations require it, set the radio power to 0dBm (most allow 
10 dBm).

4. Leave all other parameters at their default values, unless you want to activate global 
advertising and/or change the bandwidth profile.

5. Click the Execute Join button to download the join key.

– The following message appears:

6. Click Yes to confirm.

– The following message appears:

7. Click OK to acknowledge the message.

8. To start the network, select Reform Network in Additional Functions > Reset. See 
Chapter 11.1 "Reset" on page 106.

9. The wireless network is now up and running.
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Bandwidth Profile This option allows you to increase network performance by reducing network latency. If bat-
tery power is being used, this option increases energy consumption and reduces battery life. 
If a faster response time is more important than battery life, set the profile to medium or 
high.

To activate the profile, choose Reform Network in Additional Functions => Reset. See 
Chapter 11.1 "Reset" on page 106.

Global Advertising If Global Advertising is activated, the Fieldgate and the network devices issue a series of 
identification messages at a rate higher than normal to identify new wireless devices and to 
reduce the network join time. The messages are sent until the Global Advertising Timeout 
is reached.

As Global Advertising increases energy consumption of the network devices it is recom-
mended that it is activated only when needed, e.g. during the set up of the network. 

1. Enter a Global Advertising Timeout (1 ... 255 minutes)

2. Click the Activate Global Advertising button; advertising starts immediately.

8.2.2 Advanced Setup

Channel Blacklist With WirelessHART technology, Fieldgate SWG70 offers users a self-managed and self-
healing wireless network. If several wireless networks are being operated at one location, 
the Fieldgate automatically selects the optimum channel assignment. If new networks are 
added, the channel assignment is adapted automatically.

Alternatively, you can also configure the channel assignment manually. Note that a WLAN/
Wi-Fi channel based on the IEEE 802.11 standard is wider than a WirelessHART channel 
based on the IEEE 802.15.4 standard. The numbering of the channels is different for 
WLAN/Wi-Fi and WirelessHART.

Example: If the WLAN uses channel 5, channels 5 to 8 in the WirelessHART network must 
be disabled.

Channel numbering
WLAN/WiFi

Channel numbering
WirelessHART

Channel numbering
WLAN/WiFi

Channel numbering
WirelessHART

1 1 to 4 8 8 to 11
2 2 to 5 9 9 to 12
3 3 to 6 10 10 to 13
4 4 to 7 11 11 to 14
5 5 to 8 12 12 to 15
6 6 to 9 13 13 to 15
7 7 to 10
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Disabling channels 1. Disable a channel by deactivating its check box in the Channel Blacklist.

– The number of remaining active channels must be odd.
– At least 5 channels must remain active.

2. Click Send to Device to transfer the updated blacklist settings to the Fieldgate.

– Fieldgate stores the updated blacklist: the updated settings do not apply until the 
network is reformed.

3. Go to Additional Functions > Reset, and click Reform Network to apply the updated 
channel blacklist. See Chapter 11.1 "Reset" on page 106.
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8.2.3 Operating Modes
Operating Modes contains a table listing all devices in the WirelessHART network together 
with their operation modes.

Whenever a wireless device joins the network, it is automatically inserted into the list, pro-
vided it is not already listed. Wired HART devices connected to a WirelessHART Adapter 
(SWA70) are also listed. The list retains all the devices Fieldgate has detected over the life-
time of the network, i.e. if a device is completely removed from the network, it will still be 
seen in the list. Such devices can be removed from the Operating Modes list by clicking on 
the button   which appears next to them. 

– Click on Parameter > Wireless Communication > Operating Modes to display the 
table.

Parameter Meaning
Long Tag Identifies Fieldgate within the plant network

– For HART 5.0 or less, this is the text in the Message parameter
IO card Indicates the virtual I/O card number to which the device is mapped
Channel Indicates the channel of the virtual I/O card to which the device is mapped
Device Type Displays the device type as registered at the HART Communication Foundation
Status Displays the communication status

–  Connected
–  Flashing: Device connected, being identified
–  Continuous: Device connected but not identified
–  Communication failure

Dev. Status Displays the device status
–  Good
–  Out of specification
–  Failure

Note that the device status that is displayed in the list may differ from the actual 
device status because the HART status bits may be interpreted differently.

Routing Device Indicates whether the device is allowed to act a routing device.
• To deactivate the routing functionality, deactivate the corresponding check box 

in the Routing Device column.
• This option enables you to set up a star network 

Fast Pipe Establishes a direct connection to a selected device. The fast pipe connection is 
about 4 times faster than a regular connection, which enables you to perform fast 
updates.
• Click on the check box to activate the Fast Pipe.

– Note that you can activate the Fast Pipe option for only one device at a time.
Enforce Identification Forces a device to resend its identification, for example if a communication failure 

occurred.
Flush Cache Deletes the transmitted values.
Refresh Click this button to reload the operational mode parameters of all network devices
Delete button Devices with no connection can be deleted by pressing the "Delete" button .
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8.3 Interfaces (wired communication)
All Fieldgate SWG70 versions feature an Ethernet interface and a serial interface. 
Depending on the device version, this interface can support different protocols.

See this section for information about the interfaces. For information about the protocols, 
see Chapter 8.4 "Protocols (wired communication)" on page 50.

8.3.1 Ethernet
The parameters contained in this leaf pertain to the set up of the communication to the host 
via Ethernet interface offered by Fieldgate SWG70.

1. Click Wired Communication > Interfaces > Ethernet to display the associated 
parameters:

2. Enter the parameters, pressing Enter after each change.

– Note: Automatic IP address assignment requires that there is a DHCP server in the 
Ethernet network.

3. Click the Write Ethernet Information button when all parameters have been changed.

– The Fieldgate will restart with the new parameters.
– If the IP address was changed, communication will be lost.
– Change your computer's address if necessary and re-establish communication with 

the new IP address.
– If you are using the HART IP CommDTM, reconfigure the communication parameters, 

before making connection again. See Chapter 7.3.2 "Adding the Fieldgate SWG70" on 
page 36, Step 4.

Fieldgate 
SWG70 version

Interface Protocol
Modbus EtherNet/IP HART AMS

SWG70-xx-1
Modbus

Ethernet X – X X
Serial (RS-485) X – X –

SWG70-xx-2
Modbus + OPC

Ethernet X – X X
Serial (RS-485) X – X –

SWG70-xx-3
EtherNet/IP

Ethernet – X X X
Serial (RS-485) – – X –
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Ethernet parameters

8.3.2 Serial (RS-485)
The parameters contained in this leaf pertain to the set up of the serial interface offered by 
Fieldgate SWG70.

1. Click Wired Communication > Interfaces > Serial to display the associated 
parameters:

2. Configure the serial interface for HART or Modbus RTU as required.

3. After configuration, set up the interface protocol parameters in the appropriate 
"Protocol" leaf. 

– Modbus serial allows access for one master. See Chapter 8.4.4 "AMS via Ethernet" on 
page 52.

– HART serial allows access for one primary master and one secondary master. See 
Chapter 8.4.3 "HART via Ethernet or RS-485" on page 51.

Serial parameters

Parameter Meaning Default
IP Address 
Assignment 
(DHCP, DNS)

Specifies whether Fieldgate SWG70 IP network and DNS address is to be 
assigned manually or automatically.
• Manually: The settings in the dialog are used
• Automatically: The IP address of the DNS is assigned by a DHCP server

Manually

IP Address Sets fixed fieldgate IP network address for manual assignment mode 192.168.1.1
Netmask Sets subnet mask IP network address for manual assignment mode 255.255.

255.0
Gateway Address Sets default gateway TCP/IP network address

– This setting is currently not actively used by Fieldgate
0.0.0.0

DNS 1 Sets preferred DNS server IP address for manual assignment mode
– This setting is currently not actively used by Fieldgate

0.0.0.0

DNS 2 Sets alternative DNS server IP address for manual assignment mode
– This setting is currently not actively used by Fieldgate

0.0.0.0

MAC Address Displays the MAC address of the WirelessHART gateway. 
– Note that the MAC address is a characteristic of the device itself and 

cannot be changed. Each device has its own MAC address.

–

Write Ethernet 
Information

Downloads the changed parameters to the Fieldgate
– If the IP address was changed, communication will be lost
– If the other addresses were changed, communication will be interrupted 

for a short period

–

Parameter Meaning Default
Terminal Resistor 
Selection

Specifies whether hardware (DIP switch 6) or software termination 
settings are to be used

Software

Terminal Resistor Sets the termination of the wireless fieldgate when Terminal Resistor 
Selection is set to Software
– If "DIP-Switch" has been is selected, this parameter displays this setting.

Disconnected

Protocol Selection Sets the protocol to be used over the serial port Modbus RTU
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8.4 Protocols (wired communication)
Equipped with interface. Depending on the Fieldgate SWG70 version, different protocols can 
be supported. For an overview see Chapter 8.3 "Interfaces (wired communication)" on 
page 48.

8.4.1 Modbus via Ethernet or RS-485

NOTICE!
• Section 10.2 is only relevant for Fieldgate versions with Modbus, 

order code: SWG70-xx-1 and SWG70-xx-2.

The parameters contained in this leaf pertain to the set up of the Modbus communication to 
the host on the interfaces offered by Fieldgate SWG70. 

1. Click Wired Communication > Protocols > Modbus to display the associated 
parameters:

Modbus parameters Parameter Meaning Default
Bus Address Selection Specifies whether hardware (DIP switch 0-3) or software polling address 

settings are to be used
Software

Bus Address Sets the HART address of the wireless fieldgate when Bus Address 
Selection is set to Software
– When DIP-Switch is selected, displays the setting

1

Baud Rate Selection Specifies whether hardware (DIP switch 4–5) or software baudrate 
settings are to be used
• DIP Switch Setting: 9600 Bit/s - 57600 Bit/s
• Software Setting: 1200 Bit/s - 115200 Bit/s

Software

Baud Rate Sets the baudrate of the wireless fieldgate when Baud Rate Selection is set 
to Software
– When DIP-Switch is selected, displays the setting

38400

Parity Bit Sets the number of parity bits in the Modbus RTU telegram
• Odd, Even or None

Odd

Stop Bit Sets the number of stop bits in the Modbus RTU telegram
• 1, 1.5 or 2

1

Port Number
(Ethernet)

Sets Fieldgate port number for Modbus TCP transmission
– If the port number is changed, the default port remains open
– Modbus TCP allows access for up to five masters

502
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8.4.2 EtherNet/IP via Ethernet
You do not need to make any settings for the EtherNet/IP protocol.

8.4.3 HART via Ethernet or RS-485
The parameters contained in this leaf pertain to the set up of the HART communication to 
the host on the interfaces offered by Fieldgate SWG70.

1. Click Wired Communication => Protocols => HART to display the associated 
parameters:

2. If the default port number is changed, and FieldCare is in use, communication will be 
lost.

3. Reconfigure the HART IP CommDTM communication parameters, before making 
connection again. See Chapter 7.3.2 "Adding the Fieldgate SWG70" on page 36, Step 4.

HART parameters Parameter Meaning Default
Bus Address Selection Specifies whether hardware (DIP switch 0–3) or software bus address 

settings are to be used
• DIP switch: 0 –15
• Software: 0 –63

Software

Bus Address Sets the HART address of the wireless fieldgate when Bus Address 
Selection is set to Software
– When DIP-Switch is selected, displays the setting

1

Baud Rate Selection Specifies whether hardware (DIP switch 4–5) or software baudrate 
settings are to be used
• DIP switch: 9600 Bit/s –57600 Bit/s
• Software: 1200 Bit/s –115200 Bit/s

Software

Baud Rate Sets the baudrate of the wireless fieldgate when Baud Rate Selection is set 
to Software
– When DIP-Switch is selected, displays the setting

19200

Port Number Sets the Fieldgate SWG70 Ethernet port number for HART via UDP/TCP 
transmission
– If the port number is changed, the default port remains open
– HART UDP allows access for two primary masters and two secondary 

masters
– HART TCP allows access for one primary masters and one secondary 

master

5094
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8.4.4 AMS via Ethernet
If you would like to integrate Fieldgate SWG70 into Emerson’s Asset Management System 
(AMS), this must be done via an Ethernet port. In rare cases you will need to change the port 
number. The default port setting is "33333".

1. Click Wired Communication > Protocols > AMS.
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9 Diagnostics
Diagnosis contains all health and related information on Fieldgate SWG70. In FieldCare the 
corresponding function is called by right-clicking on the Fieldgate SWG70 node and select-
ing Diagnostics.

9.1 Identification
The Identification leaf contains information on the hardware and software of Fieldgate 
SWG70.

1. Click Diagnostics > Identification to display the associated parameters:

Identification parameters Parameter Meaning
Device Long Tag Identifies Fieldgate within the plant network
Device Tag Identifies Fieldgate within the plant network
Descriptor User text describing, e.g. function or location of Fieldgate
Date Indicates a date
Message User message, transmitted with information from Fieldgate SWG70
Universal Command 
Revision

Revision of the HART protocol supported by Fieldgate SWG70

Device Revision HART Revision of device specific commands supported by Fieldgate SWG70
Software Revision HART Software revision of Fieldgate SWG70
Gateway Software Versions Indicates the firmware version installed in Fieldgate SWG70
Serial number Indicates serial number of connected Fieldgate SWG70
Order Code Indicates order code of connected Fieldgate SWG70
Order Ident Indicate order identification of the connected Fieldgate SWG70
Country Code Country Code to which Fieldgate SWG70 is set
Assembly Number The assembly number of Fieldgate SWG70
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9.2 Wireless Communication
The Wireless Communication leaf contains information on the operation of Fieldgate 
SWG70 within the wireless network. 

9.2.1 Overview
Overview provides information about the I/O interfaces of the wireless network as well as 
network statistics.

1. Click Diagnostics > Wireless Communication > Overview to display the associated 
parameters:

"Wireless Communication 
- Overview" parameters

Parameter Meaning
I/O System Capabilities
Max. Card Number Indicates the maximum number of cards in the I/O system. This corresponds to the 

maximum number of wireless devices that can be connected to the gateway.
Max. Channel Number Indicates the maximum number of channels.
Max. Sub Dev. Number Indicates the maximum number of sub devices that can be connected to a specific 

channel.
Number of Devices Indicates the current number of subdevices.

– Every device counts as a subdevice, no matter if it is a wireless device or a wired 
device connected to a WirelessHART Adapter (SWA70).

Lifetime Network Statistics
Reliability Ratio of the number of successful packet transmissions to the sum of the successful 

and permanently lost packet transmissions taken across the entire network
Stability Ratio of the number of successful packet transmissions to the sum of the successful 

and unsuccessful packet transmissions taken across the entire network.
– Unsuccessful transmissions are repeated for as many time as necessary using all 

communication paths available. If the repeat process is interrupted, e.g. by 
removing the device from the network, then the corresponding packets are 
counted as lost. 

Latency Average time taken for packets generated by the wireless devices to reach the 
gateway.

Lost Upstream Packages Total number of packets generated by the wireless devices that were lost when 
transferred over the network.
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9.2.2 Details

NOTICE!
• Diagnostic information is available only after the applicable statistics period has been 

completed (15 minutes). During this time, some information is set to 0 or replaced by 
wildcard characters.

Details shows all devices in the WirelessHART network together with their diagnostic 
information.

Whenever a wireless device joins the network, it is automatically inserted into the list if it is 
not already there. Wired HART devices connected to a WirelessHART Adapter (SWA70) are 
also listed. To remove a device from the list, use the Instrument List. See Chapter 10.1 
"Instrument List" on page 62.

1. Click on Diagnostics > Wireless Communication > Details:

Wireless Communication 
Details parameters

Parameter Meaning
Tree-View Deselect this option to sort devices by their sub-device index value
Instrument Identification Displays information identifying the device:

• Long Tag: Long Tag of connected device
• IO card: Identifier of fieldgate card used by the device
• Channel: Identifier of card channel used by the device
• Device Type: Designation of connected device
• Status: Communication status of the associated device

–  Connected
–  Flashing: Device connected, being identified
–  Continuous: Device connected but not identified
–  Communication failure

• Dev. Status: Device status of the associated device
–  Good
–  Out of specification
–  Failure

Note that the device status that is displayed in the list may differ from the actual 
device status because the HART status bits may be interpreted differently.

Number of Joins Number of times the device has joined the network
Join Time Date of the last time the device joined the network
Reliability Percentage of the packets generated by the wireless devices that were correctly 

received by the gateway.
Latency Average time taken for packets generated by the wireless devices to reach the 

gateway.
+/- Show/hide the list of neighboring devices
Neighbors Neighboring WirelessHART devices in reach of the selected device
RSSI Indicates the power of the signal received from the selected device by the named 

neighboring device
Stability Ratio of successful packet transmissions to the total number of packet 

transmissions on all wireless paths in the network
Refresh Updates the instrument list
Export Exports the details list to an Excel file
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9.2.3 Burst Lists
Burst mode is a special mode of a HART slave device which allows it to periodically send the 
response to a selected HART command without the being polled by the master. For a Wire-
lessHART slave device, it is the main operating mode. and can be used, for instance, to send 
the process values from an adapter or connected HART device to Fieldgate SWG70 at regular 
intervals. 

The burst lists, contain information on the devices operating in this mode. The measured 
values sent by the devices can be viewed in the Measurement List. See Chapter 11 "Addi-
tional Functions" on page 106.

1. Click on Diagnostics > Wireless Communication > Burst Lists:

Burst List parameters Parameter Meaning
Instrument Identification Displays information identifying the device:

• Long Tag: Long Tag of connected device
• IO card: Identifier of fieldgate card used by the device
• Channel: Identifier of card channel used by the device
• Device Type: Designation of connected device
• Status: Communication status of the associated device

–  Connected
–  Flashing: Devices connected, identification in progress

 Continuous: Devices connected but not identified
–  Communication failure

• Dev. Status: Device status of the associated device
–  Good
–  Out of specification
–  Failure

+/- Show/hide the burst list details
Burst Command Command number of selected burst commands with explanation:

• 1: Returns the primary value and units
• 2: Returns the loop current and its associated percent of range.
• 3: Returns the loop current and up to four predefined dynamic

variables and units (PV, SV, TV, QV)
• 9: Returns the value and status of up to eight device or dynamic

variables with units
• 48:Returns the complete device status information
• 77: Embeds the commands of a connected wired device so that they can be 

transmitted by wireless
Num. Packets Number of burst messages sent by the network device since the last network 

restart
Refresh Updates the burst list
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9.2.4 Topology View (Diagnostics)
Topology view is a graphical overview of all wireless devices within your network, including 
their connection status and connection paths. It is set up in Engineering => Topology View. 
See Chapter 10.2 "Topology View (Engineering)" on page 65.

1. Click on Diagnostics > Wireless Communication > Topology View to open the dialog:

– The lines between the devices represent the connection paths. 
– The color and thickness indicate the connection quality respectively traffic for each 

connection path.
– The significance of the colors, line thicknesses and other functions are to be found in 

the table which follows.

2. In the example above:

– The most traffic flows between the Adapter WAD_301 and Fieldgate SWG70_01. 
– Less traffic flows between Adapter WAD_302 and WAD_303 respectively and 

Fieldgate SWG70_01 as well as between Adapter WAD_302 and WAD 303 
respectively and Adapter WAD_301.

– There is no traffic between Adapter WAD_302 and Adapter WAD_303, but the path 
is managed as a backup path in the event of one of the other paths failing.

– The stability of all connections is good.

3. Right-click on an adapter to display its network statistics.
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Topology View parameters

9.3 Wired Communication
The Wired Communication leaf contains information on the communication interface used 
to connect to a supervisory system. It contains two submenus: Overview and HART. 

9.3.1 Overview
Overview contains the performance parameters of the wired communication interface

Parameter Meaning
Traffic

Dotted line: Path is unused at the moment

Thin line: Path used by one third of connections 

Medium lines: Path used by two thirds of connections 

Thick line: Path used by all connections

Connection Quality
Signal Red: Signal stability 0 - 10% of maximum possible

Red: Signal stability 10 - 20% of maximum possible

Orange: Signal stability 20 - 30% of maximum possible

Gold: Signal stability 30 - 40% of maximum possible

Yellow: Signal stability 40 - 50% of maximum possible

Lime: Signal stability 50 - 60% of maximum possible

Light Green: Signal stability 60 - 70% of maximum possible

Lawn Green: Signal stability 70 - 80% of maximum possible

Bright Green: Signal stability 80 - 90% of maximum possible

Green: Signal stability 90 - 100% of maximum possible

Operating elements
Reset Zoom Resets the zoom to show everything
Refresh Updates the information on signal quality and traffic
Zoom rider – ------------ + Increases (+) or decreases (–) the magnification of the topology view 
Horizontal image origin Indicates the position of the horizontal origin of the image
Vertical image origin Indicates the position of the vertical origin of the image
Resolution Sets the resolution of the image
Paths shown Selects the paths to be shown in the topology view

– All: all paths are shown
– In use: only those paths used by the network are shown
– Selected: the paths associated with a device are shown when the cursor is moved 

to the said device
– None: No paths are shown



WirelessHART Fieldgate SWG70 Diagnostics

Endress+Hauser 59

1. Click on Diagnostics => Wired Communication => Overview to open the dialog: 

Overview parameters Parameter Meaning
Messages received through 
HOST

Total number of messages received from the host since the start-up or last reset of 
Fieldgate SWG70.

Messages returned to HOST Total number of messages returned to the host since the start-up or last reset of 
Fieldgate SWG70.

Number of requests 
forwarded to IO system

Total number of messages from the host forwarded to the devices in the wireless 
network since the start-up or last reset of Fieldgate SWG70.

Number of responses 
returned from IO system

Total number of messages for the host received from the devices in the wireless 
network since the start-up or last reset of Fieldgate SWG70.
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9.3.2 HART
The HART page shows the possible statuses that may exist for HART devices in the network. 
A tick box beside each parameter indicates whether the described condition is currently 
valid. 

– Click on Diagnostics > Wired Communication > Overview to open the dialog:

– In the case of the Cumulative Extended Device Status, the user must turn to the 
Wireless Communication Details list to get more information on the individual device 
status. See Chapter 9.2.2 "Details" on page 55.
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Wired Communication - 
Details parameters

Parameter Parameter Meaning
Extended Device 
Malfunction

Manager fault Non-recoverable hardware fault: Fieldgate manager
Non-Volatile Memory Defect Non-recoverable hardware fault: Non-volatile 

memory
Volatile Memory Defect Non-recoverable hardware fault: Volatile memory
Ethernet communication 
fault

Non-recoverable hardware fault: Ethernet controller

Electronic defect Non-recoverable hardware fault: Other case
RS-485 communication fault Non-recoverable hardware fault: RS-485 controller

Gateway Operation in 
Progress

Block transfer Fieldgate transferring block
Delayed answer Fieldgate awaiting answer from device (buffer)
Self test Fieldgate is in self test mode, see Chapter 8.6.5
File update Fieldgate writing to non-volatile memory file
Start-up phase Fieldgate is starting up and building the network

Extended List changes Instrument List Changed Instrument list has changed since last refresh
Active Device List Changed Device list has changed since last refresh

Cumulative Device Status Primary Variable Out of 
Limits

PV of a device in the network is out of limits

Non-Primary Variable Out of 
Limits

SV, TV, QV of a device in the network is out of limits

Loop Current Saturated Loop current of a device in the network above 20 
mA

Loop Current Fixed Loop current of a device in the network is fixed to 4 
mA (multidrop mode)

More Status Available Device in the network has more status available 
flagged

Cold Start Device in the network has cold start flagged
Configuration Changed Configuration of a device in the network has 

changed
Extended Device 
Malfunction

Device in the network has malfunctioned

Cumulative Extended Device 
Status

Maintenance required The status "Maintenance required" has been set for a 
device in the network

Device Variable Alert The status "Device Variable Alert" has been set for a 
device in the network

Critical Power Failure The status "Critical Power Failure" has been set for a 
device in the network

Device Operation in Progress "Configuration Changed bit 
reset" procedure

Fieldgate has reset the "Configuration Changes" bit 
of one of the devices

"Sub-Device update" 
procedure

Fieldgate is carrying out the identification of a 
device connected to an adapter

"Device update" procedure Fieldgate is carrying out the identification of an 
adapter
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10 Engineering

10.1 Instrument List

10.1.1 General
This leaf contains a list of instruments in the network. It is also possible to add individual 
devices that are still to be connected.

1. Click on Engineering > Instrument List to open the dialog:

Instrument List 
parameters

Parameter/Field Meaning
Instrument List Displays tabular information identifying the device:

• Long Tag: Long Tag of connected device
• IO card: Identifier of fieldgate card used by the device
• Channel: Identifier of card channel used by the device
• Device ID: HART serial number that is assigned at manufacturing time and that 

differs for each HART device of a given type
• Extended Device Type Code: Unique code identifying the HART product family

Delete button Deletes a device from the instrument list
– Click Apply to register the change in Fieldgate SWG70
– If the device is still communicating with the network, it will automatically 

reappear in the list at the next refresh
– Caution! Deleting a device from the instrument list can change the Modbus 

register address if the Modbus addresses have been automatically generated.
Export/Export CSV Exports the current instrument list as a CSV file
Import/Import CSV Imports an instrument list that has been stored as a CSV file
Import Project Tree (DTM) In Offline Parameterize dialog, imports the network view to the Instrument List
Refresh Updates the instrument list

– After switching on or resetting the device, wait at least one minute before 
pressing the Reset button. 

Apply Stores the current instrument list in Fieldgate SWG70
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10.1.2 Creating and editing an Instrument List
Normally the Instrument List is only generated once the Refresh button is pressed after the 
network is up and running. It is possible, however, to create a list from scratch before any 
WirelessHART devices join the network. This allows the order in which the devices are dis-
played in the both the Instrument List and Operating Modes - and hence in the Modbus 
mapping - to be predetermined. The individual entries can also be edited.

NOTICE!
• When editing the instrument list, incomplete entries are highlighted in red. These data 

must be entered or corrected before the instrument list can be downloaded to Fieldgate 
SWG70.

• Entries marked with yellow already exist: the copies must be removed.

Procedure for Web Server 1. Click on Engineering > Instrument List to display the instrument list.

2. To add a device, click into the last row of the instrument list and enter the Long Tag of 
the device. 

3. Enter the following optional additional parameters by clicking on the appropriate field:

– I/O Card to which the device should be attached.
– Channel: adapters are assigned to Channel 0, devices to Channel 1. 
– Device ID: unique HART serial number assigned on manufacture of the device. 
– Extended Device Type Code: unique code identifying the HART family type. press 

Enter to confirm your entries.

NOTICE!
• If the values of the fields "Device ID" and "Extended Device Type Code" are unknown, "0" must 

be entered.

4. When the instrument list is complete, press Apply to download it to Fieldgate SWG70.

5. When the devices join the network at a later time, they will be assigned to their allotted 
positions in the Operating Modes list.

6. When all devices have joined the network, return to the Instrument List and press 
Refresh to import the latest list. 

7. Click Export to store a copy of the list on your computer as a CSV file. 

– The file can be re-imported into the Instrument List by pressing Import and 
navigating to the folder containing the file.
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Procedure for FieldCare In addition to the previous method, in FieldCare the instrument list can also be generated by 
importing a network tree created in off-line mode. 

1. Create a FieldCare project. See Chapter 7.3.1 "Adding the HART IP CommDTM" on 
page 34 and see Chapter 7.3.2 "Adding the Fieldgate SWG70" on page 36

– Put the HART Communication IP CommDTM and Fieldgate SWG70 CommDTM 
online.

2. Instead of scanning for devices use the Add Device context menu to add first an 
adapter, then the device or devices attached to it. 

– For WirelessHART devices without an adapter, just add the device.

3. Repeat Step 2 until the network is complete.

– Edit the long tags so that they correspond to those stored in your devices.

4. Click on Offline Parameterize > Engineering > Instrument List, to display the empty 
instrument list.

– You may have to enable the Engineering menu first.

5. Click Import Project Tree to import the network tree.

6. Click Export CSV to store the instrument list on your computer. 

7. Close the Offline Parameterize dialog and open the Online Parameterize dialog.

– Click on Engineering > Instrument List to display the empty instrument list. 

8. Click Import CSV and import the file you have just created. 

9. Click Apply to download the instrument list to the Fieldgate.

10. When the devices join the network at a later time, they will be assigned to their allotted 
positions in the Operating Modes list.

11. When all devices have joined the network, return to the Instrument List and press 
Refresh to import the latest list. 

12. Click Export to store a copy of the list on your computer as a CSV file. 

– The file can be re-imported into the Instrument List by pressing Import and 
navigating to the folder containing the file.
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10.2 Topology View (Engineering)
Topology view is a graphical overview of all wireless devices within your network, including 
their connection status and connection paths. The view set up in the dialog described here is 
shown in Diagnosis => Wireless Communication => Topology View, see Chapter 9.2.4.

1. Click on Engineering > Topology View, to open the dialog:

– The dialog opens with icons and long tags for Fieldgate SWG70 and all WirelessHART 
devices connected to the network positioned in a blank workspace.

Topology View parameters Parameter Meaning
Select Map Uploads a map in .jpg format 
Reset Zoom Resets the zoom to the minimum value
Import Uploads the current devices and positions from a CSV file
Export Stores the current devices and positions in a CSV file
Refresh Updates the information on signal quality and traffic
Zoom rider – ------------ + Increases (+) or decreases (–) the magnification of the topology view 
Horizontal image origin Indicates the position of the horizontal origin of the image
Vertical image origin Indicates the position of the vertical origin of the image
Resolution Sets the resolution of the image
Paths shown Selects the paths to be shown in the topology view

– All: all paths are shown
– In use: only those paths used by the network are shown
– Selected: the paths associated with a device are shown when the cursor is moved 

to the said device
– None: No paths are shown
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Topology View set-up The WirelessHART devices are automatically added to the topology view. If required, click 
Refresh to reload the device information. Note that reloading the device information takes 
some time.

1. Click Select Map, to select a background image for the topology view.

– For example, a satellite photo, a floor plan or a diagram.
– The image must be in .jpg format.

2. In the dialog that now appears, click Browse to navigate to the background image.

3. Click Upload Map to upload the background image.

4. If required, edit the coordinates of the image origin in the Horizontal Image Origin 
and Vertical Image Origin boxes.

5. Enter a value in the Resolution box to scale the background image, for example 
0.4 m/pixel.

6. Arrange the WirelessHART devices in the topology view by dragging and dropping the 
icons to a selected position. 

– For more accurate positioning use the slider to zoom in or out of the topology view. 
– Click Reset Zoom to reset the zoom so that all parts become visible.
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7. When the Topology View has been set up, click Apply to store it in Fieldgate SWG70.

Export and Import 1. To export the current devices and their positions to a CSV file, click Export.

2. To load a list of devices and their positions from a CSV file, click Import.
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10.3 Configuring Modbus

NOTICE!
• The "Modbus" function is only available on WirelessHART Fieldgate models with versions 

"SWG70-xx-1-xx-xx" and "SWG70-xx-2-xx-xx". See Chapter 2.3 "Ordering information" on 
page 10.

10.3.1 Modbus Settings
Modbus Settings determines how the Modbus information is to be transmitted by Fieldgate 
SWG70 and where the information is to be found. It also allows the selection of automatic 
or manual mapping. The set-up of the Modbus communication parameters (address, baud-
rate etc.) is described in Chapter 8.4.4.

More details on the Modbus Interface itself and the way in which the HART parameters are 
mapped to the Modbus registers is to be found in. See Chapter 16 "Modbus Interface" on 
page 118.

1. Click on Engineering > Modbus Mapping > Modbus Settings to open the dialog: 

Modbus parameters Parameter Meaning Example Default
Swap Option Selects frame format swap option for Modbus data 

transmission (see also Chapter 16.1.3)
• Big Endian: no swap; 

Register 0 Register 1
Source bytes: [0xABCD] [0xEFGH]
Target bytes: [0xABCD] [0xEFGH]

• Little Endian: Register swap; 
Register 0 Register 1

Source bytes: [0xABCD] [0xEFGH]
Target bytes: [0xEFGH] [0xABCD]

The Swap Option does not apply to the Input Status registers

Big Endian Big Endian

Addressing Method Selects whether the mapping is to be done automatically or 
manually
• Auto: Mapping is done automatically according to the rules 

described in Chapter 16.2
– There is no automatic mapping of Input Status
– The dialogs Input Status and Input Registers are 

deactivated
• Manual: Mapping is done manually or semi-automatically in 

the Input Status and/or Input Register dialogged

Manual Auto

Read Modbus 
Registers Mode

Determines in which registers the mapping is to be done
• Input Registers only: Values mapped to Input Registers 

300001 to 365536
• Input and Holding Values mapped to Input Registers 

300001 to 365536 and Holding Registers 400001 to 
465536

Inactive Inactive
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10.3.2 Input Status
Input Status allows the Modbus mapping of a device with single or multiple binary inputs. 
As Fieldgate SWG70 supports extended registers, values are normally assigned to the regis-
ters with the reference addresses 100001 to 165536. The reference addresses are obtained 
by adding the register number to 100,000. The dialog checks for completeness of entries 
(line turns red if not correctly filled out) as well as double assignment to the registers (line 
turns yellow).

The algorithm assumes that the discrete device delivers a maximum of 256 packed discrete 
values, each comprising 16 bits of an unsigned Integer16 (UINT16). Each bit represents a 
unique input status. Fieldgate first splits the data into two bytes. and reserves 8 registers for 
each byte, i.e. one for each bit contained. 

• Least significant byte (Bits 0 - 7) maps e.g. to registers 100001 - 100008
• Most significant byte (Bits 8 - 15) maps e.g. to registers 100009 - 100016

The value entered after the byte selection determines which of the packed discrete values is 
to be mapped, e.g. 0 will map the first set of packed discrete values and 15 the sixteenth set 
of packed discrete values. More information is to be found in Appendix 16.2.2. 

NOTICE!
• Some HART devices map their binary values and status as PV in HART CMD 3. In this case 

the value and status information will be found in the appropriate Input or Holding 
Register. See Chapter 10.3.3 "Input Register" on page 73.

• If a device status is mapped as UINT8 in the input status register, the status will only be 
found in one of the bit registers, e.g. in bit 0. The UINT8 is stored as a 16-bit value, the 
MSB is populated with "0", see Appendix 16.1.3.

1. Click on Engineering > Modbus Mapping > Input Status to open the dialog:

2. Click on Generate to open the Generate tab.
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Input Status parameters Parameter Meaning Example Default
Table
Registers Defines the start register for the Digital I/O device values

– For Input Status the first value is normally 10000
– The initial value can be overwritten only after a device has been 

selected in the Long Tag drop-down menu
– Subsequent start registers are automatically generated

1 1

End Register End register for Digital I/O device values (generated automatically) 8 65536
Long Tag Click to open a drop-down list of connected network devices – –
IO-Card Identifier of fieldgate card used by the device – –
Channel Identifier of card channel used by the device – –
Value Click to open a drop-down list of values for the selected device

– Least Significant Byte: maps bits 0 - 7 of a UINT16 to one register 
each

– Most Significant Byte: maps bits 8 - 15 of a UINT16 to one 
register each

– –

Value field Enter an appropriate value into the field (0 to 7)
– which opens when a value is selected
– 0: the 1st discrete value of a device is mapped

...
255: the 256th discrete value of a device is mapped

0 0

Delete button Depending upon position, deletes the table or the table line – –
Generate
Start Register Defines the start register for the first Digital I/O device

– For Input Status the first value is normally 1
1 1

Generation Order Order in which the devices are mapped to the Modbus registers.
• Index: According to the index number, see Instrument List, for 

example, Chapter 10.1
• Alphabetical: In alphabetical order according to the Long Tag
• Alphabetical (sub-device): In alphabetical order according to the 

Long Tag of the sub-device.
• IO card & channel: According to the IO card & channel number of 

the wireless device.
• IO card & channel (sub-device): According to the IO card & 

channel number of the sub-device.

– –

Value Click to open a drop-down list of values for the selected device
– Least Significant Byte: maps bits 0 - 7 of a UINT16 to one register 

each
– Most Significant Byte: maps bits 8 - 15 of a UINT16 to one 

register each

– –

Value field Enter an appropriate value into the field
– which opens when a value is selected
– 0: the 1st discrete value of a device is mapped

...
255: the 256th discrete value of a device is mapped

0 0

Delete button Depending upon position, deletes the table or the table line – –
Generate Writes mapping table to table in Table tab – –
Delete all mappings • Checked: Overwrites any table already in Table tab

• Unchecked: Adds any new devices found to existing table.
– –

Operating elements
Import Imports a mapping table in CSV format – –
Export Exports the current mapping table in CSV format – –
Refresh Loads the mapping table currently stored in Fieldgate SWG70 – –
Apply Stores the current mapping table to Fieldgate SWG70 – –
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Semi-automatic 
generation of Input Status 
mapping table

1. Click on the Generate tab to open the Generate dialog:

2. Enter an offset value in the Start register field.

– For a typical application the start value is normally 1.

3. Select the order in which the devices are to be mapped to the Modbus registers in the 
Generation order drop-down list. 

4. Select the values you want to read for each device in the Value column.
- Least Significant Byte will map Bits 0 - 7 of an UINT16
- Most Significant Byte will map Bits 8 - 15 of an UINT16

5. Enter a the index of the UINT16 to be mapped (0 or 15) into the value field which now 
opens.

6. Repeat Steps 4 and 5 for all UINT16.

7. If required, check the Delete all Mappings checkbox to overwrite any existing 
mappings. 

– If the box is unchecked, any new devices found will be added to an existing table. 

8. Click Generate to write the mapping to the table on the Table tab.

9. Click the Table tab to view the generated mapping table.

10. Manually edit the generated mapping table by deleting unwanted entries with the 
Delete  button., e.g. all analog devices.

– The registers occupied by the deleted entries remain free.

11. After the mapping table is complete, click Apply to store the table in Fieldgate SWG70.
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Manual entry of an Input 
Status mapping table

1. Click on the Table tab to open the Table dialog:

2. Select a device from the drop-down menu that appears when the Long Tag field is 
clicked. 

3. Enter an offset value in the Register field.

– For a typical application the start value is normally 1.
– Offset values > 1: only values (n +1) are allowed, where n is divisible by 8.
– For the first device entered, an extra field will be added for the registers 0 to e.g. 200 

that lie before the entered value.
– The line turns red if information is missing. 
– and remains so until all entries are made. 
– For subsequent entries, missing values are outlined in red.

4. Select the value you want to read for the device in the Value column.

– Least Significant Byte will map Bits 0 - 7 of an UINT16
– Most Significant Byte will map Bits 8 - 15 of an UINT16

5. Enter the index of the UINT16 to be mapped (0 or 15) into the value field which now 
opens.

6. Repeat Steps 2, 4 and 5 for all other devices.

7. If required, manually edit the generated mapping table by deleting unwanted entries 
with the Delete  button.

8. After the mapping table is complete, click Apply to store the table in Fieldgate SWG70.

Import and Export of 
mapping tables

The export/import functionality can be useful if you want to create the mapping table using 
a spreadsheet program, or if you want to import a backup of an existing mapping table.

1. To export the current mapping table to a CSV file, click Export. 

2. To load the mapping table from a CSV file, click Import.

– Click Apply to store the imported mapping table in Fieldgate SWG70.

3. To reload the mapping table currently used by Fieldgate SWG70, click Refresh.
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10.3.3 Input Register
Input Register allows the Modbus mapping of Fieldgate SWG70 and the connected HART 
devices. As Fieldgate SWG70 supports extended registers, values are normally assigned the 
Input Registers with the reference addresses 300001 to 365536. In the case of some Mod-
bus systems values must be assigned to the holding registers with reference addresses 
400001 to 465536, see Read Modbus Registers Mode in Section 10.2.1. The dialog checks 
for completeness of entries (line turns red if not correctly filled out) as well as double assign-
ment to the registers.

1. Click on Engineering > Modbus Mapping > Input Register to open the dialog:

2. Click on Generate to open the Generate tab.
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Input Register parameters Parameter Meaning Example Default
Table
Registers Defines the start register for the HART device value

– For Input Register the first value is normally 1
– The initial value can be overwritten only after a device has 

been selected in the Long Tag drop-down menu
– Subsequent start registers are automatically generated

13 1

End Register End register for Digital I/O device values (generated 
automatically)

14 65536

Long Tag Click to open a drop-down list of connected network devices – –
IO-Card Identifier of fieldgate card used by the device – –
Channel Identifier of card channel used by the device – –
Value Click to open a drop-down list of values for the selected device – –
Delete button Enter an appropriate value into the field

– which opens when a value is selected
Generate
Start Register Defines the start register for the HART device value

– For Input Registers this is normally 1, depending on the 
Modbus system in use

13 1

Generation Order Order in which the devices are mapped to the Modbus 
registers.
• Index: According to the index number, see Instrument List, 

for example. See Chapter 10.1 "Instrument List" on page 62.
• Alphabetical: In alphabetical order according to the Long 

Tag
• Alphabetical (sub-device): In alphabetical order according to 

the Long Tag of the sub-device.
• IO card & channel: According to the IO card & channel 

number of the wireless device.
• IO card & channel (sub-device): According to the IO card & 

channel number of the sub-device.

– –

Value Click to open a drop-down list of values for the selected device – –
Value field Enter an appropriate value into the field

– which opens when a value is selected
0 0

Delete button Depending upon position, deletes the table or the table line – –
Default Settings Adds all HART Command 3 values to the value list, see See 

Chapter 16 "Modbus Interface" on page 118.
– –

Generate Writes mapping table to table in Table tab – –
Delete all mappings • Checked: Overwrites any table already in Table tab

• Unchecked: Adds any new devices found to existing table.
– –

Operating elements
Import Imports a mapping table in CSV format – –
Export Exports the current mapping table in CSV format – –
Refresh Loads the mapping table currently stored in Fieldgate SWG70 – –
Apply Stores the current mapping table to Fieldgate SWG70 – –
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Semi-automatic 
generation of Input 
Register mapping table

1. Click on the Generate tab to open the Generate dialog:

2. Enter an offset value in the Start register field.

– For a typical application, e.g. monitoring of device values only, the Start value is 
normally 1.

– If you intend to monitor Fieldgate SWG70 values, enter 13, in order to leave space for 
the Fieldgate values.

3. Select the order in which the devices are to be mapped to the Modbus registers in the 
Generation order drop-down list.

4. Click Default Settings to automatically load HART CMD 3 values as well as device and 
status information into the value list

– Alternatively click in the value field and choose the values you require.
– Note that the list will be replicated for all devices, so some editing may be required 

later. 

5. If required, check the Delete all Mappings checkbox to overwrite any existing 
mappings. 

6. If the box is unchecked, any new devices found will be added to an existing table.

7. Click Generate to write the mapping to the table on the Table tab.

8. Click the Table tab to view the generated mapping table.

9. If you want to add Fieldgate SWG70 to the mapping table:

– Select Fieldgate SWG70 in the Long Tag drop down menu.
– Select a value from the value list.
– Repeat the selection for as many Fieldgate SWG70 values as you wish to map.

10. If required, manually edit the generated mapping table by deleting unwanted entries 
with the Delete  button.

11. After the mapping table is complete, click Apply to store it in Fieldgate SWG70.
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Manual entry of an Input 
Register mapping table

1. Click on the Table tab to open the Table dialog:

2. Select a device from the drop-down menu that appears when the Long Tag field is 
clicked. 

3. Enter an offset value in the Register field.

– Offset value >1: For the first device entered, an extra field will be added for the 
registers 0 to e.g. 200 that lie before the entered value.

– The line turns red if information is missing.
– and remains so until all entries are made.
– For subsequent entries, missing entries are outlined in red.

4. Select the value you want to read for the device in the Value column.

– If you select CMD 48 Device Status enter a response byte as well.
– More information: see CMD48 Read Additional Status Information, Appendix 16.3.3.

5. Repeat Steps 2, 4 and 5 for all other devices.

6. If required, manually edit the generated mapping table by deleting unwanted entries 
with the Delete  button.

7. After the mapping table is complete, click Apply to store the table in Fieldgate SWG70.

Import and Export of 
mapping tables

The export/import functionality can be useful if you want to create the mapping table using 
a spreadsheet program, or if you want to import a backup of an existing mapping table.

1. To export the current mapping table to a CSV file, click Export. 

2. To load the mapping table from a CSV file, click Import.

3. Click Apply to store the imported mapping table in Fieldgate SWG70.

4. To reload the mapping table currently used by Fieldgate SWG70, click Refresh.

10.4 Configuring a WirelessHART OPC server 
The WirelessHART OPC server for Fieldgate SWG70 can be easily configured with the pro-
gram "WirelessHART Fieldgate OPC Configurator", which is to be found on the data medium 
supplied.

NOTICE!
• The "WirelessHART OPC server" function is only available on WirelessHART Fieldgate 

models with the version "SWG70-xx-2". See Chapter 2.3 "Ordering information" on 
page 10.

For information on operating the program see Chapter 10.4.2 "Configuring the 
WirelessHART OPC server with "WirelessHART Fieldgate OPC Configurator"" on page 78. For 
a description of the program see Chapter 10.4.3 "Description of the WirelessHART Fieldgate 
OPC Configurator" on page 81.
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10.4.1 System architecture of an OPC WirelessHART network
The following figure shows a typical architecture with the WirelessHART OPC server.

Fig. 10-1: System architecture of an OPC WirelessHART network

1 Computer as OPC client with OPC tunnel 
application, OPC tunnel application. See Chapter  
"OPC tunnel" on page 78.

2 Computer as WirelessHART OPC server with 
OPC tunnel application and the program 
"WirelessHART Fieldgate OPC Configurator". 
The program generates the necessary OPC 
configuration data for the communication with 
Fieldgate SWG70

3 Fieldgate SWG70
4 Field device with antenna (adapter)
5 WirelessHART-Adapter SWA70 (adapter)
6 Field devices (subdevices)

Ethernet

1

2

3

4

OPC client

Ethernet

5

6

WirelessHART OPC server
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OPC tunnel

An OPC tunnel is required in the following case:

• The WirelessHART OPC server and OPC client are running on different PCs. that are 
managed in different domains.

An OPC tunnel is not required in the following cases:

• The WirelessHART OPC server and OPC client are running on the same computer.
• The WirelessHART OPC server and OPC client are running on different computers, but the 

computers are managed in the same domain.

In this way, configuration problems due to DCOM security settings and DCOM interruptions 
are avoided. 

The OPC tunnel is not included in the scope of supply and must be separately licensed.

Examples of OPC tunnel products are:

• Softing: PC Easy Connect Suite 
• MatrikonOPC: OPC-TunellerTM

10.4.2 Configuring the WirelessHART OPC server with 
"WirelessHART Fieldgate OPC Configurator"

Installing the WirelessHART OPC server

Install the program "Wireless HART Fieldgate OPC server" on the computer that is to be used 
as the WirelessHART OPC server. The program can be found on the data medium supplied. 
Follow the instructions of the Installation Wizard.

"Learn" – add objects automatically to the device tree

1. Start the program either via the Windows Start icon or via the program icon on the 
desktop. The following window appears: 
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2. In the left pane, click on the Fieldgate.

3. Enter a name for the Fieldgate in the field "OPC Name". The name is added to the device 
tree in the left pane. The OPC client identifies the Fieldgate through its OPC name.

4. Enter the "Long Tag Name" of the Fieldgate in the field "Device Name". The "Device 
Name" must be identical to the "Long Tag Name", since the designation of the Fieldgate 
is identified through it.

5. Enter the appropriate data in the fields "IP Address", "Port" and "HART Bus Address".

6. Click on the button "Communication Test", in order to check whether the Fieldgate can 
be found.

NOTICE!
• If the test is unsuccessful, check your entries in the fields "Device Name", "IP Address" as well 

as the Ethernet configuration. If necessary, consult your IT department.

7. Click on the icon "Learn"   in the top left of the menu tray. 
All objects that are connected to the Fieldgate are imported into the device tree. These 
may be:

– Adapters: adapters such as a WirelessHART Adapter SWA70 or a field device with 
antenna. You can add several field devices below an adapter.

– Subdevices: field devices without an antenna. You cannot add other objects below a 
field device (subdevice).

8. In the left pane, click on Fieldgate SWG70.

9. Configure the remaining parameters. See Chapter 10.4.3 "Description of the 
WirelessHART Fieldgate OPC Configurator" on page 81.

10. Configure all the adapters and field devices (subdevices) as described in Chapter 10.4.3. 
In order to enable parameterization, select the adapter or field device concerned in the 
left pane. The device tree can be structured using the object "Folder".

11. Use the File menu to store the configuration file.

– File > Save Active: the configuration file is stored under the name 
GatewayConfiguration.xml in the folder that is accessed by the WirelessHART OPC 
server.

– File > Save As: You can select your own file name and storage location for the 
configuration file.
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"Add" – add objects manually to the device tree

1. Start the program either via the Windows Start icon or via the program icon on the 
desktop. The following window appears: 

2. Configure the Fieldgate SWG70. See Chapter 10.4.3 "Description of the WirelessHART 
Fieldgate OPC Configurator" on page 81.

3. In the left pane, click on the Fieldgate.

4. Right click on the Fieldgate to open the context menu.

5. Using the Add menu, add other objects such as a Folder, Adapter or Subdevice (field 
device). The device tree in the left pane is extended as appropriate.

– Folder: the object "Folder" can be used to structure the device tree. "Folder" may contain 
several adapters and field devices (subdevices).

– Adapters: adapters such as a WirelessHART Adapter SWA70 or a field device with 
antenna. You can add several field devices below an adapter.

– Subdevices: field devices without an antenna. You cannot add other objects below a 
field device (subdevice).

6. Configure all the adapters and field devices (subdevices) as described in Chapter 10.4.3. 
In order to enable parameterization, select the adapter or field device concerned in the 
left pane.

7. Use the File menu to store the configuration file.

– File > Save Active: the configuration file is stored under the name 
GatewayConfiguration.xml in the folder that is accessed by the WirelessHART OPC 
server.

– File > Save As: You can select your own file name and storage location for the 
configuration file.
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10.4.3 Description of the WirelessHART Fieldgate OPC Configurator

Entry fields in the right pane

The Fieldgate, adapters and field devices are configured with the parameters in the right 
frame. Select the object to be configured in the left pane. the right pane displays the param-
eters that must be entered for that object.

Identification Enter the names for the Fieldgate, the selected adapter or the selected field device in the 
Identification area.

Gateway Enter the access and communication data for the Fieldgate in the Gateway area.

Parameter Meaning
OPC Name A character string that identifies the Fieldgate, adapters or field devices. The name 

entered is displayed in the device tree in the left pane.
Device Name A character string that identifies the Fieldgate. It is recommended that the "Device 

Name" is identical to the "Long Tag Name".

Parameter Meaning
IP Address IP address of the Fieldgate
Port Port number of the Fieldgate. Standard: 5094
HART Bus Address HART bus address of the Fieldgate. Factory setting: 1
Communication Timeout Time that elapses between two successive failed attempts to open communication 

between the WirelessHART OPC server and the Fieldgate. Valid range: 
1000…10000 ms, Factory setting: 1000 ms

Maximum Timeout Retry 
Value

Maximum number of successive attempts to open communication between the 
WirelessHART OPC server and the Fieldgate. Valid range: 1-20. Factory setting: 10

Connect Gateway Interval Time that elapses after an unsuccessful attempt to open communication before the 
WirelessHART OPC server tries to open communication again.
Valid range: 20000…60000 ms. Factory setting: 20000

1 Communication Timeout 
2 Connect Gateway Interval
3 Maximum Timeout Retry Value

Communication Test Check the connection between the WirelessHART OPC server and the Fieldgate.

t1 2 3 4 5 6 7 8 9 10

1 2

3

2 2 2
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HART commandos Enter the settings for the HART commands in the Variable Configuration area. The HART 
command is activated only when the corresponding Active checkbox is ticked.

NOTICE!
• In order to minimize the scanning time, you must enter the same parameters for the 

Sampling Rate and Request Data that you have already used for the WirelessHART 
Adapter (SWA70).
For example, when a WirelessHART Adapter transmits Command 2 every 15 minutes and 
Command 48 every 60 minutes, only CMD 2 and CMD 48 should be activated and the 
corresponding times entered in the Sampling Rate field.

For more information see the WirelessHART Adapter operating instructions.

Menus

File menu

Edit menu This menu corresponds to the context menu which opens when an object is right clicked.

Parameter Meaning
Device Identification Identification of the device. Options: every minute or every hour.
CMD 1: Primary Value Transmits the primary variable and its unit at the selected interval.
CMD2 Loop Current and % of 
Range

Transmits the value of the 4…20 mA signal and the corresponding percentage 
value at the selected interval.

CMD 3: Dynamic Variables 
and Loop Current

Transmits the value of the 4…20 mA signal and up to four predefined process 
variables (PV, SV, TV and QV) and corresponding units at the selected interval.

CMD 9: Device Variables 
with Status

Transmits the values, units and status of up to eight field device variables at the 
selected interval.

CMD 33: Device Variables Transmits the values and units of up to four field device variables at the selected 
interval.

CMD 48: Additional Device 
Status

Transmits the entire device status information at the selected interval.

Designation Meaning
New Opens an empty configuration file.
Recent Opens the last used configuration file.
Open Opens a configuration file.
Open Active Opens the configuration file that is accessed by the WirelessHART OPC server.
Save As Saves a configuration file with a new file name and in any desired folder. 
Save Active Saves the configuration file under the name "GatewayConfiguration.xml" in a 

predefined folder. The WirelessHART OPC server accesses this file.
Exit Closes the "WirelessHART Fieldgate Configurator" program.

Designation Meaning
Add Add an object such as a Folder, Adapter or Subdevice (field device). The device tree 

in the left pane is extended as appropriate.
– Folder: the object "Folder" can be used to structure the device tree. "Folder" may 

contain several adapters and field devices (subdevices).
– Adapters: adapters such as a WirelessHART Adapter SWA70 or a field device 

with antenna. You can add several field devices below an adapter.
– Subdevices: field devices without an antenna. You cannot add other objects 

below a field device (subdevice).
Delete Delete an object.
Cut Delete an object and put it in the clipboard.
Copy Copy an object.
Paste Add an object from the clipboard.
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Symbols (icons)

Designation Meaning
Learn
Click on this icon to check whether a Fieldgate is connected to the WirelessHART 
OPC server. If this is the case, all objects that are connected to the Fieldgate and 
online are displayed in the device tree. If there is no connection to the Fieldgate an 
error message appears in the "Messages" area.
Verify
Click on this icon to check a manual configuration of the device tree against the 
actual configuration of the connected Fieldgate. The status of the Fieldgate, 
adapters and field devices (subdevices) is indicated by a colored border.
– Red border: object was not found.
– Yellow border: object was found, but is not represented in the device tree.
– Green border: object was found and is represented in the device tree.
If there is no connection to the Fieldgate an error message appears in the 
"Messages" area.
The verification of the configuration with that of the connected WirelessHART 
network is done by means of the device "Long Tag". Enter the "Long Tag Name" in 
the field "Device Name" in the "WirelessHART Fieldgate Configurator" program. The 
designation entered in the field "OPC Name" is that displayed in the device tree.
Import CSV
Click on the icon to import a CSV file such as the Fieldgate’s "Instrument List" or 
"Modbus".
The device tree will then be generated and displayed in accordance with the 
contents of the CSV file.
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10.4.4 Configuring bursts using the WirelessHART OPC server 
By using OPC technology, the WirelessHART OPC server offers the possibility of aligning the 
burst rate with the WirelessHART Adapter SWA70 in accordance with the application 
requirements. This means that no other program, for example FieldCare, is required for the 
configuration.

Prerequisites The following prerequisites are necessary for burst configuration:

• The WirelessHART OPC server has been installed.
• The WirelessHART OPC server has been configured with the program "WirelessHART 

Fieldgate OPC Configurator". The configuration file was saved with the menu item "Save 
Active".

• The OPC client is connected to the WirelessHART OPC server.
• The link to the OPC server has been established in the WirelessHART OPC client. The 

device tree structure created in the "WirelessHART Fieldgate OPC Configurator" appears:

Burst configuration The burst configuration is described and illustrated on the basis of the OPC client "OPC Data 
Spy". Designations and procedures may differ for other OPC clients.
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1. Select a WirelessHART Adapter.

2. Open the folder "Burst Configuration" for the selected WirelessHART Adapter.
Every WirelessHART Adapter has its own "Burst Configuration" folder. The folder 
contains the required "Burst OPC Data Items".

3. Activate the "Monitor" function for the folder "Burst Configuration".

4. Change to the folder "Data Monitor". The folder shows the current values of the "Burst 
OPC Data Items".

5. Configure the "Burst OPC Data Items" according to your requirements.
For a description see Chapter  "Description of the Burst OPC Data Items" on page 85

– Click on the "Burst OPC Data Item" that you want to configure.
– Select the client function "Sync Write" with a right click.
– Enter the new value. The newly entered value appears in the column "Value". Note that 

the value has not been sent to the Fieldgate at this point.
– Repeat the procedure for every "Burst OPC Data Item" to be configured.

6. Set the "Burst OPC Data Item" StartConfiguration to the value "1" in order to transmit 
burst configuration to the Fieldgate. 

– Before transmission begins, the entered values are checked. If the values are invalid, 
the transmission is stopped. The "Burst OPC Data Item" LastInfoMessage indicates 
the error. 

– If there are no errors, the "Burst OPC Data Item" LastInfoMessage displays the current 
status.

– Once the burst has been successfully transmitted and activated, the "Burst OPC Data 
Item" LastInfoMassage shows a message to this effect.

Description of the Burst OPC Data Items
Designation Meaning
BurstConfiguration.
BurstModeControlCode
(Burst-Modus)

Enter a number to switch the burst on or off.
• 0: Off
• 2: Wireless

BurstConfiguration.
CommandNumber

Enter the command number that is to be transmitted.
• Valid commands when the burst is for an adapter: 

(MapSubDevice.DeviceIndex = 0): 1, 2, 3, 9, 33, 48
• Valid commands when the burst is for a field device

(MapSubDevice.DeviceIndex = from 1 to 4): 0 – 255
Check the field device manual for supported commands.

BurstConfiguration.
Device Variable.Variable1-8

If you use burst commands "9" or "33" or both, enter the appropriate codes for the 
device variables. Codes for the WirelessHART-Adapter SWA70 are listed in see 
Chapter  "Device Variable Codes" on page 87. Check the appropriate manual for the 
codes of other field devices.
• Device variables 1 – 8 are available for burst command "9". 
• Device variables 1 – 4 are available for burst command "33". 

BurstConfiguration.
LastInfoMessage

Displays information over the burst parameter set that should be or has been 
transmitted. Possible information: error messages if the burst parameter set has 
errors before transmission; status messages during transmission; a message 
indicating successful transmission and activation of the burst.

BurstConfiguration.
MapSubDevice.DeviceIndex

Enter the device from which the burst command was transmitted.
• 0: Adapter
• 1: HART Subdevice 1
• 2: HART Subdevice 2
• 3: HART Subdevice 3
• 4: HART Subdevice 4

BurstConfiguration.
MapSubDevice.Message

Configures up to 10 burst messages.
Valid range: 1 – 10
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BurstConfiguration.
Period.UpdatePeriod
(time period)

If the "Trigger Mode" is set to "Continuous", enter the time that must elapse between 
two burst messages. If the "Trigger Mode" is set to any other option, this parameter 
determines the fastest rate.
• Valid range: 1 second to 24 hours (32000 – 2764800000)
• 1 second = 32000
• 10 seconds = 320000
For more information see the Operating Instructions for the WirelessHART 
Adapter SWA70, Chapter "Burst Mode", Table "Burst Mode Parameters", Parameter 
"Period".

BurstConfiguration.
Period.MaxUpdatePeriod
(Max. time period)

If the "Trigger Mode" is set to a value other than "Continuous", enter the maximum 
period in seconds that can elapse between two burst
messages if the condition ("Trigger Level") is not met.
• Valid range: 1 second to 24 hours (32000 – 2764800000)
• 1 second = 32000
• 10 seconds = 320000
For more information see the Operating Instructions for the WirelessHART 
Adapter SWA70, Chapter "Burst Mode", Table "Burst Mode Parameters", Parameter 
"Max. Period".

BurstConfiguration.
StartConfiguration

Starts the transmission of a burst configuration.
• 0: Default value – the burst configuration is not transmitted.
• 1: The entire burst parameter set is transmitted to the WirelessHART Adapter 

concerned.
BurstConfiguration.
Trigger.ModeSelectionCode
(Trigger mode)

Specifies the event that triggers a burst message from a device.
Options:
• 0: Continuous
• 1: Window
• 2: Rising
• 3: Falling
• 4: On change
For more information see the Operating Instructions for the WirelessHART 
Adapter SWA70, Chapter "Burst Mode", Table "Burst Mode Parameters", Parameter 
"Trigger Mode".

BurstConfiguration.
Trigger.TriggerLevel
(Trigger level)

Specifies the threshold for switching from "Period" to the "Max. Period", i.e. from the 
fast to the slow setting.
– The switching mode is specified in the "Trigger Mode".

BurstConfiguration.
Trigger.UnitsCode
(Unit (Trigger))

See Chapter 18 "Table Device Variable Classification and Unit Code" on page 131.

BurstConfiguration.Trigger.
VariableClassificationCode
(Class of device variable 
(Trigger))

See Chapter 18 "Table Device Variable Classification and Unit Code" on page 131.

Designation Meaning
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Device Variable Codes

Device Variable Codes for 
WirelessHART Adapter 
SWA70

For additional information, see the Operating Instructions for the WirelessHART Adapter 
SWA70, Chapter "Device Variable Mapping".

Device Variable Codes for 
field devices (subdevices)

If you configure a burst for a field device (subdevice), use the Device Variable Codes to be 
found in the corresponding manual.

Device Variable codes Meaning
0 Battery temperature
1 Minimal battery temperature
2 Maximal battery temperature
3 Battery voltage
4 Consumed energy
5 RSL to best neighbor
6 RSL to second best neighbor
7 Battery voltage with load
8 Battery voltage without load
9 Normalized consumed energy
243 Estimated lifetime of battery
244 Percent range of loop current
245 Loop current
246 Primary variable
247 Secondary variable
248 Tertiary variable
249 Quaternary variable
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10.5 EtherNet/IP configuration
NOTICE!
• The "EtherNet/IP" function is only available on WirelessHART Fieldgate models with the 

version "SWG70-xx-3". See Chapter 2.3 "Ordering information" on page 10.

The Fieldgate SWG70-xx-3 makes cyclic data available from up to 39 devices 
(WirelessHART Adapters and field devices) via EtherNet/IP. In addition, data from Fieldgate 
itself can also be made available via EtherNet/IP. Fieldgate offers 10 cyclic data exchange 
connections for this purpose. Cyclic data from up to 4 devices can be exchanged via a data 
exchange connection.

10.5.1 Setting up an EtherNet/IP connection

1. Set up the WirelessHART network. See Chapter 5.3 "Connecting to Ethernet" on 
page 22. See Chapter 7.1 "Ethernet connection" on page 31.

2. Define the HART descriptors for all the HART and WirelessHART field devices that 
should be monitored via EtherNet/IP according to the naming conventions. See 
Chapter 10.5.2 "Assigning data exchange connections via HART descriptors" on 
page 88.

3. Define the burst commands for all the HART and WirelessHART field devices that 
should be monitored via the cyclic EtherNet/IP connection. See Chapter 10.5.3 "Burst 
commands for cyclic data exchange" on page 89.

4. Integrate the WirelessHART Fieldgate SWG70 into your control system. For this 
purpose, install the Add-On Profile (AOP) or the EDS file. See Chapter 10.5.4 
"Integrating SWG70 into a PLC via EtherNet/IP" on page 90.

5. Make the configuration for cyclic or direct data exchange with the HART and 
WirelessHART field devices. See Chapter 10.5.5 "Cyclic data exchange via the 
ControlLogix® controller system" on page 90.

10.5.2 Assigning data exchange connections via HART descriptors
The "HART Descriptor" parameter is used to make available the cyclic data from field devices 
and Fieldgates. You can configure this parameter in the corresponding DTM or DD.

The "HART Descriptor" parameter has the following structure for all field devices and for the 
Fieldgates: 

• Up to 13 characters of customized text
• Identifier with 3 characters.

The customized text is used to identify the devices in readable format. You can enter the tag 
name here for example.

The identifier is used to assign the cyclic data and has the following structure:

• 1st character: @
• 2nd character: choice of one of the 10 cyclic data exchange connections. The letter "A" 

corresponds to connection "1" and the letter "J" to connection "10". 
• 3rd character: device identifier

The identifier @A0 is pre-assigned by Fieldgate and may not be used for WirelessHART 
Adapters or field devices.
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Application example The WirelessHART network consists of a Fieldgate, 4 adapters and 4 measuring devices. 

HART descriptors for HART field devices:

• LT101@A1
• PT101@A2
• FT101@A3
• TT101@B0

HART descriptors for adapters:

• ADAPTER1@B1
• ADAPTER2@B2
• ADAPTER3@B3
• ADAPTER4@C0

10.5.3 Burst commands for cyclic data exchange
In the case of WirelessHART, the variables from field devices and WirelessHART Adapters 
are transmitted to the Fieldgate by burst commands. You must configure the burst 
commands accordingly.

Use the DTM or DD of the corresponding WirelessHART device and flag the following burst 
commands:

• Command 9: Read Device Variables with Status
• Command 48: Read Additional Status

As an alternative to command 9, you can flag command 3 "Read All Dynamic Variables and 
Loop Current" or command 33 "Read Device Variables".

The following variables are available with HART commands 3, 9, 33 and 48:

As an alternative to command 9, you can flag command 3 "Read All Dynamic Variables and 
Loop Current" or command 33 "Read Device Variables".

Bit ".NoDataBurstConfigured" in "DeviceStatus_Struct" means that neither command 3, 9 nor 
command 33 has been flagged. Bit ".NoDataBurstConfigured" in "DeviceStatus_Struct" means 
that command 48 has not been flagged. 

See Section "Data block of the WirelessHART Fieldgate" on page 95. See Section "Data block 
of the HART devices" on page 97.

NOTICE!
• You can check the burst commands of all the HART devices in the WirelessHART 

network in the Fieldgate Web server or in the DTM as follows: Diagnostics > Wireless 
Communication > Burst Lists. See Chapter 9.2.3 "Burst Lists" on page 56.

Cyclic data variables In the HART command
3 9 33 48

PV, SV, TV, QV x x x
PV Status, SV Status, TV Status, QV Status x
PV Unit, SV Unit, TV Unit, QV Unit x x x
Additional Device Status Information x
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10.5.4 Integrating SWG70 into a PLC via EtherNet/IP

Rockwell Automation ControlLogix®

You can integrate the WirelessHART Fieldgate into ControlLogix® via an Add-On Profile 
(AOP).

Add-On Profile can be found on www.endress.com.

Once the Add-On Profile (AOP) has been installed, you can access the WirelessHART 
Fieldgate via the device catalog in ControlLogix®.

Other controller systems

For other controller systems, the WirelessHART Adapter is integrated via the EDS file 
(Electronic Data Sheet). You can identify the WirelessHART Fieldgate in the network 
configuration tool and put it into operation via the EDS file.

EDS file can be found on www.endress.com.

For more information on how to install the EDS file and integrate a new device, please see 
the documentation for the controller system.

10.5.5 Cyclic data exchange via the ControlLogix® controller system

NOTICE!
• The integration of the WirelessHART Fieldgate is described using the example of a 

Rockwell ControlLogix® controller. If other controllers and software are used, please 
see the corresponding documentation for the controller/software.

Configuring the IP address of SWG70

1. In the "Controller Organizer" window, double-click "WirelessHART Fieldgate".
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2. The Add-On Profile of the WirelessHART Fieldgate opens.

3. Enter the IP address of the WirelessHART Fieldgate in the "Ethernet Address" section of 
the "General" tab.

Configuring the maximum number of HART devices

1. Select the "General" tab in the Add-On Profiles section of the WirelessHART Fieldgate.

2. Click the "Change" button under "Module Definition".
The "Module Definition" window opens. Use this dialog to configure specific parameters 
for the cyclic EtherNet/IP connection and the number of HART devices.
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Checking connected HART devices

1. Select the "HART Device Map" tab in the Add-On Profiles of WirelessHART Fieldgate.

2. The "HART Device Map" is displayed.

NOTICE!
• It can take up to 10 minutes to update the HART Device Map. If a device is connected to 

the network or is removed from the network, it can take up to 10 minutes for this device 
to appear in the overview or be deleted.
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HART Device Map
Displayed information Description
HART Device Displays the HART device identifier. 

This identifier is identical to the last 3 characters of the 
device's HART descriptor. See Chapter 10.5.2.

Descriptor Displays the HART descriptor of the device.
The HART descriptor must comply with the dedicated 
naming conventions. See Chapter 10.5.2.

Long Tag Name Displays the long tag name of the device.
HART Comm Fail This bit is flagged if a device is not available, e.g. 

because it is not possible to establish the connection to 
the device. Make sure that the maximum number of 
HART devices in the "Module Definition" window is 
greater than the actual number of HART devices.

Descriptor Not Unique This bit is flagged if the HART descriptor of the HART 
device is not unique. 
Change the HART descriptor using the associated HART 
device DTM.

Data Burst Not Configured This bit is flagged if HART command 9 (alternatively 
command 3 and 33) has not been flagged as burst in 
the HART device. 
Flag HART command 9 (alternatively command 3 or 
33) using the associated device DTM. See 
Chapter 10.5.3.

Cmd48 Burst Not Configured This bit is flagged if HART command 48 has not been 
flagged by the HART device.
Flag HART command 48 using the associated device 
DTM. See Chapter 10.5.3.
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Displaying available variables

1. In the "Controller Organizer" window, double-click "Controller Tags".

2. The "Monitor Tags" section shows a detailed overview of the variables available. See 
Chapter 10.5.6 "Connection parameters for cyclic data exchange" on page 95.
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10.5.6 Connection parameters for cyclic data exchange

Data block of WirelessHART Fieldgate, used in cyclic data transfer 

The format of the data block of the WirelessHART Fieldgate which is transmitted in the first 
position of the first connection is as follows.

Data block of the WirelessHART Fieldgate

The statistics values marked with 1) are only invalid if the WirelessHART Fieldgate has been 
started and the statistics values have not yet been calculated. The statistics values remain 
valid for as long as the WirelessHART Fieldgate is in operation.

Structure Data type Size Invalid values Description
Gateway_struct 84

.NetworkReliability_percent REAL 4 Quiet NaN 1) Percentage of the packets generated by wireless 
devices that were correctly received by the 
WirelessHART Fieldgate.

.NetworkStability_ratio REAL 4 Quiet NaN 1) Ratio of successfully transmitted packets to all the 
packets transmitted on all the wireless connections

.NetworkLatency_ms DINT 4 –1 1) Average time required for the packets generated by a 
wireless device to the WirelessHART Fieldgate

.LostUpstreamPackets DINT 4 –1 1) Total number of packets that have been lost during 
transmission by a wireless device

Sub-structure DeviceStatus_Struct 4 (always valid)
.GeneralStatus BYTE 1
.InternalError BOOL Displays an internal error.

The values ".NetworkReliability_percent", 
".NetworkStability_ratio", ".NetworkLatency_ms" and 
".LostUpstreamPackets" are set to an invalid value and 
the "HART Comm Fail" bit of all the devices is flagged.

.DescriptorNotUnique BOOL The same HART descriptor has been assigned for at 
least two HART devices. 
This is an aggregate bit for all the HART devices. See 
Chapter 10.5.7 "Diagnostic bits in cyclic data 
exchange" on page 98.

.NoDataBurstConfigured BOOL Indicates that at least one HART device in cyclic data 
exchange has not flagged command 3, 9 or 33. See 
Chapter 10.5.7 "Diagnostic bits in cyclic data 
exchange" on page 98.

.NoCmd48BurstConfigured BOOL Indicates that at least one HART device in cyclic data 
exchange has not flagged command 48. See 
Chapter 10.5.7 "Diagnostic bits in cyclic data 
exchange" on page 98.

.PassThroughQueueOccupied BOOL Not used

.PassThroughResponseReady BOOL Not used

.UnusedStatus1 BYTE 1

.FieldDeviceStatus BYTE 1 Original status byte returned by WirelessHART 
Fieldgate. For more details see Page 96, "HART Device 
Status" Table.

.ExtendedDeviceStatus BYTE 1 Original status byte returned by WirelessHART 
Fieldgate. For more details see Page 96, "HART 
Extended Device Status" Table.

Sub-structure Tag_Struct 32 (always valid)
.Name BYTE[32] 32 HART Long Tag (ISO/IEC 8859-1)

Sub-structure CMD48_Struct 28 (always valid)
.Cmd48Data BYTE[25] CMD 48 data
.Cmd48Reserved BYTE[3] Fill bytes
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HART Device Status

HART Extended Device 
Status

Bit Parameter Description
0x80 Device malfunction Device in the network has malfunctioned
0x40 Configuration changed Configuration of a device in the network has changed
0x20 Cold start Device in the network has cold start flagged
0x10 More status available Device in the network has more status available flagged
0x08 Loop current fixed Loop current of a device in the network is fixed to 4 mA 

(multidrop mode)
0x04 Loop current saturated Loop current of a device in the network above 20 mA
0x02 Non-primary variable out of 

limits
SV, TV, QV of a device in the network is out of limits

0x01 Primary variable out of limits PV of a device in the network is out of limits

Bit Parameter Description
0x01 Maintenance required The device requires maintenance.
0x02 Device variable alert One of the device variables reports the "Alarm" or "Warning" status.
0x04 Critical power failure Only for battery-powered devices.

The power supply is no longer adequate. The device can no longer 
maintain the network connection for 15 minutes.

0x08 Failure At least one variable (e.g. measured values or control values) is 
invalid due to a malfunction of the field device or a peripheral.

0x10 Out of specification The current conditions deviate from the permitted ambient and 
process conditions to such an extent that affects the accuracy of 
the measurement and/or control.

0x20 Function check At least one device variable is temporarily invalid due to checks 
being performed on the device.
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Data block of HART devices, used in cyclic data transfer

This data structure is used for all WirelessHART field devices and HART devices within a 
WirelessHART network. The WirelessHART devices must support HART Revision 7 or 
higher. The HART field devices must support HART Revision 5 or 6. Not all values can be 
used for HART-5 and HART-6 devices, and some values are replaced by other values. The 
different behavior is described in the following table.

Data block of the HART devices

Structure Data type Size Invalid values Description
Device_struct 96

.PV REAL 4 Quiet NaN Primary Value (HART CMD 3/9/33)

.SV REAL 4 Quiet NaN Secondary Value (HART CMD 3/9/33)

.TV REAL 4 Quiet NaN Third Value (HART CMD 3/9/33)

.QV REAL 4 Quiet NaN Fourth Value

.PVStatus BYTE 1 0 Status byte (HART CMD 9) 1)

.SVStatus BYTE 1 0 Status byte (HART CMD 9) 1)

.TVStatus BYTE 1 0 Status byte (HART CMD 9) 1)

.QVStatus BYTE 1 0 Status byte (HART CMD 9) 1)

.PVUnit BYTE 1 0 Units Code (HART CMD 3/9/33)

.SVUnit BYTE 1 0 Units Code (HART CMD 3/9/33)

.TVUnit BYTE 1 0 Units Code (HART CMD 3/9/33)

.QVUnit BYTE 1 0 Units Code (HART 3/9/33)

.PVLowerRangeValue REAL 4 Quiet NaN Lower measuring range of the primary value 
(HART CMD 15)

.PVUpperRangeValue REAL 4 Quiet NaN Upper measuring range of the primary value 
(HART CMD 15)

Sub-structure DeviceStatus_Struct 4
.GeneralStatus BYTE 1 (always valid) 2)

.HARTCommFail BOOL HART communication error: device not found/HART 
is not activated. 3) 

See Chapter 10.5.7 "Diagnostic bits in cyclic data 
exchange" on page 98.

.DescriptorNotUnique BOOL Indicates that the same HART descriptor has been 
assigned to at least one other HART device. See 
Chapter 10.5.7 "Diagnostic bits in cyclic data 
exchange" on page 98.

.NoDataBurstConfigured BOOL Indicates that neither command 3, 9 nor 33 have been 
configured to be sent by the HART device. See 
Chapter 10.5.7 "Diagnostic bits in cyclic data 
exchange" on page 98.

.NoCmd48BurstConfigured BOOL Indicates that command 48 has not been configured 
to be sent by the HART device.
See Chapter 10.5.7 "Diagnostic bits in cyclic data 
exchange" on page 98.

.PassThroughQueueOccupied BOOL Not used

.PassThroughResponseReady BOOL Not used

.UnusedStatus1 BYTE 1 Fix: 0x00

.FieldDeviceStatus BYTE 1 (always valid) 2) Original status byte is returned by the device. For 
more details see Page 96, "HART Device Status" Table.

.ExtendedFieldDeviceStatus BYTE 1 0x00 Original status byte is returned by the device. 4)

See device documentation.
Sub-structure Tag_Struct 32 (always valid) 2)

.Name BYTE[32] 32 HART Long Tag (ISO/IEC 8859-1) 5)

Sub-structure Cmd48_Struct 28
.Cmd48Data BYTE[25] filled with 0x00 7) CMD48 data

.Cmd48Reserved BYTE[3] Fill bytes
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10.5.7 Diagnostic bits in cyclic data exchange
The cyclic data contain 4 error bits for every HART device. Each of these error bits can 
suddenly appear during cyclic communication either when communication is lost or the 
configuration of one or more devices has changed.

.HARTCommFail

This bit indicates that the device with the HART descriptor calculated from the cyclic 
connection number and the data offset cannot be reached, does not respond or is still 
initializing. The bit is reset as soon as the device is initialized. This bit is reset as soon as 
the connection is lost.

.DescriptorNotUnique

The HART descriptors of all the devices in the WirelessHART network are read during the 
basic device identification procedure. If EtherNet/IP discovers that more than two devices 
share the same HART descriptor, the ".DescriptorNotUnique" bit is flagged in the cyclic data 
exchange for the devices concerned. In addition, the ".DescriptorNotUnique" bit is also 
flagged in the cyclic data exchange for WirelessHART itself to indicate that at least one 
HART descriptor collision has been detected.

As devices with identical HART descriptors would share the same data offset in the same 
cyclic connection, the cyclic data would be populated by random data from these devices. To 
avoid this, the cyclic data are populated with the data of the device for which the identical 
HART descriptor was first discovered. This prevents the loss of cyclic data if a new HART 
device with an identical HART descriptor is added to the network.

Footnote 
number

Description

1) Status values only apply if the associated values PV, SV, TV or FV are valid. The default value "0" 
indicates that either no value has been received up to now (PV, SV, TV, or FV are invalid) or that 
the associated values are really bad (PV, SV, TV, FV do not have "Quiet NaN" as a value).
Use the following status for HART 5 devices that do not support burst command CMD 9:
• 00-hex: Not connected as long as no values are received from the device (PV, SV, TV, FV 

contains Quiet NaN)
• C0-hex: Connected, if the values for PV, SV, TV, FV contain valid data from the device

2) Always valid as long as the ".HARTCommFail" bit is not flagged. All the values are invalid 
whenever the ".HARTCommFail" bit is flagged.

3) If this bit is "1", none of the other data in "Device_struct (including substructures)" are valid.
4) Only valid for HART devices with Revision 6 and higher that support burst command 9 or 48.
5) HART devices with Revision 5 return the content of command 12 (Read Message) in the "Long 

Tag" field because the long tag is not defined in HART Revision 5. Message data also contain 
32 bytes.

6) If "Cmd48Data" is populated by 0x00, this does still not indicate that "Cmd48Data" is invalid. 
"Cmd48Data" is only invalid if ".NoCmd48BurstConfigured" is also flagged.
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.NoDataBurstConfigured

This bit indicates that the device concerned has not been configured with burst command 3, 
9 or 33. The missing burst configuration is either discovered during the detailed 
initialization procedure or following a change to the configuration. Command 3, 9 or 33 
must be flagged in order to publish cyclic data via EtherNet/IP.

Burst configuration of the wired devices must be performed via the bridge device. Burst 
commands that are sent directly to the wired device are not recognized and cause the 
".NoDataBurstConfigured" bit to be flagged. 

.NoCmd48BurstConfigured

This bit indicates that the device concerned has not been configured with burst command 
48. The missing burst configuration is either discovered during the detailed initialization 
procedure or following a change to the configuration. Command 48 must be flagged in order 
to publish cyclic data via EtherNet/IP.

Burst configuration of the wired devices must be performed via the bridge device. Burst 
commands that are sent directly to the wired device are not recognized and cause the 
".NoCmd48BurstConfigured" bit to be flagged. 

Note that the ".NoCmd48BurstConfigured" bit remains active for devices that do not support 
Command 48, such as HART devices Revision 5.

10.6 Downstream Communication (for discreet field 
devices)

You can use the Downstream Communication view to configure Downstream 
Communication. With Downstream Communication, data are transmitted to discreet field 
devices for control applications.

1. Click Engineering > Downstream Communication.

The following modes are available:

• On-change update mode
• Periodic update mode
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On-change update mode

By default, all Modbus output variables are updated with a change procedure. The Fieldgate 
detects any change in the output status caused by the Modbus Master. The Fieldgate adds 
the changes to a queue and transfers these changes to the discreet field devices as quickly as 
possible.

Periodic update mode

The periodic update mode is activated by an update interval that is different to "00:00:00". 

1. Click Engineering > Downstream Communication.

2. Enter the update interval in the Upload Period column for the relevant discreet field 
device.

3. Click Apply. All specified variables are transferred periodically to the discreet field 
device.

10.7 Substitution value (substitution value to DCS)
The WirelessHART Fieldgate detects when the last measured value is obsolete. This means 
that the Global Age Threshold Warning limit or the Global Age Threshold Error limit is 
exceeded.

In this case, you can specify one of the following substitution values:

• Last value
• NaN1 (0x7FE00000) 
• NaN2 (0x7FA00000) 
• Upscale (ffffff) 
• Downscale (000000)
• User Defined

NOTICE!
• You can perform a Factory Acceptance Test with the substitution value. See 

Chapter 10.7.2.

Setting a substitution value

1. Click Engineering > Substitution Value
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2. Select an option in the Global Selection field, or specify a value for the User Defined 
option.

3. Click Apply. The value is set globally for all field devices.

Setting different substitution values for individual field devices

1. Click the relevant Loop Current, PV, SV, TV or QV column for the device in question.

2. Enter the desired value.

3. Click Apply. The value is set for this field device.

10.7.1 Burst message monitoring
The web interface provides the option of configuring notification limits in the event that the 
value of a buffered dynamic variable or the "Additional Device Status" command 48 of a 
wireless device is obsolete.

By specifying Global Age Threshold Warning / Age Threshold Warning limits and Global 
Age Threshold Error /Age Threshold Error limits, early detection of communication losses 
is possible. If a limit value is exceeded, a warning message or error message is generated.  

For burst message monitoring, the field devices must have appropriate burst rates.

The Fieldgate reads the expected burst rates from each field device and assigns a timestamp 
to each burst message received. In this way, each buffered value is calculated as a percentage 
value of the burst rate. 

The Fieldgate uses the value calculated to determine if a message is sent within the burst 
rate of the field device or if it is overdue. When a message is received, the "counter" is reset 
and incremented again until the next message is received.

Setting warning limits and error limits

1. Click Engineering > Substitution Value.
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2. In the Global Age Threshold Warning field, enter the warning limit value for all field 
devices as a percentage of the existing burst rate, e.g. "150" for "150 %".

3. In the Global Age Threshold Error field, enter an error limit value for all field devices 
as a percentage of the existing burst rate, e.g. "300" for "300 %".

4. Click Apply to determine the limit values for all field devices.

5. If necessary, set individual limit values for individual field devices. To do so, click the 
relevant Age Threshold Warning or Age Threshold Error cell. Enter the value directly 
in the cell.

Displaying Age Threshold Warning and Age Threshold Error status 

1. Click Engineering > Measurement List

In the Measurement List you can check how old the burst messages are. In the Age 
Threshold column, the value is indicated as a percentage and the cell is highlighted using 
specific colors.

Status Color of cell Meaning Remarks
Good value Green The current value is below 

the set value for Global 
Age Threshold Warning or 
Age Threshold Warning

–

Age Threshold Warning Yellow The current value has 
exceeded the set value for 
Global Age Threshold 
Warning or Age Threshold 
Warning. 

This warning limit is 
normally used to identify 
temporary communication 
problems.

Age Threshold Error Red The current value has 
exceeded the set value for 
Global Age Threshold Error 
or Age Threshold Error.

This error limit is normally 
used to indicate what is 
likely to be the complete 
loss of the device, e.g. 
when a battery is removed.
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10.7.2 Factory Acceptance Test (FAT)
The Factory Acceptance Test is a simulation to verify if the Distributed Control System (DCS) 
is receiving the correct values from the Fieldgate. During the simulation, the substitution 
values that were defined for the field devices are transmitted to the DCS. The simulation is 
successful if the DCS receives the substitution values as expected.

Running the Factory Acceptance Test

NOTICE!
• Run the Factory Acceptance Test without first starting the network.

1. Generate a Modbus mapping. See Chapter 16.

2. Define a substitution value. See Chapter 10.7. 

3. The Factory Acceptance Test is successful if the DCS receives the substitution values as 
expected.

10.8 Security – Whitelist, Temporary Join Key
The Fieldgate supports the "Whitelist" security function. 

New field devices can be added to the network only if their addresses are listed in this 
Whitelist and can be identified.

In addition, you can define a temporary join key, which automatically becomes invalid after 
a specified time period. This key can be used, for example, for field devices that are required 
on a temporary basis only due to maintenance reasons. If the specified time has elapsed, the 
temporary join key is overwritten by the permanent join key.

1. Click Engineering > Security.
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Parameters in "Security" 
window

Defining or changing the Whitelist

1. Click Engineering > Security.

2. In the Network Access Mode dropdown menu, select the Open option to open the 
network.

3. Click the >> button for the Transfer Network to Whitelist parameter.

4. A dialog appears. Note than once you confirm the displayed message, the current 
Whitelist will be changed. The previous version cannot be restored.

5. Click Yes to confirm. The Whitelist is generated. The specified field devices are 
highlighted in the Whitelisted column in the Security view.

Parameter Meaning
Network Access Mode Mode for the network access.

• Open: Opens the network.
• Whitelist: Opens the network for all field devices listed in the Whitelist.
• Temporary Join Mode Time: Opens the network for the time period specified via 

the "Temporary Join Mode Time" parameter.
• Closed: Closes the network.

Transfer Network to 
Whitelist

Copies the network's field devices to the Whitelist.

Temporary Join Key 
Part 1 of 4

Temporary network password, 8 hexadecimal numbers, part 1 of 4, temporarily 
overwrites the permanent network password

Temporary Join Key 
Part 2 of 4

Temporary network password, 8 hexadecimal numbers, part 2 of 4, temporarily 
overwrites the permanent network password

Temporary Join Key 
Part 3 of 4

Temporary network password, 8 hexadecimal numbers, part 3 of 4, temporarily 
overwrites the permanent network password

Temporary Join Key 
Part 4 of 4

Temporary network password, 8 hexadecimal numbers, part 4 of 4, temporarily 
overwrites the permanent network password

Temporary Join Mode Time Time period for which the temporary join key is valid. You start the "Temporary 
Join Key" function via the "Start Temporary Join Mode" parameter.
The function stops automatically when the specified time has elapsed. 
Alternatively, you can stop the function earlier via the "Stop Temporary Join Mode" 
parameter.

Start Temporary Join Mode Starts the "Temporary Join Key" function.
Stop Temporary Join Mode Stops the "Temporary Join Key" function before the specified "Temporary Join Mode 

Time" has elapsed.
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6. In the Network Access Mode dropdown menu, change the Open option to Whitelist.

7. Confirm the displayed message with Yes.

All field devices highlighted as "Whitelisted" can be added to the network. Any attempt to 
add an unauthorized field device will be declined – even if the field device has a valid network 
ID and a join key.

Assigning a temporary join key

If you do not wish to reveal the permanent join key of your network, you can use the 
"Temporary Join Key" function. This temporary join key can be used, for example, to allow 
subcontractors to add field devices.

1. In the Network Access Mode dropdown menu, select the Open option to open the 
network.

2. Enter the temporary join key in the Temporary Join Key Part 1 to 4 (HEX) fields.

3. In the Network Access Mode dropdown menu, select the Temporary Join Mode Time 
option.

4. Select a time in the Temporary Join Mode Time field. Other field devices may be added 
to the network during this time.

5. For the Start Temporary Join Mode parameter, click the >> button to start the 
temporary connection mode. 

6. For the Transfer Network to Whitelist parameter, click the >> button to copy all of the 
network's field devices to the Whitelist.

7. A dialog appears. Note than once you confirm the displayed message, the current 
Whitelist will be changed. The previous version cannot be restored.

8. Click Yes to confirm. The Whitelist is generated. The specified field devices are 
highlighted in the Whitelisted column in the Security view.

9. In the Network Access Mode dropdown menu, select the Closed option to close the 
network.
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11 Additional Functions
Additional Functions contains a number of functions which maybe required during the 
Fieldgate life-cycle but not for everyday operation. The functions offered depend upon the 
parametrization tool. In FieldCare the corresponding function is called by right-clicking on 
the Fieldgate SWG70 node and selecting Additional Functions.

11.1 Reset
Reset allows the Fieldgate, the instrument list and the network to be reset, see table. The 
reset is initiated by pressing the appropriate button. During reset, communication with the 
network will be temporarily lost.

1. Click Additional Functions> Reset to open the dialog:

Reset options
Parameter group Meaning
Device Reset Click this button to restart Fieldgate without any impact on the established 

network.
– Fieldgate SWG70 is restarted with all user settings intact.

Rebuild Instrument List Click this button to regenerate the instrument list. 
– Create a backup of the existing instrument list before resetting. See 

Chapter 10.1.
– The existing instrument list is overwritten. 
– The Modbus addresses of the devices in the network may change.

Reform Network Click this button to restart and reestablish the network.
– The existing instrument list is overwritten. 
– The Modbus addresses of the devices in the network may change.
– Depending on the size of the network, this process may take some minutes.

Reset Diagnosis Bits Click this button to reset the diagnosis bits in Fieldgate SWG70.
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11.2 Self Test
Self test invokes a self testing procedure for Fieldgate SWG70. 

1. Click Additional Functions> Self Test to open the dialog:

2. For this, click the Perform Self-Test button in the dialog. 

– Call this function in FieldCare by right-clicking Fieldgate SWG70 and then selecting 
the Self Test option in the context menu. 

3. The results can be seen in the first two sections of the HART diagnosis dialog: 
Diagnostics =>Wired Communication =>HART dialog. See Chapter 9.3.2 "HART" on 
page 60.

11.3 Firmware Upgrade (Web Server)
Firmware Upgrade allows new firmware to be downloaded to the Fieldgate.

1. Click Additional Functions => Firmware Upgrade to open the dialog:

2. Browse to the folder or location where the firmware package is to be found (*.ipk, 
*.tar.gz)

3. Click to Upload the Package >>

– The following page appears: 

4. Click the Install the Package >> button to install the firmware.

– To cancel the firmware upgrade, press Discard Upgrade.

5. The package will now be installed.

– The installation process may take a while. 
– When the installation is finished, Installation Successfully Completed together 

with a log is displayed on the screen.

6. After installation, Fieldgate SWG70 restarts with the new firmware.

– The network configuration of the old firmware is retained.
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11.4 Change Password (Web Server)
To change the password for the web server, you must be logged in as "Administrator".

1. Click Additional Functions > User Level.

2. For the Change User Level parameter, click the >> button if you are not logged in as 
administrator. The Login dialog opens.

3. Enter the old password in the Enter the old password field.

4. Enter the new password in the Enter a new password and Confirm new password 
fields.

5. For the Change password parameter, click the >> button to download the new 
password.

11.5 Set DTM Addresses (DTM)
Set DTM Addresses allows the user to match the addressing in the DTM, i.e. the Long Tag 
in WirelessHART networks, to the physical devices. Any change must also be duplicated in 
the Set Device Addresses window (see Chapter 8.6.7), otherwise the DTM is not able to 
establish a connection to the adapter. See Chapter 11.6 "Set Device Addresses (DTM)" on 
page 109. Changes should be made only after all adapter DTMs have been closed. The func-
tion is not relevant to FieldCare but might be required for other FDT frames.

1. Click Additional Functions => Set DTM Addresses to open the dialog:

To change the 
DTM address:

2. Place the cursor inside a cell of the Long Tag column.

3. Change the device long tag as required. You may change the long tags of several devices 
at once, if needed.

4. Close any DTM dialogs of the devices whose long tags are to be changed.

5. To apply the new DTM address(es) press Update Changed Tags.

6. The new DTM addresses are displayed in the project view of FieldCare.
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11.6 Set Device Addresses (DTM)
Set Device Addresses displays all adapters, together with their wired connections, that can 
be seen in the network. The device address is the device long tag stored in the device. Call 
this function in FieldCare by right-clicking Fieldgate SWG70 and then selecting the More 
Functions => Set Device Addresses options in the context menu. 

Set DTM Addresses allows the user to match the address of a physical device, e.g. the Long 
Tag in WirelessHART networks, to the address saved in the DTM. The function is not rele-
vant to FieldCare but might be required for other FDT frames.

1. Click Additional Functions> Set Device Addresses to open the dialog:

To change the 
device address:

2. Place the cursor inside a cell of the Device Long Tag column.

3. Change the device long tag as required. You may change the long tags of several devices 
at once, if needed.

4. To apply the new DTM address(es) press Update Changed Tags. 

– The new DTM addresses are stored to the devices.
– Refresh updates the list.
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11.7 Upload Certificate (Web server)

11.7.1 Self-signed security certificate
A digital certificate is an electronic document that binds a public key with an identity, for 
example, an organization or a user. The binding between a public key and the identity is 
done by a signature. This signature can be self-signed or authenticated by a certification 
authority.

Fieldgate SWG70 is delivered with a self-signed certificate for the HTTPS connection. If the 
web browser is unable to verify the authenticity of a self-signed certificate, a warning mes-
sage appear: 

You can proceed to the web server by clicking the appropriate option below the message.

11.7.2 Trusted security certificate
If you wish to avoid the security message, a trusted certificate must be obtained from a cer-
tification authority. This is usually connected with a fee and applies to one Fieldgate only. 

On registering the web server you will receive files containing a certificate and a private key. 
As your computer is probably not connected to the Internet, these should be available on its 
hard disk or a USB stick before the certificate is uploaded to Fieldgate SWG70. Now proceed 
as follows:

1. Click on the Additional Functions => Upload Certificate leaf to open the dialog.

2. Click Browse and select the certificate file on the hard disk or USB stick. 

3. Click >> to upload the certificate.

4. The Upload Private Key option appears: Click Browse ... and select the private key on 
the hard disc or USB stick.

5. Click >> to upload the private key.

6. The Change Certificate and Private Key option appears: Click >> to install the trusted 
certificate.

7. Go to Additional Functions => Device Reset and perform a device reset for the 
changes to take effect. 

If the trusted certificate has been installed successfully, the address bar in the web browser 
displays a padlock icon,.

NOTICE!

• In some cases, you must also install the certificate locally on your operating system. 
– If so, click the warning message in the address bar of the web browser and select more 

information on the certificate.
– In the following window, click Install Certificate and follow the instructions of the 

installation wizard. 
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11.8 Auto Refresh
All parameter values for the web server and the Fieldgate DTM are updated automatically in 
the factory.

1. Click Additional Functions > Auto Refresh.

Parameter Parameter Meaning
Auto Refresh Activate or deactivate the "Auto Refresh" function.
Auto Refresh Cycle Time Enter interval for automatic refresh.
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12 Measurement
The Measurement table provides a comprehensive overview of all cached parameters and 
values of all sub-devices.

• As the list is stored in a non-volatile memory, the card and channel number assignment 
will remain the same after a restart of the Fieldgate or software.

• The dynamic values of each sub-device (analogue value, PV, SV, TV, QV) are cached by the 
Fieldgate only if the sub-device publishes these values.

• After a network restart, the instrument list needs time to rebuild. During this time, some 
information is set to 0 or replaced by wildcard characters.

• To remove a device from the list, use the Instrument List. See Chapter 10.1 "Instrument 
List" on page 62.

Whenever a new wireless device joins the network, it is automatically inserted into the list. 
Wired HART devices connected to a WirelessHART Adapter (SWA70) are also listed.

1. Click on the Measurement, leaf to open the dialog: 

– In FieldCare right-click on the Fieldgate SWG70 node and select Observe.

Parameter Meaning
Long Tag Identifies Fieldgate within the plant network

– For HART 5.0 or lower, the texts in the "Message" parameter
IO card Indicates the virtual I/O card number to which the device is mapped
Channel Indicates the channel of the virtual I/O card to which the device is mapped
Device Type Displays the device type as registered at the HART Communication Foundation
Status Displays the communication status

–  Connected
–  Flashing: Devices connected, identification in progress

 Continuous: Devices connected but not identified
–  Communication failure

Dev. Status Displays the device status
–  Good
–  Out of specification
–  Failure

The device status displayed in the Operating Modes list may differ from the actual device 
status because the HART status bits may be interpreted differently.

Loop current Current in mA (for HART Multidrop = 4 mA)
PV Primary value of the device
SV Secondary variable of the device
TV Tertiary variable of the device
QV Quaternary variable of the device
"+", "–" Expands or contracts the tree view
Refresh Click this button to reload the operational mode parameters of all network devices
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13 Maintenance and repair

13.1 Maintenance
No special maintenance work is required for the Fieldgate SWG70.

13.2 Return to Endress+Hauser.
Fieldgate SWG70 must be returned if repairs are required or if the wrong device has been 
ordered or delivered. According to legal regulations, Endress+Hauser, as an ISO-certified 
company, is required to follow certain procedures when handling returned products, espe-
cially those that have been in contact with medium.

To ensure swift, safe and professional device returns, please read the return procedures and 
conditions on the Endress+Hauser website at www.services.endress.com/return-material.

13.3 Disposal
Fieldgate SWG70 must be disposed of in accordance with national regulations.

13.4 Contact addresses
Contact addresses can be found on our homepage at www.addresses.endress.com/world-
wide. For inquiries, service etc. please contact your local Endress+Hauser Sales Center or 
Representative.

13.5 Accessories and spare parts
See the Technical Information document for "WirelessHART Fieldgate SWG70" (TI00027S) 
for accessories and spare parts.
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14 Troubleshooting

14.1 Faults indicated by Fieldgate LEDs

14.2 Wired Communication Faults
Fieldgate error messages are displayed in plain text in the Diagnosis leaf of the DTM, See 
Chapter 9 "Diagnostics" on page 53.

The following table summarizes the more common problems which might occur during com-
missioning and operation of the WirelessHART Fieldgate SWG70.

LED indication Problem/Remedy
1 Red LED is lit • Hardware fault which makes normal operation of the 

Fieldgate impossible.
– Send Fieldgate back for repair.

2 Red LED flashes • Under certain conditions the LED flashes while the 
Fieldgate application tries to eliminate the fault.
– If this indication persists, even after a reboot, send the 

Fieldgate back for repair.

Problem Cause/Remedy
1 The computer is not able to establish an 

Ethernet connection to the Fieldgate although 
the Fieldgate and the computer are connected 
to the Ethernet.

• The Fieldgate is connected to the Ethernet with a standard 
cable although a crossover connection is necessary (or vice 
versa).
– Wire in accordance with the table in Chapter 5.3.

• The Ethernet parameters of the Fieldgate are incorrect.
– Check the Fieldgate's Ethernet parameters 

(see Chapter 8.4.3)
• The Local Area Connection Properties of your PC are not 

configured correctly.
– Configure the Local Area Connection according to the 

instructions given (see Chapter 7.1).
• If you are parameterizing via the web interface: Maybe 

your web browser uses proxies.
– Deactivate proxies in your browser.

• Firewall blocking communication.
– Configure firewall to allow communication through 

ports 80, 443, 502 and 5094.
2 The computer is not able to establish a serial 

connection to the Fieldgate or the signal is of 
poor quality.

• The terminating resistor is not activated.
– If the RS-485 cable ends at the Fieldgate (Fieldgate is 

last device), activate the terminating resistor via the DIP 
switch inside the Fieldgate housing (see Chapter 8.4.4) 
or via the DTM (see Chapter 6.1.3.).

• Check cabling.
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14.3 Wireless Communication Faults

Problem Cause/Remedy
1 Fieldgate SWG70 cannot find a WirelessHART 

device in the network.
• The device has not yet joined the network.

– The joining process may take a while. 
– Check the join status in the Fieldgate's Instrument 

List.
– Alternatively, check the wireless communication 

parameters (join status) of the device via a HART 
modem connected to the device.

• The device carries the wrong network ID and/or the 
wrong join key.
– Check the wireless communication parameters of 

the device via a HART modem connected to the 
device. The device and the Fieldgate must have the 
same network ID and join key.

2 The wireless connection to a WirelessHART device 
is poor and disappears from time to time.

• There are not enough neighboring WirelessHART 
devices within the device's antenna range.
– Check the number of neighbors 

Diagnosis > Wireless Communication
– There should beat least 2 neighbors.

• Signal too weak
– Check the signal level of next neighbor in the 

device diagnosis - this must be larger than -80 dBm 
if the network is to work properly.

– Improve signal strength by repositioning the 
antenna or adding adapters as repeaters.

• Walls or other static/moving objects block the radio 
signals, or the antenna is not aligned vertically.
– Reposition the Fieldgate or use an external 

antenna.
3 The Network ID and the Join Key cannot be 

downloaded to Fieldgate SWG70.
• The security DIP switch 8 is OFF.

– Set DIP switch 8 to ON. If the Fieldgate is installed 
in hazardous areas Zone 2, switch off the voltage 
supply before doing this.

– If you want to continue using security mode, set the 
DIP switch 8 to OFF, after the Network ID and Join 
Key have been downloaded.

4 A device appears with a yellow icon in the 
instrument list.

• Either the device or the communication is faulty.

5 A device appears with a red icon in the instrument 
list.

• The device is faulty.
• The network was switched off for sometime, but the 

device has continued transmitting.
– The device has gone into prolonged sleep mode.
– Either wait until the device reappears (waiting time 

depends on how long the network was not present) 
or press the adapter’s push button for 5 seconds to 
force joining. 

6 A device is present in the network, but bursting is 
interrupted.

• The field device is being configured locally by a 
modem.
When a modem is communicating with the adapter, it 
is impossible to measure the loop current and 
bursting is disabled.
Bursting will restart when the modem is 
disconnected.
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14.4 Error messages of the WirelessHART OPC server in 
the "Event Viewer" window

If the WirelessHART OPC server is used, the following messages may appear in Windows 
Event Viewer.

Error message Cause/Remedy
1 The WirelessHART OPC Server cannot connect to 

the configured Fieldgate because of wrong 
Ethernet IP address or port settings.  Please make 
sure that the network is functional and the 
Ethernet IP address and port settings are correct.

The Ethernet configuration data are not valid. Check the 
network configuration parameters.

2 The WirelessHART OPC Server cannot connect to 
the configured Fieldgate because of the wrong 
HART bus address. Please check the configured 
HART bus address.

The HART bus address of the field device is not the same 
as that configured in the OPC server. 
Either change the address of the Fieldgate or the 
address in the "WirelessHART Fieldgate OPC 
Configurator.

3 The WirelessHART OPC Server cannot connect to 
the Fieldgate with the configured long tag "%s". 
Please check either the configuration of the long 
tag or the network settings of the attached 
Fieldgate.

The "Long Tag" of the Fieldgate is not the same as that 
configured in the WirelessHART OPC server. 
Either change the "Long Tag" of the Fieldgate or the 
"Device Name" in the "WirelessHART Fieldgate OPC 
Configurator".

4 The WirelessHART OPC Server cannot connect to 
the configured Fieldgate because of a general 
communication problem. Please make sure that 
the network is functional.

The WirelessHART OPC server cannot establish 
communication with the Fieldgate. General problems 
such as timeouts, lost or incomplete data telegrams, 
electrical interference etc. can cause this problem. Check 
the stability of the network function. If necessary, 
consult your IT department.

5 The WirelessHART OPC Server configuration was 
not found. The default configuration is used. Please 
use the ‘WirelessHART OPC Server Configurator’ to 
apply changes to the configuration.

Unable to find the configuration file of the 
WirelessHART OPC server. The default configuration 
file is used. Restart the program "WirelessHART 
Fieldgate OPC Configurator", in order to update the 
configuration.

6 The WirelessHART OPC Server configuration is 
corrupted. The default configuration is used. Please 
use the ‘WirelessHART OPC Server Configurator’ to 
apply changes to the configuration.

The configuration file of the WirelessHART OPC server 
is not valid. The default configuration file is used. 
Restart the program "WirelessHART Fieldgate OPC 
Configurator", in order to update the configuration.
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15 Technical data

www.endress.com For the technical data, see the Technical Information document for "WirelessHART Fieldgate 
SWG70" (TI00027S).

W@M Device Viewer Alternatively, you can also download all the associated technical documentation via the 
W@M Device Viewer. Enter the serial number of the WirelessHART Fieldgate on our 
website, "www.endress.com/deviceviewer". You can find the serial number on the nameplate.
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16 Modbus Interface

NOTICE!
• The "Modbus" function is only available on WirelessHART Fieldgate models with the 

version "SWG70-xx-1-xx-xx". See Chapter 2.3 "Ordering information" on page 10.

16.1 Introduction

16.1.1 Modbus protocol
Modbus is a quasi-industrial standard developed some years ago by Gould-Modicon. and 
provides a messaging service that may run on a variety of physical layers. For Fieldgate 
SWG70 there are two possibilities for connecting Modbus:

• Modbus RTU (also known as Serial) can be connected point-to-point to the RS-485 
interface. See Chapter 5.4 "Connecting to RS-485" on page 24.

• Modbus TCP (also known as Modbus TCP/IP) can be connected to an Ethernet Interface. 
See Chapter 5.3 "Connecting to Ethernet" on page 22.

The Modbus protocol exchanges data in a master-slave relationship. Each slave has a unique 
address, and the data are identified by their location in the slave address register. Certain 
characteristics of the Modbus protocol are fixed, such as the frame format, frame sequences, 
handling of communications errors, exception conditions and the functions performed. 
Other characteristics are user selectable; these include transmission medium, baudrate, 
character parity, number of stop bits, and transmission modes. Chapter 8.3 describes how 
both Ethernet and Serial interfaces can be set up. The contents of the data carried by the pro-
tocol are also freely selectable, i.e. nothing is said about strings, integers, floating-point 
numbers etc.

The Modbus protocol controls the query and response cycle between master and slave 
devices. Only the master can initiate a transaction. A query and response may involve only a 
single slave, or it may be in the form of a broadcast, in which case the slaves do not answer. 
The query is contained in a frame that includes the address of the intended receiver, what 
this slave is to do, data needed to perform the action, and a means of checking for errors. 
The slave checks if errors have occurred and performs the desired action. After the action is 
performed the slave builds the response and returns it to the master. The master can send 
another message to any slave as soon as it receives a valid response or after a user-selected 
time interval. 

Data can be exchanged in two transmission modes: ASCII (American Standard Code for 
Information Interchange) and RTU (Remote Terminal Unit). The major differences between 
them are the type of error check performed on the message and the number of characters 
used. Fieldgate SWG70 supports RTU only. Modbus offers several read, write and test func-
tions, each identified by a code number. They are designed as control commands for sensors 
and actuators, e.g. coils, inputs, input registers, holding or output registers, diagnosis and 
test reports, programs, polling control and reset. For Modbus TCP the serial frame is simply 
inserted into the Ethernet data frame. In addition, not all codes are implemented.
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Modbus overview

16.1.2 Modbus in Fieldgate
Fieldgate SWG70 is equipped with both a Modbus serial and Ethernet interface. As a result, 
it can be operated in one of the following roles:

• Modbus Serial Slave
• Modbus TCP Slave

A serial or TCP slave can be accessed by one Modbus master only.

Establishing 
communication

As a TCP slave, Fieldgate SWG70 will normally communicate with the master via Port 502. 
If this port is unavailable, it is possible to specify a secondary TCP/IP port number.

Modbus commands Fieldgate SWG70 support for Modbus functions is currently as follows:

Modbus RTU Modbus TCP
Standard compliance "Modbus over Serial Line" V1 "Modbus over TCP" V1
Physical layer RS-485 Ethernet
Transmission mode RTU (binary mode) TCP
Baudrates 1200 bit/s, 2400 bit/s, 4800 bit/s, 

9600 bit/s, 19200 bit/s, 38400 bit/s, 
57600 bit/s, 115200 bit/s

100 MBit/s

Parity Odd, Even, None –
Stop bits 1; 1.5; 2 –
Polling address 1...247 –
Port No. – 502
Capabilities • Input registers starting at Modbus address 30013

• HART Command 3 dynamic variables mapped into input registers
• 2 input registers map a single HART dynamic variable
• 32bit HART floating point format used
• Status information mapped on dedicated input registers

Function Function Code Hex Function supported
Read discrete inputs 2 0x02 Yes
Read coils 1 0x01 No
Write single coil 5 0x05 No
Write multiple coils 15 0x0F No
Read input register 4 0x04 Yes
Read holding register 3 0x03 Yes
Write single register 6 0x06 No
Write multiple registers 16 0x10 No
Read/Write multiple register 23 0x17 No
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Registers Modbus specifies four different types of register:

• Discrete input registers contain the discrete input values and possibly status
• Input registers contain analog input values and status
• Coil registers contain discrete output values and possibly status
• Holding registers contain analog output values and status

In addition, it is possible to "pack" discrete inputs and outputs into words, which are then 
stored as appropriate in the input or holding registers. 
Fig. 16-1 overleaf gives an overview of the register and reference address ranges used for 
each register type.

For Fieldgate, the holding registers are a read only image of the input registers which can 
be accessed when the Read Modbus Registers Mode is set to "Input and Holding". See 
Chapter 10.3.1.

HART implementation The Modbus implementation in Fieldgate SWG70 maps HART dynamic process variables 
over Modbus input registers and also uses input registers to provide device-related status 
information. The Modbus implementation is based on the following assumptions:

• The HART Command 3 dynamic variables are used for automatic Modbus mapping.
• For Modbus access, publishing must be enabled for all relevant devices.
• The Fieldgate caches the relevant information. Modbus commands will therefore access 

the internal Fieldgate memory.
• Modbus input registers are only supported if they are associated with HART dynamic 

process variables.
• A device can either be a WirelessHART device or a wired HART device connected to a 

WirelessHART Adapter (SWA70).
• WirelessHART and wired HART devices are mapped independently within the Modbus 

input registers. 
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Fig. 16-1: Mapping of Modbus registers Fieldgate SWG70

Refresh time Fieldgate SWG70 refreshes Modbus discrete inputs and input registers once every macro-
cycle. The length of the macrocycle depends on the number of WirelessHART devices in the 
network, the response time of the devices and the number of parameters they transmit.

• In general, shorter refresh times can be attained by restricting the traffic over the network 
to essential parameters only.
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16.1.3 Data types
Fieldgate SWG70 supports three different data types, which are interpreted and stored as 
described below: 

• Floating point, Unsigned Integer16, Unsigned Integer8

Floating point

Unsigned16

Unsigned8

Value range (±) 1.175 * 10-38 to 3.403 * 1038 
Byte Structure

Byte Structure Float Swapped Float
Modbus Register 1

Modbus Register 2

Sign Exponent (8 bit) Fraction (23 bit)

31 023

015 31 16

31 16 015

Value range 0 to 65.535
Byte Structure

Byte Structure Unsigned Integer16 Swapped Unsigned Integer16
Modbus Register 1

Value (16 bit)

15 0

015 015

Value range 0 to 255
Byte Structure

Byte Structure Unsigned Integer8
(Integer 8 without sign)

Swapped Unsigned Integer8

Modbus Register 1

Value (8 bit)

15 7 0

0 0 0 0 0 0 0 0

015 7

0 0 0 0 0 0 0 0

015 7

0 0 0 0 0 0 00
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16.2 Rules for mapping

16.2.1 Automatic mapping of analog devices (HART CMD 3)
Each HART device is mapped into 12 consecutive Modbus input registers. The order of HART 
device mapping starting from register 13 is the same as the order of the sub-device identity 
summary (returned by HART CMD84). For example, the HART device with the sub-device 
index=1 is mapped starting at register 13. The device with the sub-device index = 2 is 
mapped starting at register 25, and so on.

To find out the starting register reference address of a certain sub-device, use the following 
formula:

• SMIR = 300013 + 12*(SDI-1)

• SMIR: is the starting Modbus input register of the associated HART device
• SDI: is the sub-device index value.

The following table shows an example of the mapping of the first two HART devices, i.e. the 
ones associated with SDI=1 and SDI=2. The assigned Modbus registers can be viewed in the 
Input Status and Input Register dialogs. See Chapter 10.3.3 "Input Register" on page 73.

Example of Modbus 
mapping of HART CMD 3

Modbus Specific Status

HART Device Status

Reference 
address

Modbus RTU Format: Sub-device 
index

300013 300014 AI Primary variable (loop current, mA unit) 32-bit floating 
point

1
300015 300016 PV Primary variable (device-specific unit)
300017 300018 SV Secondary variable (device-specific unit)
300019 300020 TV Ternary variable (device-specific unit)
300021 300022 QV Quaternary variable (device-specific unit)
300023 – ModStat Modbus Specific Status 16-bit unsigned 

integer300024 – DevStat HART Device Status
300025 300026 AI Primary variable (loop current, mA unit) 32-bit floating 

point
2

300027 300028 PV Primary variable (device-specific unit)
300029 300030 SV Secondary variable (device-specific unit)
300031 300032 TV Ternary variable (device-specific unit)
300033 300034 QV Quaternary variable (device-specific unit)
300035 – ModStat Modbus Specific Status 16-bit unsigned 

integer300036 – DevStat HART Device Status

Bit Parameter Description
0x01 (LSB) Cache validity Set to 1 when the HART CMD 3 cache of the device is empty.
0x02 (LSB) Identification ongoing Set to 1 when the gateway is performing a device identification 

procedure.
0x04 (LSB) Device off-line Set to 1 when the device is offline

Bit Parameter Description
0x80 Device malfunction Device in the network has malfunctioned
0x40 Configuration changed Configuration of a device in the network has changed
0x20 Cold start Device in the network has cold start flagged
0x10 More status available Device in the network has more status available flagged
0x08 Loop current fixed Loop current of a device in the network is fixed to 4 mA 

(multidrop mode)
0x04 Loop current saturated Loop current of a device in the network above 20 mA
0x02 Non-primary variable out of 

limits
SV, TV, QV of a device in the network is out of limits

0x01 Primary variable out of limits PV of a device in the network is out of limits
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16.2.2 Digital input/output devices
There is no automatic mapping of the Input Status registers. the user must generate the 
mapping table either semi-automatically or manually. 

• A semi-automatic mapping will duplicate the values entered under the "Generate" tab for 
all devices in the network, irrespective of device type

• A manual mapping allows the table to be built up for each individual device 
(recommended)

Discrete devices publish their values by "bursting" HART CMD 64386. This tells Fieldgate 
SWG70 how many discrete values a device has as well as the index of the first discrete value. 
A maximum of 256 discrete values can be mapped for each device. At the moment, Fieldgate 
SWG70 does not map the status of the device.

Each discrete value is published as a UNIT16. Fieldgate SWG70 first splits the data into two 
bytes then reserves 8 registers for each byte, i.e. one for each bit. 

•  The Least Significant Byte (x) maps Bits 0 - 7 of the value with Index x
•  The Most Significant Byte (x) maps Bits 8 - 15 of the value with Index x

Index "x" is not determined by the position of the discrete value in the device burst list but 
rather by its position in CMD 64385. For example, if the 1st and 4th discrete variables are 
selected in the burst list, the corresponding indexes are "0" and "3". Assuming that all bytes 
are of interest, the user must enter the following lines: 

•  Tag Device 1: Least Significant Byte0
Tag Device 1: Most Significant Byte 0
Tag Device 1: Least Significant Byte 3
Tag Device 1: Lost Significant Byte 3

The following (manual) mapping table results:

When Fieldgate SWG70 receives CMD 64.386, it checks whether the variables have been 
mapped, then enters the associated information. Any values that are not mapped are 
discarded.

Reference address Device Discrete Variable Bit Byte (Variable Index)
100001 Device 1 Variable 1 Bit 0 LSB (0)
100002 Device 1 Variable 1 Bit 1 LSB (0)
...
100007 Device 1 Variable 1 Bit 6 LSB (0)
100008 Device 1 Variable 1 Bit 7 LSB (0)
100009 Device 1 Variable 1 Bit 8 MSB (0)
100010 Device 1 Variable 1 Bit 9 MSB (0)
...
100015 Device 1 Variable 1 Bit 14 MSB (0)
100016 Device 1 Variable 1 Bit 15 MSB (0)
100017 Device 1 Variable 4 Bit 0 LSB (3)
...
100025 Device 1 Variable 4 Bit 7 LSB (3)
100026 Device 1 Variable 4 Bit 8 MSB (3)
...
100032 Device 1 Variable 4 Bit 15 MSB (3)
...
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16.3 Mapping formats

16.3.1 Dynamic process variables
For each HART device, the 5 possible Command 3 floating-point dynamic variables are 
sequentially mapped (units code values are not mapped). If a device does not support a spe-
cific dynamic value, a "NaN" (Not a Number) floating-point value is returned (namely, 0x7F, 
0xA0, 0x00, 0x00).

The CMD3 dynamic variables follow the IEEE-754 (IEC559) single-precision floating-point 
format.

The same format is also used for the Modbus 32-bit floating point values. 

The Modbus protocol does not explicitly specify any 32-bit data element. However, the usage 
of 2 consecutive 16-bit registers is the de-facto standard way to map a single-precision IEEE-
754 floating-point value. The Modbus floating value will be transmitted in the "big-endian" 
or "little endian" style according to the swap selection in the Modbus dialog. See 
Chapter 8.4.4 "AMS via Ethernet" on page 52. 

For example, the number 123456.00 as defined in the IEEE-754 standard appears as 
follows:

This number will be transmitted from the Fieldgate to the Modbus master in the following 
sequence:

• 47 F1 20 00

in "big-endian" style where "00" – the less significant byte – is the first one to be transmitted. 
The sequence can be changed to "little-endian". See Chapter 10.3.1 "Modbus Settings" on 
page 68.

16.3.2 Status mapping
For each HART device, two 16-bit unsigned input registers are used to map the relevant sta-
tus information. The status information is delivered as a series of independent flags. Within 
an input register, the unused bits are always returned as "0".

•  ModStat: Modbus Specific Status
– Bit 0: Cache validity
– Bit 1: Identifications
– Bits 2 – 15: Not used

•  DevStat: The "Device Status" information according to the HART 7 specification
– Bit 0: Primary variable out of limits
– Bit 1: Non-primary variable out of limits
– Bit 2: Loop current saturated
– Bit 3: Loop current fixed
– Bit 4: More status available
– Bit 5: Cold start
– Bit 6: Configuration changed
– Bit 7: Device malfunction

For more information see the Modbus Specific Status and HART Device Status tables. See 
Chapter 16.2 "Rules for mapping" on page 123.

1-bit Sign of Fraction 8-bit Exponent 23-bit Fraction

Byte 0 Byte 1 Byte 2 Byte 3
0x00 0x20 0xF1 0x47
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16.3.3 HART CMD48 Read Additional Status Information
Command 48 returns device status information not included in the response code or device 
status byte of Command 3. All field devices support at least bytes 0 ... 8. If a field device sup-
ports more than one analog channel, then bytes 9 ... 13 will be supported as well.

Response Data Bytes Byte Parameter Description
0 Extended dev ice malfunction

(Device-specific status 0)
• 0x01 Manager fault 
• 0x02 Non-Volatile Memory Defect
• 0x04 Volatile Memory Defect 
• 0x08 Ethernet communication fault 
• 0x10 Wired Device Duplicated 
• 0x20 Long Tag Duplicated
• 0x40 Electronic defect
• 0x80 RS-485 communication fault 

1 Gateway Operation in Progress 
(Device-specific status 1)

• 0x02 Block transfer (not currently supported)
• 0x04 Delayed answer 
• 0x08 Self-test (not currently supported) 
• 0x20 Device List update 
• 0x40 Network Manager Reset In Progress 
• 0x80 Start-up phase

2 Extended Lists Changes
(Device-specific status 2)

• 0x01 Instrument List Changed 
• 0x04 Active Device List changed 

3 Cumulative Device Status
(Device-specific status 3)

• 0x01 Primary Variable Out of Limits 
• 0x02 Non-Primary Variable Out of Limits 
• 0x04 Loop Current Saturated 
• 0x08 Loop Current Fixed 
• 0x10 More Status Available
• 0x20 Cold Start
• 0x40 Configuration Changed
• 0x80 Device malfunction

4 Cumulative Extended Device 
Status
(Device-specific status 4)

• 0x01 Maintenance Required
• 0x02 Device Variable Alert 
• 0x04 Critical Power Failure 

5 Device Operation in Progress 
(Device-specific status 5)

• 0x02 “Configuration Changed bit reset” procedure
• 0x04 “Sub-Device update” procedure 
• 0x08 “Device update” procedure 

6 Extended device status Not relevant for Gateway, always set to "0"
7 Device operating mode For future expansions, always set to "0"
8 Standardized status 0 • 0x01 Simulation active

The device is in simulation mode and one or more of its device 
variables are not representative of the process.

• 0x02 Non-volatile memory defect
The non-volatile memory check is invalid or maybe corrupt, or the 
battery of a battery-powered memory is defective

• 0x04 Volatile memory defect
The RAM memory check is invalid or maybe corrupt.

• 0x08 Watchdog reset executed
A watchdog reset has been executed.

• 0x10 Power supply conditions out of range
The power supply is outside its allowable range.

• 0x20 Environmental conditions out of range
An internal or environmental condition is beyond acceptable limits.

• 0x40 Electronic defect
A hardware problem not related to the sensor has been detected.

9 Standardized status 1 For future expansions, always set to "0"
10 Analog channel saturated Not relevant for Gateway, always set to "0"
11 Standardized status 2 • 0x01 Sub-device list changed 

When set, the I/O system has lost communication with one of its sub-
devices or discovered a new sub-device. This bit is reset if command 74 
"Number of devices detected" is issued. The current sub-device list is 
read using command 84.

• 0x02 Duplicate master detected
The adapter has discovered another master with the same address 
connected to its token-passing interface.
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16.3.4 Read Digital Inputs
HART Specification 285 describes the requirements for discrete and hybrid field devices. A 
digital device will return binary values only. A hybrid device may return both analog and 
binary values. Digital inputs are read using HART command 64.386 which returns a block of 
binary variables (values and status). The length of the data string depends upon the device 
polled. For further details, please consult the device manual. 

Request Data Bytes
Byte Format Description
0-1 Unsigned16 Index of First Binary Variable to read 
2 Unsigned8 Number of Binary Variables to read (n)
Response Data Bytes
Byte Format Description
0-1 Unsigned16 Index of first Binary Variable Returned
2 Unsigned8 Number of Binary Variables returned (n)
3 Bits-8 Extended Device Status
4-7 Time Time stamp for most recent change to Actual Value of first Discrete Variable 

Value
8-9 Unsigned16 First Discrete Variable Value
10 Bits-8 First Discrete Variable Status

• 0x01: 1 = Binary Variable in Simulation or Local Override
• 0x02: 1 = Binary Variable in Fault Mode
• 0x02-0x04: Reserved, bit set to zero

11-12 Unsigned16 Second Binary Variable Value
13 Bits-8 Second Binary Variable Status
.....
3n+8-
3n+9

Unsigned16 Last Binary Variable Value

3n+10 Bits-8 Last Binary Variable Status
Command-Specific Response Codes
Code Class Description
0 Success No Command-Specific Errors
1 Undefined
2 Error Invalid Selection
3-4 Undefined
5 Error Too Few data Bytes Received
6 Error Device-Specific Command Error
7 Undefined
7 Undefined
8 Warning Set to nearest value
9-15 Undefined
16 Error Access Restricted
17-127 Undefined
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17 CSV file formats

NOTICE!
• This section on "CSV file formats" is only relevant for Fieldgate versions with Modbus. The 

"Modbus" function is only available on WirelessHART Fieldgate models with the version 
"SWG70-xx-1-xx-xx". See Chapter 2.3 "Ordering information" on page 10.

17.1 Structure of the CSV files
When creating or editing CSV files for import into Fieldgate SWG70, the following rules 
apply:

• Use a semicolon ";" as separator for the values in the CSV file. If a value already contains a 
semicolon you must put the value into quote signs. If the value already contains quote 
signs, put the entire value into quote signs and replace the original quote signs with double 
quote signs.
Example!
The value - this is a "long tag" that contains quote signs - must be entered like this: "this is 
a "long tag" that contains quote signs"

• Avoid special characters. They can easily be corrupted or they can cause the whole data 
row to be skipped during the import of the CSV file.

• Avoid leading blanks, trailing blanks, and tabs, especially for integer or hexadecimal 
values.

• Respect the data type of each column.
• If a mandatory column is missing, the whole file is rejected and nothing is imported.
• If a mandatory value is missing, the corresponding data row is skipped.

17.2 Modbus Mapping CSV files
The files for MODBUS mapping contain the following columns

The data in the RegisterType, InformationCode, and MappingCode columns is encoded as 
described in the tables below.

Register Type Codes

Information Code

Expanded 
Device 
Type Code

Device ID IO-Card Channel Long Tag Registers Register 
Type

Information 
Code

Mapping 
Code

4 digits hex  6 digits hex integer integer string [32] integer integer  integer  integer
– – – – mandatory mandatory mandatory mandatory mandatory

Value Description
1 Discrete Input
3 Input Register

Value Description
0 HART Status (RegisterType Code = 3)
1 CMD 48 Status (RegisterType Code = 3)
2 Device Variables (RegisterType Code = 3)
3 Modbus Status (RegisterType Code = 3)
4 Discrete Variables LSB (RegisterType Code = 1)
5 Discrete Variables MSB (RegisterType Code = 1)
6 Network Statistic (RegisterType Code = 3)
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Note that the Mapping Codes depend on the Information Code, see the following table.

17.3 Instrument List CSV files
The files for the instrument list contain the following columns:

17.4 Topology View CSV file
The files for the topology view contain the following columns.

Note that the X- and Y-origins of the background image are not part of the CSV file, as these 
coordinates are related to the background image. 

Information Code Value Description
0 (HART Status)  0 Device Status

1 Extended Device Status
2 Device Status & Extended Device Status

1 (CMD 48 Status) 0 ... 12 CMD 48 status word to be mapped
0 maps CMD 48 bytes 0&1
1 maps CMD 48 bytes 2&3 
... and so on
12 maps CMD 48 byte 24 only

2 (Device Variable) 0 ... 242 Device Variables
For more information on what device-specific information is 
available and on the device specific unit codes, see the manual 
of the subdevice.

243 Battery Life
244 Percent Range
245 Loop Current
246 Primary Variable
247 Secondary Variable
248 Tertiary Variable
249 Quaternary Variable
255 Slot 0 data time stamp

3 (Modbus Status) 0 "Mod Stat" information
4 (Discrete Variable - LSB) 0 ... 255 Binary Variable Index

The least significant byte of the variable is mapped.
5 (Device Variable - MSB) 0 ... 255 Binary Variable Index

The most significant byte of the variable is mapped.
6 (Network Statistic) 0 Reliability

1 Stability
2 Latency
3 Lost Upstream Packets

LSB: least significant byte, MSB: most significant byte

Type Code Device ID IO-Card Channel Long Tag
4 digits hex 6 digits hex integer integer string[32]

mandatory

Expanded 
Device Type 
Code

Device ID IO-Card Channel Long Tag Units Code Range X-Coordinate Y-Coordinate Z-Coordinate

4 digits hex 6 digits hex integer integer string[32] integer float float float float
– – – – mandatory – mandatory mandatory – –
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17.5 Details
The files you can export under Diagnostics > Wireless Communication > Details contain 
the following columns. There are no mandatory columns as there is no import function. 
Nevertheless, you can export the data in CSV format for documentation.

Expanded 
Device 
Type Code

Device 
ID

IO-Card Channel Long Tag Status Device 
Status

Number Of 
Joins

Recent Join 
Date

Reliability Latency Neighbors RSSI Stability

4 digits 
hex

6 digits 
hex

integer integer string[32] 2 digits 
hex

2 digits 
hex

integer yyyy: mm:dd
hh:mm:ss

float float string[32] integer float
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18 Table Device Variable Classification and 
Unit Code

Device Variable Classification Classification Code Unit Code Description
Generic 0 240-249 Enumeration may be used for manufacturer specific 
Generic 0 249 definitions
Generic 0 250 Not Used
Generic 0 251 None
Generic 0 252 Unknown
Generic 0 253 Special
Temperature 64 32 Degrees Celsius
Temperature 64 33 Degrees Fahrenheit
Temperature 64 34 Degrees Rankine
Temperature 64 35 Kelvin
Pressure 65 1 inches of water at 68 degrees F
Pressure 65 2 inches of mercury at O degrees C
Pressure 65 3 feet of water at 68 degrees F
Pressure 65 4 millimeters of water at 68 degrees F
Pressure 65 5 millimeters of mercury at 0 degrees C
Pressure 65 6 pounds per square inch
Pressure 65 7 bars
Pressure 65 8 millibars
Pressure 65 9 grams per square centimeter
Pressure 65 10 kilograms per square centimeter
Pressure 65 11 pascals
Pressure 65 12 kilopascals
Pressure 65 13 torr
Pressure 65 14 atmospheres
Pressure 65 145 inches of water at 60 degrees F
Pressure 65 170 centimeters of water at 4 degrees C
Pressure 65 171 meters of water at 4 degrees C
Pressure 65 172 centimeters of mercury at 0 degrees C
Pressure 65 173 pounds per square foot
Pressure 65 174 hectoPascals
Pressure 65 175 pounds per square inch absolute
Pressure 65 176 kilograms per square meter
Pressure 65 177 feet water 4 degrees C
Pressure 65 178 feet water at 60 degrees F
Pressure 65 179 meters of mercury at O degrees C
Pressure 65 180 1E6 psi million pounds per square inch
Pressure 65 237 megapascals
Pressure 65 238 inches of water at 4 degrees C
Pressure 65 239 millimeters of water at 4 degrees C
Volumetric Flow 66 15 cubic feet per minute
Volumetric Flow 66 17 liters per minute
Volumetric Flow 66 18 imperial gallons per minute
Volumetric Flow 66 19 cubic meter per hour
Volumetric Flow 66 22 gallons per second
Volumetric Flow 66 23 million gallons per day
Volumetric Flow 66 24 liters per second
Volumetric Flow 66 25 million liters per day
Volumetric Flow 66 26 cubic feet per second
Volumetric Flow 66 27 cubic feet per day
Volumetric Flow 66 28 cubic meters per second
Volumetric Flow 66 29 cubic meters per day
Volumetric Flow 66 30 imperial gallons per hour
Volumetric Flow 66 31 imperial gallons per day
Volumetric Flow 66 121 normal cubic meter per hour MKS System
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Volumetric Flow 66 122 normal liter per hour MKS System
Volumetric Flow 66 123 standard cubic feet per minute U.S. System
Volumetric Flow 66 130 cubic feet per hour
Volumetric Flow 66 131 cubic meters per minute
Volumetric Flow 66 132 barrels per second 
Volumetric Flow 66 133 barrels per minute 
Volumetric Flow 66 134 barrels per hour 
Volumetric Flow 66 135 barrels per day
Volumetric Flow 66 136 gallons per hour
Volumetric Flow 66 137 imperial gallons per second
Volumetric Flow 66 138 liters per hour
Volumetric Flow 66 170 beer barrels per second 
Volumetric Flow 66 171 beer barrels per minute 
Volumetric Flow 66 172 beer barrels per hour 
Volumetric Flow 66 173 beer barrels per day 
Volumetric Flow 66 174 normal liter per day 
Volumetric Flow 66 175 normal liter per minute 
Volumetric Flow 66 176 normal liter per second
Volumetric Flow 66 177 standard liter per day 
Volumetric Flow 66 178 standard liter per hour
Volumetric Flow 66 179 standard liter per minute
Volumetric Flow 66 180 standard liter per second
Volumetric Flow 66 181 normal cubic meter per day
Volumetric Flow 66 182 normal cubic meter per minute
Volumetric Flow 66 183 normal cubic meter per second
Volumetric Flow 66 184 standard cubic feet per day 
Volumetric Flow 66 185 standard cubic feet per hour 
Volumetric Flow 66 186 standard cubic feet per second 
Volumetric Flow 66 187 standard cubic meter per day 
Volumetric Flow 66 188 standard cubic meter per hour 
Volumetric Flow 66 189 standard cubic meter per minute 
Volumetric Flow 66 190 standard cubic meter per second 
Volumetric Flow 66 235 gallons per day
Velocity 67 20 feet per second
Velocity 67 21 meters per second
Velocity 67 114 inches per second
Velocity 67 115 inches per minute
Velocity 67 116 feet per minute
Velocity 67 120 meters per hour
Volume 68 40 gallons
Volume 68 41 liters
Volume 68 42 imperial gallons
Volume 68 43 cubic meters
Volume 68 46 barrels 
Volume 68 110 bushels
Volume 68 111 cubic yards
Volume 68 112 cubic feet
Volume 68 113 cubic inches
Volume 68 124 bbl Iiq
Volume 68 166 normal cubic meter MKS System
Volume 68 167 normal liter MKS System
Volume 68 168 standard cubic feet U.S. System
Volume 68 170 beer barrel 
Volume 68 171 standard liter 
Volume 68 172 standard cubic meter
Volume 68 236 hectoliters
Length 69 44 feet
Length 69 45 meters

Device Variable Classification Classification Code Unit Code Description



WirelessHART Fieldgate SWG70 Table Device Variable Classification and Unit Code

Endress+Hauser 133

Length 69 47 inches
Length 69 48 centimeters
Length 69 49 millimeters
Length 69 151 feet in sixteenths
Length 69 170 μm micron
Length 69 171 μin microinch 
Time 70 50 minutes
Time 70 51 seconds
Time 70 52 hours
Time 70 53 days
Time 70 170 ms milliseconds
Time 70 171 μs microseconds 
Time 70 172 ns narioseconds
Mass 71 60 grams
Mass 71 61 kilograms
Mass 71 62 metric tons
Mass 71 63 pounds
Mass 71 64 short tons
Mass 71 65 long tons
Mass 71 125 ounce
Mass Flow 72 70 grams per second
Mass Flow 72 71 grams per minute
Mass Flow 72 72 grams per hour
Mass Flow 72 73 kilograms per second
Mass Flow 72 74 kilograms per minute
Mass Flow 72 75 kilograms per hour
Mass Flow 72 76 kilograms per day
Mass Flow 72 77 metric tons per minute
Mass Flow 72 78 metric tons per hour
Mass Flow 72 79 metric tons per day
Mass Flow 72 80 pounds per second
Mass Flow 72 81 pounds per minute
Mass Flow 72 82 pounds per hour
Mass Flow 72 83 pounds per day
Mass Flow 72 84 short tons per minute
Mass Flow 72 85 short tons per hour
Mass Flow 72 86 short tons per day
Mass Flow 72 87 long tons per hour
Mass Flow 72 88 long tons per day
Mass per Volume 73 90 specific gravity units
Mass per Volume 73 91 grams per cubic centimeter
Mass per Volume 73 92 kilograms per cubic meter
Mass per Volume 73 93 pounds per gallon
Mass per Volume 73 94 pounds per cubic foot
Mass per Volume 73 95 grams per milliliter
Mass per Volume 73 96 kilograms per liter
Mass per Volume 73 97 grams per liter
Mass per Volume 73 98 pounds per cubic inch
Mass per Volume 73 99 short tons per cubic yard
Mass per Volume 73 100 degrees twaddell
Mass per Volume 73 102 degrees baume heavy
Mass per Volume 73 103 degrees baume light
Mass per Volume 73 104 degrees API
Mass per Volume 73 146 micrograms per liter
Mass per Volume 73 147 micrograms per cubic meter
Mass per Volume 73 148 percent consistency
Mass per Volume 73 170 milligrams per liter
Viscosity 74 54 centistokes

Device Variable Classification Classification Code Unit Code Description
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Viscosity 74 55 centipoise
Viscosity 74 170 Ps-s Pascal second
Angular Velocity 75 117 degrees per second
Angular Velocity 75 118 revolutions per second
Angular Velocity 75 119 revolutions per minute
Energy (Work) 77 69 joule 
Energy (Work) 77 89 Dth deka therm / MMBtu Million British thermal unit
Energy (Work) 77 126 foot pound force
Energy (Work) 77 128 kilo watt hour 
Energy (Work) 77 162 mega calorie 
Energy (Work) 77 164 mega joule
Energy (Work) 77 165 Btu British thermal unit
Force 78 68 N Newton
Force 78 170 kN kilo Newton
Power 79 127 kilo watt
Power 79 129 horsepower
Power 79 140 mega calorie per hour 
Power 79 141 mega joule per hour
Power 79 142 British thermal unit per hour 
Power 79 170 MJls megajoules per second / MW Megawatt
Power 79 171 MJ/d megajoules per day 
Power 79 172 MMBtu/s million British thermal units per second
Power 79 173 MMBtu/h million British thermal units per hour 
Power 79 174 MMBtu/d million British thermal units per day
Power 79 127 kilo watt
Power 79 129 horsepower
Power 79 140 mega calorie per hour 
Power 79 141 mega joule per hour
Power 79 142 British thermal unit per hour 
Power 79 170 MJls megajoules per second / MW Megawatt
Power 79 171 MJ/d megajoules per day 
Power 79 172 MMBtu/s million British thermal units per second
Power 79 173 MMBtu/h million British thermal units per hour 
Power 79 174 MMBtu/d million British thermal units per day
Frequency 80 38 hertz
Analytical 81 57 percent
Analytical 81 59 pH
Analytical 81 150 percent steam quality
Analytical 81 160 percent plato
Analytical 81 161 percent lower explosion level
Capacitance 82 153 picofarads
Electromotive / Electric Potential / EMF 83 36 millivolts
Electromotive / Electric Potential / EMF 83 58 volts
Current 84 39 milliamperes
Current 84 39 milliamperes
Current 84 170 nA: nanoamperes
Current 84 171 μA: microamperes
Current 84 170 nA: nanoamperes
Current 84 171 μA: microamperes
Resistance 85 37 ohms
Resistance 85 163 kohms
Resistance 85 170 MOhm mega ohms
Resistance 85 171 Ohm cm
Resistance 85 172 kOhm cm
Resistance 85 173 MOhm cm
Resistance 85 174 mΩ milli Ohms
Resistance 85 37 Ohms
Resistance 85 163 kilo ohms

Device Variable Classification Classification Code Unit Code Description
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Resistance 85 170 mega ohms
Resistance 85 171 Ohm cm 
Resistance 85 172 kohm Cm 
Resistance 85 173 MOhm cm
Resistance 85 174 milli Ohms 
Angle 86 143 degrees
Angle 86 144 radian
Angle 86 143 degrees
Angle 86 144 radian
Conductance 87 56 microsiemens
Conductance 87 66 milli siemens per centimeter
Conductance 87 67 micro siemens per centimeter
Conductance 87 56 microsiemens
Conductance 87 66 milli siemens per centimeter
Conductance 87 67 mmm siemens per centimeter conductivity
Volume Per Volume 88 149 volume percent
Volume Per Volume 88 154 milliliters per liter
Volume Per Volume 88 155 microliters per liter
Volume per Volume 88 149 volume percent
Volume per Volume 88 154 milliliters per liter
Volume per Volume 88 155 microliters per liter
Volume per Mass 89 107 degrees balling
Volume per Mass 89 152 cubic feet per pound
Volume per Mass 89 107 degrees balling
Volume per Mass 89 152 cubic feet per pound
Concentration 90 57 Percent
Concentration 90 105 percent solids per weight
Concentration 90 106 percent solids per volume
Concentration 90 108 proof per volume
Concentration 90 109 proof per mass
Concentration 90 139 ppm parts per million
Concentration 90 169 ppb parts per billion
Concentration 90 101 °Bx degrees brix
Concentration 90 170 ppth parts per thousand
Acceleration 96 170 g - Gravitational Acceleration
Acceleration 96 171 feet per second
Acceleration 96 172 meter per second squared
Turbidity 97 170 FNU: Formazin Nephelometric Units ISO
Turbidity 97 171 FTU: Formazin Turbidity Unit 
Turbidity 97 172 NTU: Nephelometric Turbidity Unit 
Volumetric Gas Flow per Second 99 186 standard cubic feet per second 
Volumetric Gas Flow per Second 99 176 normal liter per second 
Volumetric Gas Flow per Second 99 180 standard liter per second
Volumetric Gas Flow per Second 99 183 normal cubic meter per second 
Volumetric Gas Flow per Second 99 190 standard cubic meter per second 
Volumetric Gas Flow per Minute 100 123 standard cubic feet per minute
Volumetric Gas Flow per Minute 100 175 normal liter per minute
Volumetric Gas Flow per Minute 100 179 standard liter per minute 
Volumetric Gas Flow per Minute 100 182 normal cubic meter per minute 
Volumetric Gas Flow per Minute 100 189 standard cubic meter per minute 
Volumetric Gas Flow per Hour 101 185 standard cubic feet per hour 
Volumetric Gas Flow per Hour 101 122 normal liter per hour 
Volumetric Gas Flow per Hour 101 178 standard liter per hour 
Volumetric Gas Flow per Hour 101 121 normal cubic meter per hour
Volumetric Gas Flow per Hour 101 188 standard cubic meter per hour 
Volumetric Gas Flow per Day 102 184 standard cubic feet per day 
Volumetric Gas Flow per Day 102 174 normal liter per day
Volumetric Gas Flow per Day 102 177 standard liter per day

Device Variable Classification Classification Code Unit Code Description
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Volumetric Gas Flow per Day 102 181 normal cubic meter per day 
Volumetric Gas Flow per Day 102 187 standard cubic meter per day
Volumetric Liquid Flow per Second 103 174 Imperial Fluid ounces per second 
Volumetric Liquid Flow per Second 103 175 US Fluid ounces per second 
Volumetric Liquid Flow per Second 103 176 milliliter (cc) per second 
Volumetric Liquid Flow per Second 103 24 liters per second
Volumetric Liquid Flow per Second 103 178 hectoliter per second
Volumetric Liquid Flow per Second 103 28 cubic meter (kiloliter) per second 
Volumetric Liquid Flow per Second 103 180 million liters (megaliter) per second
Volumetric Liquid Flow per Second 103 22 US gallons per second 
Volumetric Liquid Flow per Second 103 182 US kilogallon per second
Volumetric Liquid Flow per Second 103 183 US million gallons per second 
Volumetric Liquid Flow per Second 103 137 imperial gallons per second 
Volumetric Liquid Flow per Second 103 185 imperial million gallons per second
Volumetric Liquid Flow per Second 103 26 cubic feet per second 
Volumetric Liquid Flow per Second 103 187 Acre—Feet per second
Volumetric Liquid Flow per Second 103 188 US drum per second 
Volumetric Liquid Flow per Second 103 189 US liquid barrel per second 
Volumetric Liquid Flow per Second 103 170 US beer barrel per second 
Volumetric Liquid Flow per Second 103 132 Oil barrels per second 
Volumetric Liquid Flow per Second 103 192 UK beer barrel per second
Volumetric Liquid Flow per Minute 104 174 Imperial Fluid ounces per minute 
Volumetric Liquid Flow per Minute 104 175 US Fluid ounces per minute 
Volumetric Liquid Flow per Minute 104 176 milliliter (cc) per minute
Volumetric Liquid Flow per Minute 104 17 liters per minute
Volumetric Liquid Flow per Minute 104 178 hectoliter per minute
Volumetric Liquid Flow per Minute 104 131 cubic meter (kiloliter) per minute 
Volumetric Liquid Flow per Minute 104 180 million liters (megaliter) per minute 
Volumetric Liquid Flow per Minute 104 16 US gallons per minute
Volumetric Liquid Flow per Minute 104 182 US kilogallon per minute
Volumetric Liquid Flow per Minute 104 183 US million gallons per minute 
Volumetric Liquid Flow per Minute 104 18 imperial gallons per minute 
Volumetric Liquid Flow per Minute 104 185 imperial million gallons per minute 
Volumetric Liquid Flow per Minute 104 15 cubic feet per minute 
Volumetric Liquid Flow per Minute 104 187 Acre—Feet per minute 
Volumetric Liquid Flow per Minute 104 188 US drum per minute 
Volumetric Liquid Flow per Minute 104 189 US liquid barrel per minute
Volumetric Liquid Flow per Minute 104 170 US beer barrel per minute
Volumetric Liquid Flow per Minute 104 133 Oil barrels per minute
Volumetric Liquid Flow per Minute 104 192 UK beer barrel per minute
Volumetric Liquid Flow per Hour 105 174 Imperial Fluid ounces per hour 
Volumetric Liquid Flow per Hour 105 175 US Fluid ounces per hour
Volumetric Liquid Flow per Hour 105 176 milliliter (cc) per hour 
Volumetric Liquid Flow per Hour 105 138 liters per hour
Volumetric Liquid Flow per Hour 105 178 hectoliter per hour 
Volumetric Liquid Flow per Hour 105 29 cubic meter (kiloliter) per hour 
Volumetric Liquid Flow per Hour 105 180 million liters (megaliter) per hour 
Volumetric Liquid Flow per Hour 105 136 US gallons per hour
Volumetric Liquid Flow per Hour 105 182 US kilogallon per hour 
Volumetric Liquid Flow per Hour 105 183 US million gallons per hour
Volumetric Liquid Flow per Hour 105 30 imperial gallons per hour 
Volumetric Liquid Flow per Hour 105 185 imperial million gallons per hour
Volumetric Liquid Flow per Hour 105 130 cubic feet per hour
Volumetric Liquid Flow per Hour 105 187 Acre—Feet per hour
Volumetric Liquid Flow per Hour 105 188 US drum per hour 
Volumetric Liquid Flow per Hour 105 189 US liquid barrel per hour
Volumetric Liquid Flow per Hour 105 172 US beer barrel per hour 
Volumetric Liquid Flow per Hour 105 134 Oil barrels per hour

Device Variable Classification Classification Code Unit Code Description
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Volumetric Liquid Flow per Hour 105 192 UK beer barrel per hour
Volumetric Liquid Flow per Day 106 174 Imperial Fluid ounces per day 
Volumetric Liquid Flow per Day 106 175 US Fluid ounces per day
Volumetric Liquid Flow per Day 106 176 milliliter (cc) per day 10-3 Liter
Volumetric Liquid Flow per Day 106 177 Liters per day
Volumetric Liquid Flow per Day 106 178 Hectoliter per day 
Volumetric Liquid Flow per Day 106 19 cubic meter (kiloliter) per day 
Volumetric Liquid Flow per Day 106 25 million liters (megaliter) per day 
Volumetric Liquid Flow per Day 106 235 US gallons per day
Volumetric Liquid Flow per Day 106 182 US kilogallon per day 
Volumetric Liquid Flow per Day 106 23 US million gallons per day
Volumetric Liquid Flow per Day 106 31 imperial gallons per day 
Volumetric Liquid Flow per Day 106 185 imperial million gallons per day 
Volumetric Liquid Flow per Day 106 27 cubic feet per day
Volumetric Liquid Flow per Day 106 187 Acre-Feet per day 
Volumetric Liquid Flow per Day 106 188 US drum per day 
Volumetric Liquid Flow per Day 106 189 US liquid barrel per day
Volumetric Liquid Flow per Day 106 173 US beer barrel per day
Volumetric Liquid Flow per Day 106 135 Oil barrels per day
Volumetric Liquid Flow per Day 106 192 UK beer barrel per day
Thermal Expansions 107 170 /C
Thermal Expansions 107 171 /F 
Miscellaneous – 156 dB: Decibel
Volumetric Energy Density – 170 kJ/I kilojoules per liter 
Volumetric Energy Density – 171 Btu/ft3 British thermal units per cubic foot 

Device Variable Classification Classification Code Unit Code Description
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